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safety information
These warnings and precautions are included to prevent injury to you and others, and to prevent any potential damage to 
your machine. Be sure to read and understand all of these instructions before using the machine.
Use common sense for operating any electrical appliance and whenever using your machine. Also, follow all warnings and 
instructions marked on the machine and in the accompanying literature. After reading this section, keep it in a safe place 
for future reference.

Important safety symbols

This section explains the meanings of all icons and signs in the user's guide. These safety symbols are in order, according to the degree of 
danger.

Explanation of all icons and signs used in the user’s guide

Operating environment

 Warning

Warning Hazards or unsafe practices that may result in severe personal injury or death.

Caution Hazards or unsafe practices that may result in minor personal injury or property damage.

Do not attempt.

Do not disassemble.

Do not touch.

Unplug the power cord from the wall socket.

Make sure the machine is grounded to prevent electric shock.

Call the service center for help.

Follow directions explicitly.

Do not use if the power cord is damaged or if the 
electrical outlet is not grounded.
► This could result in electric shock or fire. 

Do not bend, or place heavy objects on the power 
cord. 
► Stepping on or allowing the power cord to be 
crushed by a heavy object could result in electric 
shock or fire. 

Do not place anything on top of the machine (water, 
small metal or heavy objects, candles, lit cigarettes, 
etc.).
► This could result in electric shock or fire. 

Do not remove the plug by pulling on the cord; do not 
handle the plug with wet hands. 
► This could result in electric shock or fire. 
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 Caution

Operating method

 Caution

If the machine gets overheated, it releases smoke, 
makes strange noises, or generates an odd odor, 
immediately turn off the power switch and unplug the 
machine.
► This could result in electric shock or fire. 

During an electrical storm or for a period of 
non-operation, remove the power plug from the 
electrical outlet. 
► This could result in electric shock or fire. 

If the plug does not easily enter the electrical outlet, do not 
attempt to force it in. 
► Call an electrician to change the electrical outlet, or this 
could result in electric shock.

Be careful, the paper output area is hot. 
► Burns could occur. 

Do not allow pets to chew on the AC power, telephone or PC 
interface cords.
► This could result in electric shock or fire and/or injury to your 
pet. 

If the machine has been dropped, or if the cabinet appears 
damaged, unplug the machine from all interface connections 
and request assistance from qualified service personnel.
► Otherwise, this could result in electric shock or fire.

If the machine does not operate properly after these 
instructions have been followed, unplug the machine from all 
interface connections and request assistance from qualified 
service personnel.
► Otherwise, this could result in electric shock or fire.

If the machine exhibits a sudden and distinct change in 
performance, unplug the machine from all interface 
connections and request assistance from qualified service 
personnel.
► Otherwise, this could result in electric shock or fire.

Do not forcefully pull the paper out during printing. 
► It can cause damage to the machine.

When printing large quantities, the bottom part of the 
paper output area may get hot. Do not allow children 
to touch. 
► Burns can occur.

Be careful not to put your hand between the machine 
and paper tray.
► You may get injured.

When removing jammed paper, do not use tweezers 
or sharp metal objects. 
► It can damage the machine.

Do not block or push objects into the ventilation opening.
► This could result in elevated component temperatures which 
can cause damage or fire.

Do not allow too many papers to stack up in the paper output 
tray.
► It can damage the machine. 

Be care when replacing paper or removing jammed paper. 
► New paper has sharp edges and can cause painful cuts.

This machine's power interception device is the power cord. 
► To switch off the power supply, remove the power cord from 
the electrical outlet. 
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Installation / Moving

 Warning

 Caution

Maintenance / Checking

 Caution

Do not place the machine in an area with dust, 
humidity or water leaks. 
► This could result in electric shock or fire. 

When moving the machine, turn the power off and 
disconnect all cords; then lift the machine with at 
least two people.
► The machine could fall, causing injury or machine 
damage.

Do not put a cover over the machine or place it in an airtight 
location, such as a closet.
► If the machine is not well-ventilated, this could result in fire.

Do not place the machine on an unstable surface.
► The machine could fall, causing injury or machine damage.

Make sure you plug the power cord into a grounded electrical 
outlet.
► Otherwise, this could result in electric shock or fire.

The machine should be connected to
the power level which is specified on the label.
► If you are unsure and want to check the power level you are 
using, contact the electrical utility company.

Do not overload wall outlets and extension cords.
► This can diminish performance, and could result in electric 
shock or fire.

Use only No.26 AWGa or larger, telephone line cord, if 
necessary.
► Otherwise, it can cause damage to the machine.

a.AWG: American Wire Gauge

Use the power cord supplied with your machine for safe 
operation. If you are using a cord which is longer than 2 meters 
(6 feet) with a 140V machine, then the gauge should be 16 
AWG or larger.
► Otherwise, it can cause damage to the machine, and could 
result in electric shock or fire.

Unplug this product from the wall outlet before 
cleaning the inside of the machine. Do not clean the 
machine with benzene, paint thinner or alcohol; do 
not spray water directly into the machine. 
► This could result in electric shock or fire. 

Keep cleaning supplies away from children. 
► Children could get hurt.

When you are working inside the machine replacing 
supplies or cleaning the inside, do not operate the 
machine.
► You could get injured.

Do not disassemble, repair or rebuild the machine by 
yourself. 
► It can damage the machine. Call a certified 
technician when the machine needs repair.
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Supply usage

 Caution

Keep the power cable and the contact surface of the plug clean 
from dust or water.
► Otherwise, this could result in electric shock or fire. 

To clean and operate the machine, strictly follow the user's 
guide provided with the machine.
► Otherwise, you could damage the machine.

Do not remove any covers or guards that are fastened with 
screws. 
► The machine should only be repaired by a Samsung service 
technician.

Do not disassemble the toner cartridge.
► Toner dust can be dangerous if inhaled or 
ingested.

When storing supplies such as toner cartridges, keep 
them away from children.
► Toner dust can be dangerous if inhaled or 
ingested.

Do not burn any of the supplies such as toner 
cartridge or fuser unit.
► This could cause an explosion or uncontrollable 
fire.

Using recycled supplies, such as toner, can cause damage to 
the machine.
► In case of damage due to the use of recycled supplies, a 
service fee will be charged.

When changing the toner cartridge or removing jammed paper, 
be careful not to let toner dust touch your body or clothes.
► Toner dust can be dangerous if inhaled or ingested.

When toner gets on your clothing, do not use hot water to wash 
it.
► Hot water sets toner into fabric. Use cold water.
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regulatory information
This machine is designed for a normal work environment and certified with several regulatory statements.

Laser Safety Statement

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, and 
elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1:1993 + A1:1997 + A2:2001.
Class I laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to 
laser radiation above a Class I level during normal operation, user maintenance or prescribed service condition.
• Wavelength: 800 nm
• Beam divergence

- Paraller: 12 degrees
- Perpendicular: 30 degrees

• Maximum power or energy output: 5 mW

WARNING 
Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible, 
can damage your eyes.
When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:

Ozone Safety

During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is 
advisable that the machine be operated in a well ventilated area.
If you need additional information about ozone, contact your local Samsung dealer.
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Mercury Safety

Power Saver

Recycling

China only

Correct Disposal of This Product (Waste Electrical & Electronic Equipment)

(Applicable in the European Union and other European countries with separate collection systems)

Contains Mercury, Dispose According to Local, State or Federal Laws.(U.S.A. only)

This printer contains advanced energy conservation technology that reduces power consumption when it is not in active use.
When the printer does not receive data for an extended period of time, power consumption is automatically lowered. 
ENERGY STAR and the ENERGY STAR mark are registered U.S. marks. 
For more information on the ENERGY STAR program see http://www.energystar.gov

Recycle or dispose of the packaging material for this product in an environmentally responsible manner.

This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB 
cable) should not be disposed of with other household waste at the end of their working life. To prevent possible harm to the environment or 
human health from uncontrolled waste disposal, please separate these items from other types of waste and recycle them responsibly to 
promote the sustainable reuse of material resources.
Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and 
how they can take these items for environmentally safe recycling.
Business users should contact their supplier and check the terms and conditions of the purchase contract. This product and its electronic 
accessories should not be mixed with other commercial wastes for disposal.
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Correct disposal of batteries in this product

(Applicable in the European Union and other European countries with separate battery return systems.)

Taiwan only

Radio Frequency Emissions

FCC Information to the User
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that may cause undesired operation.
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or experienced radio TV technician for help.

 

Change or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to 
operate the equipment.

Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.
Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B prescrites dans la 
norme sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.

This marking on the battery, manual or packaging indicates that the batteries in this product should not be disposed with other household 
waste at the end of their working life. Where marked, the chemical symbols Hg, Cd or Pb indicate that the battery contains mercury, cadmium 
or lead above the reference levels in EC Directive 2006/66. If batteries are not properly disposed of, these substances can cause harm to 
human health or the environment. To protect natural resources and to promote material reuse, please separate batteries from other types of 
waste and recycle them through your local, free battery return system.
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UNITED STATES OF AMERICA

Federal Communications Commission (FCC)
Intentional emitter per FCC Part 15
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz Band, may be 
present (embedded) in your printer system. This section is only applicable if these devices are present. Refer to the system label to verify the 
presence of wireless devices.
Wireless devices that may be in your system are only qualified for use in the United States of America if an FCC ID number is on the system 
label.
The FCC has set a general guideline of 20 cm (8 inches) separation between the device and the body, for use of a wireless device near the 
body (this does not include extremities). This device should be used more than 20 cm (8 inches) from the body when wireless devices are on. 
The power output of the wireless device (or devices), which may be embedded in your printer, is well below the RF exposure limits as set by 
the FCC.
This transmitter must not be collocated or operation in conjunction with any other antenna or transmitter.
Operation of this device is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation of the device.

 

Wireless devices are not user serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to 
use it. Contact manufacturer for service.

FCC Statement for Wireless LAN use:

 

While installing and operating this transmitter and antenna combination the radio frequency exposure limit of 1m W/cm2 may be 
exceeded at distances close to the antenna installed. Therefore, the user must maintain a minimum distance of 20cm from the antenna at 
all times. This device cannot be colocated with another transmitter and transmitting antenna.

Russia only

Germany only

Turkey only
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Fax Branding

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device to send any 
message via a telephone facsimile machine unless such message clearly contains in a margin at the top or bottom of each transmitted page or 
on the first page of the transmission the following information:
1. the date and time of transmission
2. identification of either business, business entity or individual sending the message; and
3. telephone number of either the sending machine, business, business entity or individual.
The Telephone Company may make changes in its communications facilities, equipment operations or procedures where such action is 
reasonably required in the operation of its business and is not inconsistent with the rules and regulations in FCC Part 68. If such changes can 
be reasonably expected to render any customer terminal equipment incompatible with telephone company communications facilities, or require 
modification or alteration of such terminal equipment, or otherwise materially affect its use or performance, the customer shall be given 
adequate notice in writing, to allow the customer an opportunity to maintain uninterrupted service

Ringer Equivalence Number

The Ringer Equivalence Number and FCC Registration Number for this machine may be found on the label located on the bottom or rear of the 
machine. In some instances you may need to provide these numbers to the telephone company.
The Ringer Equivalence Number (REN) is a measure of the electrical load placed on the telephone line, and is useful for determining whether 
you have “overloaded” the line. Installing several types of equipment on the same telephone line may result in problems making and receiving 
telephone calls, especially ringing when your line is called. The sum of all Ringer Equivalence Numbers of the equipment on your telephone 
line should be less than five in order to assure proper service from the telephone company. In some cases, a sum of five may not be usable on 
your line. If any of your telephone equipment is not operating properly, you should immediately remove it from your telephone line, as it may 
cause harm to the telephone network.
The equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA. On the rear of this equipment is a label that 
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to the 
telephone company.

 

FCC Regulations state that changes or modifications to this equipment not expressly approved by the manufacturer could void the user’s 
authority to operate this equipment. In the event that terminal equipment causes harm to the telephone network, the telephone company 
should notify the customer that service may be stopped. However, where prior notice is impractical, the company may temporarily cease 
service, providing that they:
a)promptly notify the customer.
b)give the customer an opportunity to correct the equipment problem.
c)inform the customer of the right to bring a complaint to the Federal Communication Commission pursuant to procedures set out in FCC 

Rules and Regulations Subpart E of Part 68.

You should also know that:
• Your machine is not designed to be connected to a digital PBX system.
• If you intend to use a computer modem or fax modem on the same phone line as your machine, you may experience transmission and 

reception problems with all the equipment. It is recommended that no other equipment, except for a regular telephone, share the line with 
your machine.

• If your area experiences a high incidence of lightning or power surges, we recommend that you install surge protectors for both the power 
and the telephone lines. Surge protectors can be purchased from your dealer or telephone and electronic specialty stores.

• When programming emergency numbers and/or making test calls to emergency numbers, use a non-emergency number to advise the 
emergency service dispatcher of your intentions. The dispatcher will give you further instructions on how to actually test the emergency 
number.

• This machine may not be used on coin service or party lines.
• This machine provides magnetic coupling to hearing aids.
You may safely connect this equipment to the telephone network by means of a standard modular jack, USOC RJ-11C.
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Replacing the Fitted Plug (for UK Only)

Important
The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and has a 13 amp fuse. When you change or examine the 
fuse, you must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, do not use the plug until 
you have another fuse cover. 
Contact the people from you purchased the machine.
The 13 amp plug is the most widely used type in the UK and should be suitable. However, some buildings (mainly old ones) do not have normal 
13 amp plug sockets. You need to buy a suitable plug adaptor. Do not remove the moulded plug.

 

If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you plug it into a socket.

Important warning: 

• Green and Yellow: Earth
• Blue: Neutral
• Brown: Live

If the wires in the mains lead do not match the colors marked in your plug, do the following:
You must connect the green and yellow wire to the pin marked by the letter “E” or by the safety ‘Earth symbol’ or colored green and yellow or 
green.
You must connect the blue wire to the pin which is marked with the letter “N” or colored black.
You must connect the brown wire to the pin which is marked with the letter “L” or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

Declaration of Conformity (European Countries)

Approvals and Certifications

Hereby, Samsung Electronics declare that this product is in compliance with the essential requirements and other relevant provisions of:
CLX-3185 Series: R&TTE Directive (1999/5/EC)
The declaration of conformity may be consulted at www.samsung.com/printer, go to Support > Download center and enter your printer (MFP) 
name to browse the EuDoC. 
January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of the member states related to low voltage equipment.
January 1, 1996: Council Directive 2004/108/EC (92/31/EEC), approximation of the laws of the Member States related to electromagnetic 
compatibility.
March 9, 1999: Council Directive 1999/5/EC on radio equipment and telecommunications terminal equipment and the mutual recognition of 
their conformity. A full declaration, defining the relevant Directives and referenced standards can be obtained from your Samsung Electronics 
Co., Ltd. representative.

You must earth this machine.
The wires in the mains lead have the following color code:

The CE marking applied to this product symbolizes Samsung Electronics Co., Ltd. Declaration of Conformity with the following applicable 
93/68/EEC Directives of the European Union as of the dates indicated:
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EC Certification
Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal Equipment Directive (FAX)
This Samsung product has been self-certified by Samsung for pan-European single terminal connection to the analogue public switched 
telephone network (PSTN) in accordance with Directive 1999/5/EC. The product has been designed to work with the national PSTNs and 
compatible PBXs of the European countries:
In the event of problems, you should contact the Euro QA Lab of Samsung Electronics Co., Ltd. in the first instance.
The product has been tested against TBR21. To assist in the use and application of terminal equipment which complies with this standard, the 
European Telecommunication Standards Institute (ETSI) has issued an advisory document (EG 201 121) which contains notes and additional 
requirements to ensure network compatibility of TBR21 terminals. The product has been designed against, and is fully compliant with, all of the 
relevant advisory notes contained in this document.

European Radio Approval Information (for products fitted with EU-approved radio devices)
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz band, may be 
present (embedded) in your printer system which is intended for home or office use. This section is only applicable if these devices are present. 
Refer to the system label to verify the presence of wireless devices.
Wireless devices that may be in your system are only qualified for use in the European Union or associated areas if a CE mark  
with  a Notified Body Registration Number and the Alert Symbol is on the system label.
The power output of the wireless device or devices that may be embedded in you printer is well below the RF exposure limits as set by the 
European Commission through the R&TTE directive.

European States qualified under wireless approvals:
EU
Austria, Belgium, Cyprus, Czech Republic, Denmark, Estonia, Finland, France (with frequency restrictions), Germany, Greece, Hungary, 
Ireland, Italy, Latvia, Lithuania, Luxembourg, Malta, The Netherlands, Poland, Portugal, Slovakia, Slovenia, Spain, Sweden and the U.K.
EEA/EFTA countries
Iceland, Liechtenstein, Norway and Switzerland

European States with restrictions on use:
EU
In France, the frequency range is restricted to 2446.5-2483.5 MHz for devices above 10 mW transmitting power such as wireless
EEA/EFTA countries
No limitations at this time
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Regulatory Compliance Statements

Wireless Guidance
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz Band, may be 
present (embedded) in your printer system. The following section is a general overview of considerations while operating a wireless device.
Additional limitations, cautions, and concerns for specific countries are listed in the specific country sections (or country group sections). The 
wireless devices in your system are only qualified for use in the countries identified by the Radio Approval Marks on the system rating label. If 
the country you will be using the wireless device in, is not listed, contact your local Radio Approval agency for requirements. Wireless devices 
are closely regulated and use may not be allowed.
The power output of the wireless device or devices that may be embedded in your printer is well below the RF exposure limits as known at this 
time. Because the wireless devices (which may be embedded into your printer) emit less energy than is allowed in radio frequency safety 
standards and recommendations, manufacturer believes these devices are safe for use. Regardless of the power levels, care should be taken 
to minimize human contact during normal operation.
As a general guideline, a separation of 20 cm (8 inches) between the wireless device and the body, for use of a wireless device near the body 
(this does not include extremities) is typical. This device should be used more than 20 cm (8 inches) from the body when wireless devices are 
on and transmitting.
This transmitter must not be collocated or operation in conjunction with any other antenna or transmitter.
Some circumstances require restrictions on wireless devices. Examples of common restrictions are listed below:

Radio frequency wireless communication can interfere with equipment on commercial aircraft. Current aviation regulations require wireless 
devices to be turned off while traveling in an airplane. IEEE 802.11 (also known as wireless Ethernet) and Bluetooth communication devices 
are examples of devices that provide wireless communication.

In environments where the risk of interference to other devices or services is harmful or perceived as harmful, the option to use a wireless 
device may be restricted or eliminated. Airports, Hospitals, and Oxygen or flammable gas laden atmospheres are limited examples where use 
of wireless devices may be restricted or eliminated. When in environments where you are uncertain of the sanction to use wireless devices, ask 
the applicable authority for authorization prior to use or turning on the wireless device.

Every country has different restrictions on the use of wireless devices. Since your system is equipped with a wireless device, when traveling 
between countries with your system, check with the local Radio Approval authorities prior to any move or trip for any restrictions on the use of 
a wireless device in the destination country.

If your system came equipped with an internal embedded wireless device, do not operate the wireless device unless all covers and shields are 
in place and the system is fully assembled.

Wireless devices are not user serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to use it. 
Contact manufacturer for service.

Only use drivers approved for the country in which the device will be used. See the manufacturer System Restoration Kit, or contact 
manufacturer Technical Support for additional information.

OpenSSL License

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 
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documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes 

software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without 

prior written permission.
5. For written permission, please contact openssl-core@openssl.org.
6. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written 

permission of the OpenSSL Project.
7. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the 

OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This product includes cryptographic software written by Eric Young(eay@cryptsoft.com). This product includes software written by Tim Hudson 
(tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with 
Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are adhered to. The following conditions apply to 
all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this 
distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young's, 
and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given 
attribution as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation 
(online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: "This product includes 

cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can be left out if the routines from the library 
being used are not cryptographic related:-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an 
acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  
IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publicly available version or derivative of this code cannot be changed. i.e. this code cannot simply 
be copied and put under another distribution licence [including the GNU Public Licence.
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about this user’s guide
This user’s guide provides information about basic understanding of the machine as well as detailed explanation on each 
step during actual usage. It is a valuable resource for both novice and professional users for the proper installation and 
use of the machine.

 

•Read the safety information before using the machine (See "Safety information" on page 1).
•If you have a problem using the machine, refer to the troubleshooting chapter (See "Troubleshooting" on page 1).
•Terms used in this user’s guide are explained in the glossary chapter (See "Glossary" on page 1).
•Illustrations in this user’s guide may differ from your machine depending on its options or models.
•The procedures in this user’s guide are mainly based on Windows XP.

Convention
Some terms in this guide are used interchangeably, as below.
• Document is synonymous with original.
• Paper is synonymous with media, or print media.
• Machine refers to printer or MFP.
The following table offers the conventions of this guide.

 

The date format may differ from country to 
country.

 

Do not touch the surface of the drum 
located in the toner cartridge or imaging 
unit.

Convention Description Example

Bold For texts on the display or button names on the machine. Start

Note Provides additional information or details for the machine function and feature.

Caution Contains information you can use to protect the machine from possible 
mechanical damage or malfunction

Footnote Provides additional information on certain words or a phrase. a. pages per minute

(“Cross-reference”) Refers you to additional detailed information. (See "Finding more information" on page 2).
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Finding more information
You can find information about setting up and using your machine in the following resources, either as a print-out or on screen.

• Samsung AnyWeb Print: helps personal users to screen-capture the website screen in Windows Internet Explorer easily. 
(http://solution.samsungprinter.com/personal/anywebprint)

• SyncThru™ Web Admin Service: provides convenient tools for network administrators who need to manage many machines 
simultaneously. This program is for network model only. (http://solution.samsungprinter.com)

• Samsung Easy Color Manager: helps Samsung color laser printer users to adjust color as they like. 
(http://solution.samsungprinter.com/personal/colormanager)

Material name Description

Quick Installation 
Guide

This guide provides information on setting up your machine. This guide is provided in the box with the printer.

User’s Guide This guide provides you with step-by-step instructions for using your machine’s full features, maintaining your machine, 
troubleshooting, and replacing supplies.

Machine Driver Help This help provides you with information about the printer driver and instructions for setting up the options for printing (See "Using help" 
on page 3).

Samsung website If you have Internet access, you can get help, support, machine drivers, manuals, and order information from the Samsung website, 
www.samsung.com/printer.

Downloadable 
software

You can download useful software programs from the Samsung website. 
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features of your new product
Your new machine is equipped with a number of special features that improve the quality of the documents you print.

Special Features

Print with excellent quality and speed

• You can print with a full range of colors using cyan, magenta, 
yellow and black.

Copy originals in several formats

• Your machine can copy multiple image copies from the 
original document on a single page (See "2-up or 4-up 
• You can print with a resolution of up to 2400 x 600 dpi 
effective output.

• Your machine prints A4-sized paper at up to 16 ppm and 
Letter-sized paper at up to 17 ppm. In the color mode, your 
machine prints A4-sized or Letter-sized paper at up to 4 
ppm.

Handle many different types of printable material

• The 130-sheet tray supports plain paper in various sizes - 
letterhead, envelopes, labels, custom-sized media, postcard 
and heavy paper.

Create professional documents

• Print Posters. The text and pictures of each page of your 
document are magnified and printed across the sheet of 
paper and can then be taped together to form a poster (See 
"Printing posters" on page 3).

• Print Watermarks. You can customize your documents with 
words such as “Confidential” (See "Using watermarks" on 
page 4).

• You can use preprinted or letterhead paper (See"Using 
overlay" on page 5).

Save time and money

• To save paper, you can print multiple pages on one single 
sheet of paper (See "Printing multiple pages on one sheet of 
paper" on page 3).

• This machine automatically conserves electricity by 
substantially reducing power consumption when not in use.

• To save paper, you can print on both sides of the paper 
(manual) (See "Printing on both sides of the paper (Manual)" 
on page 3).

Print in various environments

• You can print with various operating systems such as 
Windows, Linux and Macintosh operating systems (See 
"System requirements" on page 2).

• Your machine is equipped with Hi-Speed USB 2.0 interface 
and network interface.

• Your machine is equipped with wireless network interface 
(CLX-3185FW/CLX-3185WK only).
Features of your new product_
copying (N-up)" on page 2).
• There are special functions to erase catalog and newspaper 

background.
• The print quality and image size may be adjusted and 

enhanced at the same time.

Scan the originals and send it right away

• Scan in color and use the precise compressions of BMP, 
JPEG, TIFF and PDF formats.

• Quickly scan and send files to multiple destination using 
networking scanning (See "For network connected machine 
(CLX-3185N/CLX-3185FN/CLX-3185FW/CLX-3185WK 
only)" on page 2).

IPv6 (CLX-3185N/CLX-3185WK/CLX-3185FN/CLX-3185FW 
only)

• The machine supports IPv6. See "IPv6 Configuration" on 
page 6 for the more information.

Set a specific time to transmit a Fax 
(CLX-3185FN/CLX-3185FW only)

• You can specify a certain time to transmit the fax and also 
send the fax to several stored destinations.

• After the transmission, the machine may point out the fax 
reports according to the setting.

Eco copy (CLX-3185/CLX-3185N/CLX-3185FN only)

• You can cut toner consumption and paper usage. See "Eco 
Copy button (CLX-3185/CLX-3185N/CLX-3185FN only)" on 
page 8 for the more information.
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Features by Models
The machine is designed to support all of your document needs from printing and copying to more advanced networking solutions for your business. 
Some features and optional goods may not be available depending on models or countries.
The below table is a listing of the major features by each model.

( ●: Included, ○: Optional, Blank: Not available) 

 

•CLX-3180K, CLX-3185, CLX-3185K and CLX-3186 are the same machine despite the name difference. This User’s Guide is written on the basis of 
CLX-3185.

•CLX-3185N, CLX-3185NK and CLX-3186N are the same machine despite the name difference. This User’s Guide is written on the basis of CLX-3185N.
•CLX-3185FN and CLX-3186FN are the same machine despite the name difference. This User’s Guide is written on the basis of CLX-3185FN.

Features

CLX-3180K
CLX-3185
CLX-3185K
CLX-3186

CLX-3185N
CLX-3185NK
CLX-3186N

CLX-3185WK CLX-3185FN
CLX-3186FN CLX-3185FW

Print ● ● ● ● ●

Duplex (2-sided) printing (manual) ● ● ● ● ●

Copy ● ● ● ● ●

Eco Copy ● ● ●

Scan ● ● ● ● ●

Fax ● ●

Network PC fax ● ●

On Hook Dial ● ●

USB 2.0 ● ● ● ● ●

USB Memory Interface (Direct USB) ● ● ● ●

IPv6 ● ● ● ●

Network Interface Ethernet 10/100 Base TX wired LAN ● ● ● ●

Network Interface 802.11b/n/g wireless LAN ● ●

SyncThru™ Web Service ● ● ● ●

Print Screen ●

Automatic Document Feeder (ADF) ● ●
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1.introduction
This chapter gives you an overview of your machine.
This chapter includes:
• Machine overview (CLX-3185/CLX-3185N/CLX-3185WK)
• Control panel overview (CLX-3185/CLX-3185N/CLX-3185WK)
• Machine overview (CLX-3185FN/CLX-3185FW)
• Control panel overview (CLX-3185FN/CLX-3185FW)

• Understanding the Status LED
• Introducing the useful buttons
• Acknowledging the status of the toner cartridge

  

Machine overview (CLX-3185/CLX-3185N/CLX-3185WK)
Front view
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This illustration may differ from your machine depending on its model.
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Rear view
This illustration may differ from your machine depending on its model.
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1 Rear door handle
 

4 USB port
 

2 Rear door
 

5 Network porta

a.CLX-3185N/CLX-3185WK only

 

3 Power cord receptacle
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Control panel overview (CLX-3185/CLX-3185N/CLX-3185WK)
This control panel may differ from your machine depending on its model.

 

1 Power Allows you to turn the power on and off (See "Power button" on page 8).

 

2

Eco Copy Reduces toner consumption and paper usage (See "Eco Copy button (CLX-3185/CLX-3185N/CLX-3185FN only)" on 
page 8).

Direct USB (CLX-3185WK)
Allows you to directly print files stored on a USB memory device when it is inserted into the USB memory port on the front 
of your machine (See "Using USB memory device (CLX-3185N/CLX-3185FN/CLX-3185WK/CLX-3185FW only)" on 
page 1).

 

3 ID Copy Allows you to coy both sides the ID card like a driver’s license to a single side of paper (See "ID card copying" on page 2).
 

4 Display Shows the current status and prompts during an operation.
 

5 Left/Right Arrow Scrolls through the options available in the selected menu and increases or decreases values.
 

6 OK Confirms the selection on the screen.
 

7 Menu Enters Menu mode and scrolls through the available menus (See "Menu overview" on page 4).
 

8 Stop/Clear Stops an operation at any time. In ready mode, clears/cancels the copy options such as the darkness, the document type 
setting, the copy size and the number of copies.

 

9 Wireless LED (CLX-3185WK) Shows the current status of the wireless network connection (See "Understanding the Status LED" on page 8).
 

10 Status LED Shows the status of your machine (See "Understanding the Status LED" on page 8).
 

11 Color Start Begins a printing job in color mode.
 

12 Black Start Begins a printing job in black and white mode.
 

13 Back Sends you back to the upper menu level.
 

14 Toner Color The toner colors shown below LCD display co-works with the display messages (See "Acknowledging the status of the 
toner cartridge" on page 9).

 

15 Scan to Sends scanned data (See "Scanning originals and sending to your computer (Scan to PC)" on page 1).

 

16

Print Screen (CLX-3185) Prints the displayed screen of your monitor (See "Print screen button (CLX-3185 only)" on page 8).

Direct USB (CLX-3185N)
Allows you to directly print files stored on a USB memory device when it is inserted into the USB memory port on the front 
of your machine (See "Using USB memory device (CLX-3185N/CLX-3185FN/CLX-3185WK/CLX-3185FW only)" on 
page 1).

WPS (CLX-3185WK) If your wireless access point supports Wi-Fi Protected Setup™(WPS), you can configure the machine easily without a 
computer (See "WPS button (CLX-3185WK/CLX-3185FW only)" on page 9).

1 3 4 7 852

11 101213 5

6

1516 14 9
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Machine overview (CLX-3185FN/CLX-3185FW)
Front view

This illustration may differ from your machine depending on its model.
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Rear view

This illustration may differ from your machine depending on its model.
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Control panel overview (CLX-3185FN/CLX-3185FW)
This control panel may differ from your machine depending on its model.

 

1 Power Allows you to turn the power on and off (See "Power button" on page 8).

 

2

Eco Copy (CLX-3185FN) Reduces toner consumption and paper usage (See "Eco Copy button (CLX-3185/CLX-3185N/CLX-3185FN only)" on 
page 8).

Direct USB (CLX-3185FW)
Allows you to directly print files stored on a USB memory device when it is inserted into the USB memory port on the front 
of your machine (See "Using USB memory device (CLX-3185N/CLX-3185FN/CLX-3185WK/CLX-3185FW only)" on 
page 1).

 

3 ID Copy Allows you to coy both sides the ID card like a driver’s license to a single side of paper (See "ID card copying" on page 2).
 

4 Display Shows the current status and prompts during an operation.
 

5 Copy Activates Copy mode.
 

6 Fax Activates Fax mode.
 

7 Left/Right Arrow Scrolls through the options available in the selected menu and increases or decreases values.
 

8 Menu Enters Menu mode and scrolls through the available menus (See "Menu overview" on page 4).
 

9 OK Confirms the selection on the screen.
 

10 Number Keypad Dials a number or enters alphanumeric characters (See "Entering characters using the number keypad 
(CLX-3185FN/CLX-3185FW only)" on page 2).

 

11 Address Book Allows you to search for stored email addresses.
 

12 Redial/Pause Redials the last number in ready mode, or inserts a pause into a fax number in Edit mode.
 

13 Black Start Begins a printing job in black and white mode.
 

14 Stop/Clear Stops an operations at any time. In ready mode, clears/cancels the copy options such as the darkness, the document type 
setting, the copy size and the number of copies.

 

15 Wireless LED (CLX-3185FW) Shows the current status of the wireless network connection (See "Understanding the Status LED" on page 8).
 

16 Status LED Shows the status of your machine (See "Understanding the Status LED" on page 8).
 

17 Color Start Begins a printing job in color mode.
 

18 On Hook Dial Engages the telephone line.
 

19 Back Sends you back to the upper menu level.

15161718192122 20 7
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20 Scan/Email Activates Scan mode.
 

21 Toner Color The toner colors shown below LCD display co-works with the display messages (See "Acknowledging the status of the 
toner cartridge" on page 9).

 

22

Direct USB (CLX-3185FN) Allows you to directly print files stored on a USB memory device when it is inserted into the USB port on the front of your 
machine (See "Using USB memory device (CLX-3185N/CLX-3185FN/CLX-3185WK/CLX-3185FW only)" on page 1).

WPS (CLX-3185FW) If your wireless access point supports Wi-Fi Protected Setup™(WPS), you can configure the machine easily without a 
computer (See "WPS button (CLX-3185WK/CLX-3185FW only)" on page 9).
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Understanding the Status LED
The color of the Status LED indicates the machine's current status.

 

Samsung does not recommend using a non-genuine Samsung toner 
cartridge such as one that is refilled or remanufactured. Samsung 
cannot guarantee a non-genuine Samsung toner cartridge's quality. 
Service or repair required as a result of using non-genuine Samsung 
toner cartridges will not be covered under the machine warranty.

 

Check the message on the display. Follow the instructions in the 
message or refer to troubleshooting part (See "Understanding display 
messages" on page 5). If the problem persists, call a service 
representative.

 

All printing errors will be appeared in the Smart Panel program 
window. If the problem persists, call a service representative.

Introducing the useful buttons

 

•Supported optional devices and features may differ according to your 
model. Check your model name. 

•Illustrations may differ from your machine depending on the model or 
its options. Check your model name.

Menu button
When you want to know the machine status and set your machine to use an 
advanced feature, click the Menu button (See "Machine status and 
advanced feature" on page 1).

Power button
For CLX-3185 CLX-3185N and CLX-3185WK, plug the power cord into the 
AC power outlet and press this button, the machine will be turned on. When 
you want to turn the power off, press this button until Power Down appears 
on the display. Choose Yes to turn the power off.
For CLX-3185FN and CLX-3185FW, plug the power cord into the AC power 
outlet and then the machine will be turned on automatically.

 

When the machine goes into power save mode, Power button lights 
on blue.

Print screen button (CLX-3185 only)
• In case of print the active windows displayed in the monitor.

1.Press Print Screen on the control panel.
2.Press OK when Active appears.

The machine prints the active windows displayed in the monitor
• In case of print the whole monitor screen.

1.Press Print Screen on the control panel.
2.Press OK when Full appears.

The machine prints the whole monitor screen.

 

•The page will be printed on the default page like A4 or Letter.
•You can only use this function with a USB-connected machine. 
•Print Screen can only be used with Windows and Macintosh 

operating systems.
•You can only use this function if the machine driver is installed.

Eco Copy button (CLX-3185/CLX-3185N/CLX-3185FN 
only)
The Eco Copy function cuts toner consumption and paper usage. You can 
configure Eco Copy function to adjust your paper savings and save setting 
you want to use.
1. Press Menu on the control panel.
2. Press the left/right arrow until Copy Setup appears and press OK.

Status Description

Off • The machine is off-line.
• The machine is in power saver mode. When 

data is received or any button is pressed, it 
switches to on-line automatically.

• Wireless function can not be used.

Green Blinking • When the green LED slowly blinks, the 
machine is receiving data from a computer.

• When the green LED blinks rapidly, the 
machine is printing data. 

On The machine is on-line and can be used.

Blue On When the machine is connected to a wireless 
network, Wireless LED lights on blue 
(CLX-3185FW/CLX-3185WK only).

Red Blinking • A minor error has occurred and the machine is 
waiting for the error to be cleared. Check the 
display message. When the problem is 
cleared, the machine resumes (See 
"Understanding display messages" on 
page 5).

• A small amount of toner is left in the cartridge. 
The estimated cartridge life of toner is close. 
Prepare a new cartridge for replacement. You 
may temporarily increase the printing quality 
by redistributing the toner (See "Redistributing 
toner" on page 1).

On • A toner cartridge has almost reached the end 
of its estimated cartridge life. It is 
recommended to replace the toner cartridge 
(See "Replacing the toner cartridge" on 
page 2).

• A paper jam has occurred (See "Clearing 
paper jams" on page 2).

• The door is opened. Close the door.
• There is no paper in the tray. Load paper in 

the tray.
• The machine has stopped due to a major 

error. Check the display message (See 
"Understanding display messages" on 
page 5). 
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3. Press OK when Change Default appears.
4. Press the left/right arrow until Eco Copy appears and press OK.
5. Press the left/right arrow to select the mode you want.

•Mono Only: prints all original images in black and white mode.
•2up/Mono: prints two original images reduced to fit onto one sheet of 

paper in black and white mode.
•4up/Mono: prints four original images reduced to fit onto one sheet of 

paper in black and white mode.
•2up/Color: prints two original images reduced to fit onto one sheet of 

paper in color mode.
•4up/Color: prints four original images reduced to fit onto one sheet of 

paper in color mode.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

WPS button (CLX-3185WK/CLX-3185FW only)
Wi-Fi Protected Setup™(WPS) is a standard for easy and secure 
establishment of a wireless network. This function simplifies the process of 
configuring the wireless network connection and security options.
The WPS button enables you to setup the wireless network configuration 
easily. This function simplifies the process of configuring the wireless 
network options such as a network name (SSID), data encryption and 
authentication. You can complete the wireless connection settings by just 
pressing this button.
To perform this function, refer to "Wireless network setup 
(CLX-3185FW/CLX-3185WK only)" on page 1.

Acknowledging the status of the toner cartridge
The status of toner cartridges is indicated by the Status LED and the LCD 
display. If the toner cartridge is low or needs to be replaced, the Status LED 
turns red and the display shows the message. However, the arrow mark 
shows which color toner is of concern or may be installed with a new 
cartridge.

Example:

The above example shows the yellow cartridge status indicated by the 
arrow. Check the message to find out what the problem is and how to solve 
it. See "Understanding display messages" on page 5 to browse the detailed 
information on error messages.

 

Samsung does not recommend using non-genuine Samsung toner 
cartridge such as refilled or remanufactured. Samsung cannot 
guarantee non-genuine Samsung toner cartridge's quality. Service or 
repair required as a result of using non-genuine Samsung toner 
cartridges will not be covered under the machine warranty.
Introduction_ 9



1.getting started
This chapter gives you step-by-step instructions for setting up the USB connected machine and software.
This chapter includes:
• Setting up the hardware
• Supplied software
• System requirements

• Installing USB connected machine’s driver
• Sharing your machine locally

  

 

•Supported optional devices and features may differ according to your 
model. Check your model name. 

•Illustrations may differ from your machine depending on the model or 
its options. Check your model name.

Setting up the hardware
This section shows the steps to set up the hardware, as is explained in the 
Quick Installation Guide. Make sure you read the Quick Installation Guide 
first and follow the steps below.
1. Select a stable location.

Select a level, stable place with adequate space for air circulation. Allow 
extra space to open door(s) and tray(s). 
The area should be well ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the machine close to the 
edge of your desk or table.

Printing is suitable for altitudes under 1,000 m (3,281 ft.). Refer to the 
altitude setting to optimize your printing (See "Altitude adjustment" on 
page 1).
Place the machine on a flat, stable surface so that there is no incline 
greater than 2 mm (0.08 inch). Otherwise, printing quality may be 

affected.

2. Unpack the machine and check all the enclosed items.
3. Remove all tape.
4. Install the toner cartridge.
5. Load paper (See "Loading paper in the tray" on page 4).
6. Make sure that all cables are connected to the machine. 
7. Turn the machine on.

 

When you move the machine, do not tilt or turn it upside down. 
Otherwise, the inside of the machine may be contaminated by toner, 
which can cause damage to the machine or bad print quality.
This machine will not operate when the power main fails.

Supplied software
After you have set up your machine and connected it to your computer. You 
must install the machine software. If you are a Windows or Macintosh OS 
user, install the software from the supplied CD, or if you are a Linux OS 
user, download the software from the Samsung website 
(www.samsung.com/printer) and install on your computer.

 

•Machine software is occasionally updated for reasons like the release 
of new operating system and etc. If needed, download the latest 
version from the Samsung website (www.samsung.com/printer).

•Installed software may be different depending on each model.

2mm
(0.08 in)

2mm
(0.08 in)
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System requirements
Before you begin, ensure that your system meets the following 
requirements.

Microsoft® Windows®
Your machine supports the following Windows operating systems.

 

•Internet Explorer 5.0 or higher is the minimum requirement for all 
Windows operating systems.

•Users who have an administrator right can install the software.
•Windows Terminal Services is compatible with your machine.

Macintosh

OS Contents

Windows • Printer driver: Use this driver to take full advantage of 
your machine’s features.

• Scanner driver: TWAIN and Windows Image 
Acquisition (WIA) drivers are available for scanning 
documents on your machine.

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• SmarThrua: This program is the accompanying 
Windows-based software for your multifunctional 
machine. 

• Samsung Scan and Fax Manager: You can find out 
about Samsung Scan and Fax Manager program 
information and installed scan driver's condition.

• Network PC Fax: You can send a fax from your 
computer without going to the machine. 
(CLX-3185FN/CLX-3185FW only)

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

a.Allows you to edit a scanned image in various ways using a powerful 
image editor and to send the image by email. You can also open 
another image editor program such as Adobe Photoshop, from 
SmarThru. For details, refer to the on-screen help supplied on the 
SmarThru program (See "SmarThru" on page 3).

Macintosh • Printer driver: Use this driver to take full advantage of 
your machine’s features.

• Scanner driver: TWAIN driver is available for scanning 
documents on your machine.

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• Samsung Scan and Fax Manager: You can find out 
about Samsung Scan and Fax Manager program 
information and installed scan driver's condition.

• Fax Utilities: You can send a fax from your computer 
without going to the machine. 
(CLX-3185FN/CLX-3185FW only)

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

Linux • Unified Linux Driver: Use this driver to take full 
advantage of your machine’s features.

• SANE: Use this driver to scan documents.
• Smart Panel: This program allows you to monitor the 

machine’s status and alerts you when an error occurs 
during printing.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

OPERATING 
SYSTEM

Requirement (recommended)

CPU RAM free HDD 
space

Windows® 
2000

Intel® Pentium® II 400 
MHz (Pentium III 933 
MHz)

64 MB  
(128 MB)

600 MB

Windows® XP Intel® Pentium® III 933 
MHz (Pentium IV 1 GHz)

128 MB  
(256 MB)

1.5 GB

Windows 
Server® 2003

Intel® Pentium® III 933 
MHz (Pentium IV 1 GHz)

128 MB  
(512 MB)

1.25 GB to  
2 GB

Windows 
Server® 2008

Intel® Pentium® IV 1 
GHz (Pentium IV 2 GHz)

512 MB  
(2 GB)

10 GB

Windows 
Vista®

Intel® Pentium® IV 3 
GHz

512 MB  
(1 GB)

15 GB

Windows® 7 Intel® Pentium® IV 1 
GHz 32-bit or 64-bit 
processor or higher

1 GB 
(2 GB)

16 GB

• Support for DirectX® 9 graphics with 128 MB 
memory (to enable the Aero theme).

• DVD-R/W Drive

Windows 
Server® 2008 
R2

Intel® Pentium® IV 1 
GHz (x86) or 1.4 GHz 
(x64) processors (2 GHz 
or faster)

512 MB  
(2 GB)

10 GB

OPERATING 
SYSTEM

Requirements (recommended)

CPU RAM free HDD 
space

Mac OS X 
10.3 ~ 10.4

• Intel® 
Processors

• PowerPC G4/ 
G5

• 128 MB for a 
PowerPC based 
Mac (512 MB)

• 512 MB for a 
Intel-based Mac 
(1 GB)

1 GB

Mac OS X 
10.5

• Intel® 
Processors

• 867 MHz or 
faster Power 
PC G4/ G5

512 MB (1 GB) 1 GB

Mac OS X 
10.6

• Intel® 
Processors

1 GB (2 GB) 1 GB
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Linux

 

•It is necessary to claim swap partition of 300 MB or larger for working 
with large scanned images.

•The Linux scanner driver supports the optical resolution at maximum.

Installing USB connected machine’s driver
A locally connected machine is a machine directly connected to your 
computer by a USB cable.

 

Only use a USB cable no longer than 3 m (10 ft.).

Windows
You can install the machine software using the typical or custom method.
The following steps are recommended for most users who use a machine 
directly connected to your computer. All components necessary for machine 
operations will be installed.
1. Make sure that the machine is connected to your computer and powered 

on.

 

If the “Found New Hardware Wizard” appears during the 
installation procedure, click Cancel to close the window.

2. Insert the supplied software CD into your CD-ROM drive.
•The software CD should automatically run and an installation window 

will appear.
•If the installation window does not appear, click Start and then Run. 

Type X:\Setup.exe, replacing “X” with the letter, which represents 
your CD-ROM drive. Click OK.

•If you use Windows Vista, Windows 7 or Windows Server 2008 R2 click 
Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter, which represents 
your CD-ROM drive and click OK.

•If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

•If the AutoPlay window appears in Windows 7 or Windows Server 2008 
R2, click Run Setup.exe in Install or run program field, and click 
Yes in the User Account Control window.

3. Select Install Now.

If necessary, select a language from the drop-down list of Installation 
Language.

 

The Advanced Installation has two options, Custom Installation 
and Install Software Only. The Custom Installation allows you 
to select the machine’s connection and choose individual 
component to install. The Install Software Only allows you to 
install the supplied software such as Smart Panel. Follow the 
guide in the window.

4. Read License Agreement and select I accept the terms of the 
License Agreement. Then, click Next.

The program searches for the machine.

 

If your machine is not connected to the computer, the error 

Item Requirements

Operating 
system

Fedora 2~10 (32/ 64 bit)
OpenSuSE® 9.2, 9.3, 10.0, 10.1, 10.2, 10.3, 11.0, 
11.1 (32/64 bit)
SuSE Linux 9.1 (32 bit)
Ubuntu 6.06, 6.10, 7.04, 7.10, 8.04, 8.10 (32/64 bit)
Mandrake 10.0, 10.1 (32/64 bit)
Mandriva 2005, 2006, 2007, 2008, 2009 (32/64 bit)
Debian 3.1, 4.0, 5.0 (32/64 bit)
Redhat® Enterprise Linux WS 4, 5 (32/64 bit)
SuSE Linux Enterprise Desktop 9, 10 (32/64 bit)

CPU Pentium IV 2.4GHz (Intel CoreTM2)

RAM 512 MB (1 GB)

Free HDD space 1 GB (2GB)
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message appears.

•After connecting the machine, click Next.
•If you do not want to connect the machine at this time, click the 

check box next to Check if you want to install the software 
without connection of the printer. In this case, Print a test 
page window will be skipped and installation is completed.

•The installation window in this User’s Guide may differ depending 
on the machine and interface in use.

5. The searched machines will be shown on the screen. Select the one you 
wish to use and click Next.

 

If the driver searched only one machine, the confirmation window 
appears.

6. After the installation is finished, a window asking you to print a test page 
appears. If you want to print a test page, click Print a test page.
Otherwise, just click Next and go to step 8.

7. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

8. If you want to register your machine on Samsung website, click On-line 
Registration.

 

If your machine is not connected yet to the computer, click How to 
connect?. How to connect? gives you the detailed information 
about how to connect the machine. Follow the instructions in the 
window.

9. Click Finish.

 

If the printer driver does not work properly, follow the steps below to 
repair or reinstall the driver. 
a)Make sure that the machine is connected to your machine and 

powered on.
b)From the Start menu, select Programs or All Programs > 

Samsung Printers > your printer driver name > Maintenance.
c)Select Repair or Remove as you wish to execute, then follow the 

instruction in the window.

Macintosh
The software CD that came with your machine provides you with the Driver 
files that allow you to use the CUPS driver or PostScript driver (only 
available when you use a machine, which supports the PostScript driver) for 
printing on a Macintosh computer. 
Also, it provides you with the TWAIN driver for scanning on a Macintosh 
computer.

1. Make sure that the machine is connected to your computer and powered 
on.

2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Macintosh desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the Installer OS X icon.
6. Enter the password and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Read the license agreement and click Continue.
9. Click Agree to agree to the license agreement.
10. Select Easy Install and click Install. Easy Install is recommended for 

most users. All components necessary for machine operations will be 
installed. 
If you select Custom Install, you can choose individual components to 
install.

11. When the message which warns that all applications will close on your 
computer appears, click Continue.

12. Select Typical installation for a local printer and then click OK.
13. The Installation process is being executed.
14. The Fax Queue Creator window appears during the installation 

process.
•For CLX-3185/CLX-3185N/CLX-3185WK, click Cancel to go to the next 

step.
•For CLX-3185FN/CLX-3185FW, select your machine name from the 

Printer Name list and click Create. When the confirmation window 
appears, click OK.

15. Click Continue on the Read Me window.
16. After the installation is finished, click Restart.

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow the steps below to uninstall the driver for Macintosh.
a)Make sure that the machine is connected to your computer and 

powered on.
b)Insert the supplied software CD into your CD-ROM drive.
c)Double-click CD-ROM icon that appears on your Macintosh desktop.
d)Double-click the MAC_Installer folder.
e)Double-click the Installer OS X icon.
f)Enter the password and click OK.
g)The Samsung Installer window opens. Click Continue.
h)Read the license agreement and click Continue.
i)Click Agree to agree to the license agreement. 
j)Select Uninstall and click Uninstall.
k)When the message which warns that all applications will close on 

your computer appears, click Continue.
l)When the uninstall is done, click Quit.

Linux
You need to download Linux software packages from the Samsung website 
to install the printer software (http://www.samsung.com/printer).
Follow the steps below to install the software.

Installing the Unified Linux Driver
1.Make sure that the machine is connected to your computer and 

powered on.
2.When the Administrator Login window appears, type in “root” in the 

Login field and enter the system password.
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You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3.From the Samsung website, download and unpack the Unified Linux 
Driver package to your computer.

4.Click  at the bottom of the desktop. When the Terminal screen 
appears, type in the following.
[root@localhost root]#tar zxf [FilePath]/UnifiedLinuxDriver.tar.gz
[root@localhost root]#cd [FilePath]/cdroot/Linux
[root@localhost Linux]#./install.sh

 

If you do not use the graphical interface and failed to install the 
software, you have to use the driver in the text mode. Follow 
the steps 3 to 4, and then follow the instructions on the terminal 
screen.

5.When the welcome screen appears, click Next.
6.When the installation is complete, click Finish.
The installation program added the Unified Driver Configurator desktop 
icon and the Unified Driver group to the system menu for your 
convenience. If you have any difficulties, consult the on-screen help that 
is available through your system menu or from the driver package 
Windows applications, such as Unified Driver Configurator or Image 
Manager.

Installing the SmartPanel
1.Make sure that the machine is connected to your computer and 

powered on.
2.When the Administrator Login window appears, type in “root” in the 

Login field and enter the system password.

 

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3.From the Samsung website, download and unpack the Smart Panel 
package to your computer.

4.Click  at the bottom of the desktop. When the Terminal screen 
appears, type in the following.
[root@localhost root]#tar zxf [FilePath]/SmartPanel.tar.gz
[root@localhost root]#cd [FilePath]/cdroot/Linux/smartpanel
[root@localhost smartpanel]#./install.sh

 

If you do not use the graphical interface and failed to install the 
software, you have to use the driver in the text mode. Follow 
the steps 3 to 4 and then follow the instructions on the terminal 
screen.

Installing the Printer Settings Utility
1.Make sure that the machine is connected to your computer and 

powered on.
2.When the Administrator Login window appears, type in “root” in the 

Login field and enter the system password.

 

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3.From the Samsung website, download and unpack the Printer Settings 
Utility package to your computer.

4.Click  at the bottom of the desktop. When the Terminal screen 
appears, type in the following.

[root@localhost root]#tar zxf [FilePath]/PSU.tar.gz
[root@localhost root]#cd [FilePath]/cdroot/Linux/psu
[root@localhost psu]#./install.sh

 

If you do not use the graphical interface and failed to install the 
software, you have to use the driver in the text mode. Follow the 
steps 3 to 4 and then follow the instructions on the terminal screen.

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow the steps below to uninstall the driver for Linux.
a)Make sure that the machine is connected to your computer and 

powered on.
b)When the Administrator Login window appears, type in “root” 

in the Login field and enter the system password.
You must log in as a super user (root) to uninstall the printer 
driver. If you are not a super user, ask your system 
administrator.

c)Click the icon at the bottom of the desktop. When the Terminal 
screen appears, type in the following.
[root@localhost root]#cd /opt/Samsung/mfp/uninstall/
[root@localhost uninstall]#./uninstall.sh

d)Click Uninstall.
e)Click Next. 
f)Click Finish.

Sharing your machine locally
Follow the steps below to set up computers to share your machine locally.
If the host computer is directly connected to the machine with a USB cable 
and is also connected to the local network environment, client computers 
connected to the local network can use the shared machine through the 
host computer to print. 

Windows
Setting up a host computer
1.Install your printer driver (See "Installing USB connected machine’s 

driver" on page 3).
2.Click the Windows Start menu. 
3.For Windows Server 2000, select Settings > Printers.

•For Windows XP/Server 2003, select Printers and Faxes. 
•For Windows Server 2008/Vista, select Control Panel > Hardware 

and Sound > Printers. 
•For Windows 7, select Control Panel > Devices and Printers. 
•For Windows Server 2008 R2, select Control Panel > Hardware > 

 

1
Host computer A computer, which is directly connected to 

the machine by a USB cable.
 

2
Client computers Computers, which use the machine shared 

through the host computer. 

2
1
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Devices and Printers. 
4.Right-click on the printer icon. 
5.For Windows XP/Server 2003/Server 2008/Vista, press Properties.

For Windows 7/Server 2008 R2, from context menus, select the 
Printer properties.

 

If Printer properties item has a ► mark, you can select other 
printer drivers connected with the selected printer.

6.Select the Sharing tab.
7.Check the Share this printer.

 

In Windows Vista or higher, press Change sharing options 
before check the Share this printer.

8.Fill in the Share Name field. Click OK.

Setting up a client computer
1.Install your printer driver (See "Installing USB connected machine’s 

driver" on page 3).
2.Click the Windows Start menu. 
3.Select All programs > Accessories > Windows Explorer.
4.Enter in IP address of the host computer and press Enter in your 

keyboard. 

 

In case the host computer requires a User name and 
Password, fill in User ID and password of the host computer 
account.

5.Right-click the printer icon you want to share and select Connect.
6.If a set up complete message appears, click OK. 
7.Open the file you want to print and start printing. 

Macintosh

 

The following steps are for Mac OS X 10.5 ~ 10.6. Refer to Mac Help 
for other versions. 

Setting up a host computer
1.Install your printer driver (See "Macintosh" on page 4).
2.Open the Applications folder > System Preferences, and click Print 

& Fax. 
3.Select your machine to share in the Printers list on the left pane of the 

window.
4.Select Share this printer.

Setting up a client computer
1.Install your printer driver (See "Macintosh" on page 4).
2.Open the Applications folder > System Preferences, and click Print 

& Fax. 
3.Press the “+” icon. 

A display window showing the name of your shared printer appears.
4.Select your machine and click Add. 
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1.network setup 
(clx-3185n/clx-3185wk/clx-3185fn/clx-3185f
w only)
This chapter gives you step-by-step instructions for setting up the network connected machine and software.
This chapter includes:
• Network environment
• Introducing useful network programs
• Using a wired network

• Installing wired network-connected machine’s driver
• IPv6 Configuration

  

 

Supported optional devices and features may differ according to your 
model. Check your model name. 
(See "Features by Models" on page 2).

Network environment
You need to set up the network protocols on the machine to use it as your 
network machine. You can set up the basic network settings through the 
machine's control panel.
The following table shows the network environments supported by the 
machine.

Introducing useful network programs
There are several programs available to setup the network settings easily in 
network environment. For the network administrator especially, managing 
several machines on the network is possible. 

 

Before using the programs below, set the IP address first.

SyncThru™ Web Service
Web server embedded on your network machine, which allows you to do 
the following tasks.
• You can configure the network parameters necessary for the machine to 

connect to various network environments.
• You can customize machine settings.

(See "Using SyncThru™ Web Service 
(CLX-3185N/CLX-3185WK/CLX-3185FN/CLX-3185FW only)" on 
page 1).

SyncThru™ Web Admin Service
Web-based machine management solution for network administrators. 
SyncThru™ Web Admin Service provides you with an efficient way of 
managing network devices and lets you remotely monitor and troubleshoot 
network machines from any site with corporate internet access. Download 
this program from http://solution.samsungprinter.com.

SetIP
This utility program allows you to select a network interface and manually 
configure the IP addresses for use with the TCP/IP protocol.
• See "IPv4 setting using SetIP Program (Windows)" on page 2.
• See "IPv4 setting using SetIP Program (Macintosh)" on page 3.
• See "IPv4 setting using SetIP Program (Linux)" on page 3.

 

TCP/IPv6 is not supported by this program.

Using a wired network
You must set up the network protocols on your machine to use it on your 
network. This chapter will show you how this is easily accomplished.

Item Requirements

Network interface • Ethernet 10/100 Base-TX
• 802.11b/n/g Wireless LAN 

(CLX-3185WK and CLX-3185FW only)

Network operating system • Windows 2000/Server 2003 /Server 
2008/XP/Vista/7/Server 2008 R2

• Various Linux OS
• Mac OS X 10.3 ~ 10.6

Network protocols • TCP/IPv4
• DHCP, BOOTP
• DNS, WINS, Bonjour, SLP, UPnP
• Standard TCP/IP Printing (RAW), LPR, 

IPP, WSD
• SNMPv 1/2/3, HTTP (S), IPSec
• TCP/IPv6 (DHCP, DNS, RAW, LPR, 

SNMPv 1/2/3, HTTP (S), IPSec)
(See "IPv6 Configuration" on page 6)

Wireless security • Authentication: Open System, Shared 
Key, WPA Personal, WPA2 Personal 
(PSK)

• Encryption: WEP64, WEP128, TKIP, 
AES
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You can use network after connecting network cable to a corresponding 
port on your machine. 

Printing a network configuration report
You can print Network Configuration Report from the machine’s control 
panel that will show the current machine’s network settings. This will help 
you to set up a network and troubleshoot problems.
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appears and press OK.
3. Press the left/right arrow until Network Info. appears and press OK.
4. Press the left/right arrow until Yes appears and press OK.
Using this Network Configuration Report, you can find your machine MAC 
address and IP address.
For example:
• MAC Address:00:15:99:41:A2:78
• IP Address:192.0.0.192

Setting IP address
First, you have to set up an IP address for network printing and 
managements. In most cases a new IP address will be automatically 
assigned by a DHCP (Dynamic Host Configuration Protocol) server located 
on the network.
In a few situations the IP address must be set manually. This is called a 
static IP and is often required in corporate Intranets for security reasons.
• DHCP IP assignment: Connect your machine to the network, and wait a 

few minutes for the DHCP server to assign an IP address to the 
machine. Then, print the Network Configuration Report as explained 
above. If the report shows that the IP address has changed, the 
assignment was successful. You will see the new IP address in the 
report.

• Static IP assignment: Use SetIP program to change the IP address 
from your computer. If your machine has a control panel, you can also 
change IP address using the machine's control panel.

In an office environment, we recommend that you contact a network 
administrator to set IP address for you.

IPv4 setting using control panel (Windows)
1.Connect your machine to the network with a network cable.
2.Turn on the machine.
3.Press Menu on the control panel.
4.Press the left/right arrow until Network appears and press OK.
5.Press the left/right arrow until TCP/IP appears and press OK.
6.Press the left/right arrow until Static appears and press OK.
7.Press the left/right arrow until IP Address appears and press OK.
8.Enter the IP address using numeric keypad and press OK.

 

Enter a byte between 0 and 255 using the number keypad and 
press the left/right arrow to move between bytes.
Repeat this to complete the address from the 1st byte to the 
4th byte.

9.Enter other parameters such as the Subnet Mask and Gateway 
appears and press OK.

10.After entering all parameters, press Stop/Clear to return to ready 
mode.

Now go to "Installing wired network-connected machine’s driver" on 
page 3.

IPv4 setting using SetIP Program (Windows)
This program is for manually setting the network IP address of your 
machine using its MAC address to communicate with the machine. A 
MAC address is the hardware serial number of the network interface and 
can be found in the Network Configuration Report.
Before using SetIP program, disable the computer firewall by performing 
the following steps.
1.Open Control Panel.
2.Double-click Security Center.
3.Click Windows Firewall.
4.Disable the firewall.

Installing the program
1.Insert the Printer Software CD-ROM provided with your machine. 

When the driver CD runs automatically, close that window.
2.Start Windows Explorer and open the X drive (X represents your 

CD-ROM drive).
3.Double-click Application > SetIP.
4.Double-click Setup.exe to install this program.
5.Select a language, then click Next.
6.Follow the instructions in the window and complete the installation.

Starting the program
1.Connect your machine to the network with a network cable.
2.Turn on the machine.
3.From the Windows Start menu, select All Programs > Samsung 

Printers > SetIP > SetIP.

4.Click on the  icon (third from left) in the SetIP window to open the 
TCP/IP configuration window.

5.Enter the machine’s new information into the configuration window as 
follows. In a corporate intranet, you may need to have this 
information assigned by a network manager before proceeding.

•MAC Address: Find the machine’s MAC address from the Network 
Configuration Report and enter it without the colons. For 
example, 00:15:99:29:51:A8 becomes 0015992951A8.

•IP Address: Enter a new IP address for your printer.
For example, if your computer’s IP address is 192.168.1.150, 
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enter 192.168.1.X (X is number between 1 and 254 other than 
the computer’s address).

•Subnet Mask: Enter a Subnet Mask.
•Default Gateway: Enter a Default Gateway.

6.Click Apply, and then click OK. The machine will automatically print 
the Network Configuration Report. Confirm that all the settings are 
correct.

7.Click Exit to close the SetIP program.
8.If necessary, restart the computer’s firewall.

IPv4 setting using SetIP Program (Macintosh)
For using SetIP program, disable the computer firewall before continuing 
by performing the following.
1.Open System Preferences.
2.Click Security.
3.Click the Firewall menu.
4.Turn firewall off.

 

The following instructions may vary from your model.

1.Connect your machine to the network with a network cable.
2.Insert the Installation CD-ROM, and open the disk window, select 

MAC_Installer > MAC_Printer > SetIP > SetIPapplet.html.
3.Double-click the file and Safari will automatically open, then select 

Trust. The browser will open the SetIPapplet.html page that shows 
the printer’s name and IP address information. 

4.Highlight the printer information row and select the Setup icon, which 
is the second icon from the left in the application menu bar. A TCP/IP 
Configuration window will open.

 

If the printer was not shown in the information row, select the 
Manual Setting icon (third from left) to open the TCP/IP 
Configuration window.

5.Enter the machine’s new information into the configuration window as 
follows. In a corporate intranet, you may need to have this 
information assigned by a network manager before proceeding.
•MAC Address: Find the machine’s MAC address from the Network 

Configuration Report and enter it without the colons. For 
example, 00:15:99:29:51:A8 becomes 0015992951A8.

•IP Address: Enter a new IP address for your printer.
For example, if your computer’s IP address is 192.168.1.150, 
enter 192.168.1.X (X is number between 1 and 254 other than 
the computer’s address).

•Subnet Mask: Enter a Subnet Mask.
•Default Gateway: Enter a Default Gateway.

6.Select Apply, then OK, and OK again. The printer will automatically 
print the configuration report. Confirm that all the settings are correct. 
Quit Safari. You may close and eject the installation CD-ROM. If 
necessary, restart the computer’s firewall. You have successfully 
changed the IP address, subnet mask, and gateway.

IPv4 setting using SetIP Program (Linux)
SetIP program should be automatically installed during the printer driver 
installation.
1.Print the machine’s network configuration report to find your machine’s 

MAC address. 
2.Open the /opt/Samsung/mfp/share/utils/.
3.Double-click the SetIPApplet.html file. 
4.Click to open the TCP/IP configuration window. 

5.Enter the network card’s MAC address, IP address, subnet mask, 
default gateway, and then click Apply. 

 

When you enter the MAC address, enter it without a colon(:).

6.The machine prints the network information. Confirm all the settings 
are correct. 

7.Close the SetIP program. 

Network parameter setting
You can also set up the various network settings through the network 
administration programs such as SyncThru™ Web Admin Service and 
SyncThru™ Web Service.

Restoring factory default settings
You may need to reset the machine to the factory default settings when 
machine that you are using is connected to new network environment.

Restoring factory default settings using control panel
1.Press Menu on the control panel.
2.Press the left/right arrow until Network appears and press OK.
3.Press the left/right arrow until Clear Setting appears and press OK.
4.Press the left/right arrow until Yes appears and press OK.
5.Turn off and restart machine to apply settings.

Restoring factory default settings using SyncThru™ 
Web Service
1.Start a web browser such as Internet Explorer, Safari or Firefox and 

enter your machine’s new IP address in the browser window.
For example:

2.Click Go to access the SyncThru™ Web Service.
3.Click Login on the upper right of the website.

The Login window appears. 
4.Type in the ID and Password, and then click Login.

If it is your first time logging into SyncThru™ Web Service, type in 
the below default ID and password.
•ID: admin 
•Password: sec00000 

5.Click Settings > Network Settings.
6.Click Restore Default on the left pane of the website.
7.Click Clear.
8.Click Yes when the confirmation window appears.
9.Click OK when the success window appears.
10.Turn off and restart machine to apply settings.

Installing wired network-connected machine’s 
driver
Windows
You can set up the machine driver, follow the steps below. 
This is recommended for most users. All components necessary for 
machine operations will be installed. 
1. Make sure that the machine is connected to the network or USB and 

powered on.
2. Insert the supplied software CD into your CD-ROM drive.
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•The software CD should automatically run and an installation window 
appears.

•If the installation window does not appear, click Start and then Run. 
Type X:\Setup.exe, replacing “X” with the letter which represents 
your CD-ROM drive. Click OK.

•If you use Windows Vista, Windows 7 or Windows 2008 Server R2 click 
Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your CD-ROM drive and click OK.

•If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

•If the AutoPlay window appears in Windows 7 or Windows 2008 Server 
R2, click Run Setup.exe in Install or run program field, and click 
Yes in the User Account Control windows.

3. Select Install Now.

If necessary, select a language from the drop-down list.

 

•For CLX-3185WK/CLX-3185FW, you can access Wireless 
Setting and Installation menu. The Wireless Setting and 
Installation allows you to install a wireless network to connect 
to the machine with a USB cable (See "Setting a wireless 
network with USB cable" on page 3).

•The Advanced Installation has two options, Custom 
Installation and Install Software Only. The Custom 
Installation allows you to select the machine’s connection and 
choose individual component to install. The Install Software 
Only allows you to install the supplied software such as Smart 
Panel. Follow the instruction on the window.

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.
The program searches for the machine.

 

If your machine is not found in the network or locally, the error 

message appears.

•Check if you want to install the software without connection 
of the printer.
-Check this option to install this program without a machine 

connected. In this case, the print a test page window will be 
skipped, and completes the installation.

•Search again
When you press this button, the firewall notice window 
appears.
-Turn off the firewall and Search again. For Windows 

operating system, click Start > Control Panel > Windows 
Firewall, and inactivate this option.

-Turn off the firewall from the third party's program beside the 
operating system. Refer to the manual provided by 
individual programs.

•Direct Input
The Direct Input allows you to search a specific machine on 
the network.
-Search by IP address: Enter the IP address or the host 

name. Then click Next.
To verify your machine’s IP address, print a network 
configuration report (See "Printing a network configuration 
report" on page 2).

-Search by network path: To find a shared machine (UNC 
Path), enter the shared name manually or find a shared 
printer by clicking the Browse button. Then click Next.

•Help
If your machine is not connected to the computer or network, 
this help button gives detailed information about the how to 
connect the machine.

•SNMP Community Name
If your system administrator set the new SNMP Community 
Name on the machine, you can find the machine in the 
network. Contact your system administrator for new SNMP 
Community Name.

5. The searched machine will be shown on the screen. Select the one you 
wish to use and click OK.

 

If the driver searched only one machine, the confirmation window 
appears.

6. After the installation is finished, a window asking you to print a test page 
appears. If you want to print a test page, click Print a test page.
Otherwise, just click Next and go to step 8.
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7. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

8. To register as a user of the machine in order to receive information from 
Samsung website, click On-line Registration.

 

If your machine is not connected yet to the network, click How to 
connect?. How to connect? gives detailed information about the 
how to connect the machine. Follow the instructions in the window.

9. Click Finish.

 

•After the driver setup is completed, you may enable firewall.
•If your printer driver does not work properly, follow the step below to 

repair or reinstall the driver.
a)Make sure that the machine is connected to your machine and 

powered on.
b)From the Start menu, select Programs or All Programs > 

Samsung Printers > your printer driver name > 
Maintenance.

c)Select the option as you wish, follow the instruction on the 
window.

Macintosh
1. Make sure that the machine is connected to your network and powered 

on. Also, your machine’s IP address should have been set. 
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Macintosh desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the Installer OS X icon.
6. Enter the password and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Read the license agreement and click Continue.
9. Click Agree to agree to the license agreement.
10. Select Easy Install and click Install. Easy Install is recommended for 

most users. All components necessary for machine operations will be 
installed. 
If you select Custom Install, you can choose individual components to 
install.

11. The message which warns that all applications will close on your 
computer appears. Click Continue.

12. Select Typical installation for a network printer for a network printer 
and then click OK.

13. The SetIP program automatically runs. If the machine has already 
configured network information, close the SetIP program.

14. Click OK to continue the installation.
15. The Fax Queue Creator window appears during the installation 

process.
•For CLX-3185N/CLX-3185WK, click Cancel to go to the next step.
•For CLX-3185FN/CLX-3185FW, select your machine name from the 

Printer Name list and click Create. When the confirmation window 
appears, click OK.

16. Click Continue on the Read me window.
17. After the installation is finished, click Restart.
18. Open the Applications folder > Utilities > Print Setup Utility.

•For Mac OS X 10.5~10.6, open the Applications folder > System 
Preferences and click Print & Fax.

19. Click Add on the Printer List.
•For Mac OS X 10.5~10.6, click the “+” icon. A display window will pop 

up. 

20. For Mac OS X 10.3, select the IP Printing tab.
•For Mac OS X 10.4, click IP Printer.
•For Mac OS X 10.5~10.6, click IP.

21. Select HP Jetdirect - Socket in Protocol.

 

When printing a document containing many pages, printing 
performance may be enhanced by choosing Socket for Printer 
Type option.

22. Enter the machine’s IP address in the Address input field.
23. Enter the queue name in the Queue input field. If you cannot determine 

the queue name for your machine server, try using the default queue 
first.

24. For Mac OS X 10.3, if Auto Select does not work properly, select 
Samsung in Printer Model and your machine name in Model Name.
•For Mac OS X 10.4, if Auto Select does not work properly, select 

Samsung in Print Using and your machine name in Model. 
•For Mac OS X 10.5~10.6, if Auto Select does not work properly, choose 

Select Printer Software and your machine name in Print Using.
Your machine appears on the Printer List, and is set as the default 
machine.

25. Click Add.

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow steps below to uninstall the driver for Macintosh.
a)Make sure that the machine is connected to your computer and 

powered on.
b)Insert the supplied software CD into your CD-ROM drive.
c)Double-click CD-ROM icon that appears on your Macintosh desktop.
d)Double-click the MAC_Installer folder.
e)Double-click the Installer OS X icon.
f)Enter the password and click OK.
g)The Samsung Installer window opens. Click Continue.
h)Select Uninstall and click Uninstall. 
i)When the message which warns that all applications will close on 

your computer appears, click Continue.
j)When the uninstall is done, click Quit.

Linux
You need to download Linux software packages from the Samsung website 
to install the printer software (http://www.samsung.com/printer).

 

To install other software:
•See "Installing the SmartPanel" on page 5.
•See "Installing the Printer Settings Utility" on page 5.

Install Linux Driver and add network Printer
1.Make sure that the machine is connected to your network and 

powered on. Also, your machine’s IP address should have been set. 
2.Download the Unified Linux Driver package from the Samsung 

website.
3.Extract the UnifiedLinuxDriver.tar.gz file and open the new directory.
4.Double-click the Linux folder.
5.Double-click the install.sh icon.
6.The Samsung Installer window opens. Click Continue.
7.The Add printer wizard window opens. Click Next.
8.Select Network printer and click Search button.
9.The Printer’s IP address and model name appears on list field.
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10.Select your machine and click Next.
11.Input the printer description and Next
12.When the add printer is done, click Finish
13.When the install is done, click Finish

Add network Printer
1.Double-click the Unified Driver Configurator.
2.Click Add Printer…
3.The Add printer wizard window opens. Click Next.
4.Select Network printer and click the Search button.
5.The printer’s IP address and model name appears on list field.
6.Select your machine and click Next.
7.Input the printer description and Next
8.When the add printer is done, click Finish.

IPv6 Configuration

 

TCP/IPv6 is supported properly only in Windows Vista or higher.

 

If the IPv6 network seems to not be working, set all the network setting 
to the factory defaults and try again (See "Restoring factory default 
settings" on page 3).

In the IPv6 network environment, follow the next procedure to use the IPv6 
address.
1. Connect your machine to the network with a network cable.
2. Turn on the machine.
3. Print a Network Configuration Report from the machine’s control 

panel that will check IPv6 addresses.

 

a)Press Menu on the control panel.
b)Press the left/right arrow until Network appears and press OK.
c)Press the left/right arrow until Network Info. appears and press 

OK.
d)Press the left/right arrow until Yes appears and press OK.

4. Select Start > Control Panel > Printers and Faxes.
5. Click Add a printer on the left pane of the Printers and Faxes 

windows.
6. Click Add a local printer on the Add Printer windows.
7. The Add Printer Wizard window appears. Follow the instruction on the 

window.

 

If the machine does not work in the network environment, activate 
IPv6. Refer to the next section followed by.

Activating IPv6
The machine is provided with IPv6 feature on.
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appears and press OK.
3. Press the left/right arrow until TCP/IP (IPv6) appears and press OK.
4. Press the left/right arrow until IPv6 Activate appears and press OK.
5. Press the left/right arrow until On appears and press OK.
6. Turn the machine off and turn it on again.
7. Reinstall your printer driver.

Setting IPv6 addresses
Machine supports the following IPv6 addresses for network printing and 
managements.

• Link-local Address: Self-configured local IPv6 address (Address starts 
with FE80).

• Stateless Address: Automatically configured IPv6 address by a 
network router.

• Stateful Address: IPv6 address configured by a DHCPv6 server.
• Manual Address: Manually configured IPv6 address by a user.

DHCPv6 address configuration (Stateful)
If you have a DHCPv6 server on your network, you can set one of the 
following option for default dynamic host configuration.
1.Press Menu on the control panel.
2.Press the left/right arrow until Network appears and press OK.
3.Press the left/right arrow until TCP/IP (IPv6) appears and press OK.
4.Press the left/right arrow until DHCPv6 Config appears and press OK.
5.Press the left/right arrow to access the required value.

•DHCPv6 Addr.: Always use DHCPv6 regardless of router request.
•DHCPv6 Off: Never use DHCPv6 regardless of router request.
•Router: Use DHCPv6 only when requested by a router.

6.Press OK.

Manual address configuration
1.Start a web browser such as Internet Explorer that supports IPv6 

addressing as a URL.
2.When the SyncThru™ Web Service window opens, move the mouse 

cursor on the Settings of the top menu bar and then click Network 
Settings.

3.Click TCP/IPv6 on the left pane of the website.
4.Select the Manual Address check box. Then, the Address/Prefix text 

box is activated.
5.Enter the rest of address (ex:3FFE:10:88:194::AAAA. “A” is the 

hexadecimal 0 through 9, A through F).
6.Click the Apply button.

Using SyncThru™ Web Service
1. Start a web browser such as Internet Explorer that supports IPv6 

addressing as a URL.
2. Select one of the IPv6 addresses (Link-local Address, Stateless 

Address, Stateful Address, Manual Address) from Network 
Configuration Report (See "Printing a network configuration report" on 
page 2).

3. Enter the IPv6 addresses (ex: http://[FE80::215:99FF:FE66:7701]).

 

Address must be enclosed in '[ ]' brackets.
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1.wireless network setup 
(clx-3185fw/clx-3185wk only)
This chapter gives you step-by-step instructions for setting up the wireless network connected machine and software.
This chapter includes:
• Using a wireless network
• Setting a wireless network with WPS button on the control panel
• Setting a wireless network with USB cable
• Setting a wireless network with network cable

• Resetting factory default values
• Completing the Installation
• Troubleshooting

  

 

For more information about network environment, network programs 
and Installing network connected machine’s driver, refer to following 
chapters. 
•See "Network environment" on page 1.
•See "Introducing useful network programs" on page 1.
•See "Setting a wireless network with USB cable" on page 3.
•See "Setting a wireless network with network cable" on page 8.

Using a wireless network
Choosing your network connection
Typically, you can only have one connection between your computer and 
the machine at a time. There are two types of network connections to 
consider. 
• Wireless network without an access point (Ad-Hoc mode) 
• Wireless network with an access point (Infrastructure mode) 

Printing a network configuration report
You can print Network Configuration Report from the machine’s control 
panel that will show the current machine’s network settings. This will help 
you to set up a network and troubleshoot problems.
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appears and press OK.
3. Press the left/right arrow until Network Info. appears and press OK.
4. Press the left/right arrow until Yes appears and press OK.
Using this Network Configuration Report, you can find your machine MAC 
address and IP address.
For example:
• MAC Address:00:15:99:41:A2:78
• IP Address:192.0.0.192

IP addresses
Every device in a network has a unique numerical address called an IP 
Address. Your machine came with a Default IP address of 192.0.0.192, 
which you can verify by printing out Network Configuration Report or 
Configuration Report.
• DHCP IP assignment: Connect your machine to the network, and wait a 

few minutes for the DHCP server to assign an IP address to the 
machine. Then, print the Network Configuration Report as explained 
above. If the report shows that the IP address has changed, the 
assignment was successful. You will see the new IP address in the 

report.
• Static IP assignment: Use SetIP program to change the IP address 

from your computer (See "Setting IP address" on page 2).
In an office environment, we recommend that you contact a network 
administrator to set IP address for your machine.

Wireless network name and Network Key
Wireless networks require higher security. When an access point is first set 
up, a network name (SSID), the type of security used and a Network Key 
should be created for the network. Check this information before proceeding 
with the machine installation.

 

After choosing your configuration, follow the simple directions for your 
computer operating system, but first locate the Software CD supplied 
with the machine before proceeding.

Installing a wireless network with the WPS button
If your machine and an access point (or wireless router) support Wi-Fi 
Protected Setup™(WPS), you can easily configure the wireless network 
settings by pressing the WPS ( ) button on the control panel (See 
"Setting a wireless network with WPS button on the control panel" on 
page 2).

Infrastructure mode
This is an environment generally used for homes 
and SOHOs. This mode uses an access point to 
communicate with the wireless machine.
• See "Installing the machine on a wireless 

network with an Access Point (Windows)" on 
page 3.

• See "Installing the machine on a wireless 
network with an Access Point (Macintosh)" on 
page 6.

Ad-Hoc mode
This mode does not use an access point, the 
wireless computer and wireless machine 
communicate directly.
• See "Installing the machine on an Ad-Hoc 

wireless network (Windows)" on page 5
• See "Installing the machine on an Ad-Hoc 

wireless network (Macintosh)" on page 7
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Installing a wireless network with cables
You can install a wireless network to connect to the machine with either a 
USB cable or a network cable. For most users, we recommend using a USB 
cable with the program provided in the supplied software CD. 
The following are two ways to install a wireless network with cables.
• With a USB cable: You can simply set up a wireless network using the 

program in the supplied software CD. Only Windows and Macintosh 
operating system are supported (See "Setting a wireless network with 
USB cable" on page 3).

 

You can also install a wireless network in Printer Settings Utility 
with a USB cable after installing driver (Windows and Macintosh 
operating system are supported).

• With a network cable: You can set up a wireless network using the 
SyncThru™ Web Service program (See "Setting a wireless network with 
network cable" on page 8).

Setting a wireless network with WPS button on 
the control panel
If your machine and an access point (or wireless router) support Wi-Fi 
Protected Setup™(WPS), you can easily configure the wireless network 
settings by pressing the WPS ( ) button on the control panel.

Items to prepare
You need to ensure you have the following items ready to use:
• Check if the access point (or wireless router) supports Wi-Fi Protected 

Setup™(WPS).
• Check if your machine supports Wi-Fi Protected Setup™(WPS).

Choosing your network connection
There are two methods to connect your machine to a wireless network by 
using the WPS ( ) button on the control panel.
The Push Button Configuration (PBC) method allows you to connect your 
machine to a wireless network by pressing both the WPS button on the 
control panel of your machine and the WPS (PBC) button on a Wi-Fi 
Protected Setup™(WPS)-enabled access point (or wireless router) 
respectively.
The Personal Identification Number (PIN) method helps you connect your 
machine to a wireless network by entering the supplied PIN information on a 
Wi-Fi Protected Setup™(WPS)-enabled access point (or wireless router).
Factory default in your machine is PBC mode, which is recommended for a 
typical wireless network environment.

 

Access point (or wireless router) that supports WPS (Wi-Fi Protected 
Setup™) has the symbol shown below.

Changing WPS mode
Factory default in your machine is PBC mode. To change WPS mode, 
follow the steps below.
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appears and press OK.
3. Press the left/right arrow until Wireless appears and press OK.
4. Press the left/right arrow until WPS Setting appears and press OK.

5. Press the left/right arrow until the WPS mode you want appears and 
press OK.
•PBC mode: Pressing both the WPS ( ) button on the control panel 

of your machine and the WPS (PBC) button on a Wi-Fi Protected 
Setup™(WPS)-enabled access point (or wireless router) 
respectively, you can easily connect your machine to a wireless 
network.

•PIN mode: Entering the supplied PIN number on a Wi-Fi Protected 
Setup™(WPS)-enabled access point (or wireless router), you can 
manually connect your machine to a wireless network.

6. Press Stop/Clear to return to ready mode.

Setting a wireless network in PBC mode
Factory default in your machine is PBC mode.

Connecting to a wireless network in PBC mode
To connect your machine to the wireless network in PBC mode, follow 
the steps below. You also need to check the WPS ( ) button on the 
control panel and the messages on the display.

 

You can check the status of the wireless network connection (See 
"Understanding the Status LED" on page 8).

1.Press the WPS ( ) button for more than two seconds on the 
control panel.

2.Push WPS on AP within 02:00: The machine starts waiting for up to 
two minutes until you press the WPS (PBC) button on the access 
point (or wireless router).

3. : Press the WPS (PBC) button on the access point (or wireless 
router) within two minutes.

4.Connecting: The machine is connecting to the access point (or 
wireless router).

5.Connected: When the machine is successfully connected to the 
wireless network, the blue wireless LED light stays on.
•AP SSID: After completing the wireless network connection 

process, AP’s SSID information appears on the display.

 

If the machine fails to connect to the wireless network, the 
Connecting Failed and the Wait 2 minutes for Reconnecting 
messages appear in turn on the display. Then, the machine tries to 
re-connect to the wireless network.

Re-connecting to a wireless network in PBC mode
If you press the WPS ( ) button on the control panel when the 
wireless function is off, the machine automatically tries to re-connect to 
the access point (or wireless router) with the previously used wireless 
connection settings and address.
1.Connecting: If you press the WPS ( ) button on the control panel 

when the wireless function is off, the machine automatically tries to 
re-connect to the access point (or wireless router) with the previously 
used wireless connection settings and address.

2.Connected: When the machine is successfully connected to the 
wireless network, the blue wireless LED light stays on. 
•AP SSID: After completing the wireless network connection 

process, AP’s SSID information appears on the display.

 

If there is no previously used access point (or wireless router), 
or the network settings have been changed, the Connecting 
Failed and the Wait 2 minutes for Reconnecting messages 
appear in turn on the display, and then the machine tries to 
re-connect to the wireless network. After the second attempt to 
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connect, the machine stops the wireless connection function if 
the machine fails to get the wireless connection. Try again to 
connect to the wireless network after solving the connection 
problem.

Canceling a wireless network connection process in 
PBC mode
To cancel the wireless network connection function when the machine is 
connecting to the access point (or wireless router) in PBC mode, press 
the WPS ( ) button on the control panel again. The Connecting 
Canceled and the Wait 2 minutes for Reconnecting messages 
appear in order on the display.

Disconnecting a wireless network connection in PBC 
mode
To disconnect the wireless network connection, press the WPS ( ) 
button on the control panel again.
•When the access point (Wi-Fi Network) is in idle mode: The 

Disconnected message appears on the display. The machine is 
returned to ready mode.

•When the access point (Wi-Fi Network) is being used: The Wait 
Job to Finish message appears on the display. The machine waits 
until the current job is finished. Then, the wireless network 
connection is automatically disconnected. The machine is returned 
to ready mode.

Setting a wireless network in PIN mode
Factory default in your machine is PBC mode. To change to PIN mode, 
refer to "Changing WPS mode" on page 2.

Connecting a wireless network in PIN mode
To connect to the wireless network in PIN mode, follow the steps below. 
You also need to check the status of the WPS ( ) button and the 
wireless LED.

1.Press the WPS ( ) button for more than four seconds on the 
control panel.

2.Enter xxxx-xxxx on AP:02:00: Eight-digit PIN number appears on 
the display. Then, the machine starts waiting for up to two minutes 
until you enter the supplied PIN number on the access point (or 
wireless router).

3. : Enter the supplied PIN number on the access point (or wireless 
router) within two minutes.

4.Connecting: The machine is connecting to the wireless network.
5.Connected: When the machine is successfully connected to the 

wireless network, the blue wireless LED light stays on.
•AP SSID: After completing the wireless network connection 

process, AP’s SSID information appears on the display.

 

If the machine fails to connect to the wireless network, the 
Connecting Failed and the Wait 2 minutes for 
Reconnecting messages appear in turn on the display. Then, 
the machine tries to re-connect to the wireless network.

Re-connecting to a wireless network in PIN mode
If you press the WPS ( ) button on the control panel when the 
wireless function is off, the machine automatically tries to re-connect to 
the access point (or wireless router) with the previously used wireless 
connection settings and address.

1.Connecting: If you press the WPS ( ) button on the control panel 
when the wireless function is off, the machine automatically tries to 
re-connect to the access point (or wireless router) with the previously 
used wireless connection settings and address.

2.Connected: When the machine is successfully connected to the 
wireless network, the blue wireless LED light stays on. 
•AP SSID: After completing the wireless network connection 

process, AP’s SSID information appears on the display.

 

If there is no previously used access point (or wireless router), 
or the network settings have been changed, the Connecting 
Failed and the Wait 2 minutes for Reconnecting messages 
appear in turn on the display, and then the machine tries to 
re-connect to the wireless network. After the second attempt to 
connect, the machine stops the wireless connection function if 
the machine fails to get the wireless connection. Try again to 
connect to the wireless network after solving the connection 
problem.

Canceling a wireless network connection process in 
PIN mode
To cancel the wireless network connection function when the machine is 
connecting to the access point (or wireless router) in PIN mode, press 
the WPS ( ) button on the control panel again. The Connecting 
Canceled and the Wait 2 minutes for Reconnecting messages 
appear in order on the display.

Disconnecting a wireless network connection in PIN 
mode
To disconnect the wireless network connection, press the WPS ( ) 
button on the control panel again.
•When the access point (Wi-Fi Network) is in idle mode: The 

Disconnected message appears on the display. The machine is 
returned to ready mode.

•When the access point (Wi-Fi Network) is being used: The Wait 
Job to Finish message appears on the display. The machine waits 
until the current job is finished. Then, the wireless network 
connection is automatically disconnected. The machine is returned 
to ready mode.

Setting a wireless network with USB cable

 

Refer to your network administrator or the person that set up your 
wireless network for information about your network configuration.

Installing the machine on a wireless network with an 
Access Point (Windows) 

Items to prepare
Ensure you have next items ready.
• Access point
• Network-connected computer
• Software CD that provided with your machine
• The machine installed with a wireless network interface
• USB cable

Creating the infrastructure network in Windows
When the items are ready, follow below steps:
Wireless network setup (CLX-3185FW/CLX-3185WK only)_ 3



1. Check whether the USB cable is connected to the machine.
2.Turn on your computer, access point and machine.
3.Insert the supplied software CD into your CD-ROM drive.

•The software CD should automatically run and an installation 
window appears.

•If the installation window does not appear, click Start and then Run. 
Type X:\Setup.exe, replacing “X” with the letter which represents 
your CD-ROM drive. Click OK.

•If you use Windows Vista, Windows 7 or Windows 2008 Server R2 
click Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your CD-ROM drive and click OK.

•If the AutoPlay window appears in Windows Vista, Windows 7 or 
Windows 2008 Server R2, click Run Setup.exe in Install or run 
program field, and click Continue or Yes in the User Account 
Control windows.

4.Select the Wireless Setting and Installation option.
5.Read License Agreement, and select I accept the terms of the 

License Agreement. Then, click Next.
6.The software searches the wireless network.

 

If the searching has failed, you may check if the USB cable is 
connected between the computer and machine properly, and 
follow the instruction on the window.

7.After searching, the window shows the wireless network devices. 
Select the name (SSID) of access point you are using, and click 
Next.

 

If you cannot find out the network name you want to choose, or 
if you want to set the wireless configuration manually, click 
Advanced Setting.
•Enter the wireless Network Name: Type the SSID of 

access point you want (SSID is case-sensitive).
•Operation Mode: Select Infrastructure.
•Authentication: Select an authentication type.

Open System: Authentication is not used, and encryption 
may or may not be used depending on the need for data 
security.
Shared Key: Authentication is used. A device that has a 
proper WEP key can access the network.
WPA Personal or WPA2 Personal: Select this option to 
authenticate the print server based on WPA Pre-Shared 
Key. This uses a shared secret key (generally called Pre 
Shared Key passphrase), which is manually configured on 
the access point and each of its clients.

•Encryption: Select the encryption. (None, WEP64, WEP128, 
TKIP, AES, TKIP AES)

•Network Key: Enter the encryption network key value.
•Confirm Network Key: Confirm the encryption network key 

value.
•WEP Key Index: If you are using the WEP Encryption, select 

the appropriate WEP Key Index.

 

The wireless network security window appears when the 
access point has security setting.
The wireless network security window appears. The window 
may differ according to its security mode, WEP or WPA.
•In case of WEP

Select Open System or Shared Key for the authentication 
and enter WEP security key. Click Next.

WEP (Wired Equivalent Privacy) is a security protocol 
preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged 
on a wireless network using a 64-bit or 128-bit WEP 
encryption key.

•In case of WPA
Enter the WPA shared key and click Next.
WPA authorizes and identifies users based on a secret key 
that changes automatically at regular intervals. WPA also 
uses TKIP (Temporal Key Integrity Protocol) and AES 
(Advanced Encryption Standard) for data encryption.

8.The window shows the wireless network setting, and check if settings 
are right. Click Next.
•For the DHCP method

If the IP address assignment method is DHCP, check if DHCP is 
shown in the window. However, if it shows Static, click Change 
TCP/IP to change the assignment method to DHCP.

•For the Static method
If the IP address assignment method is Static, check if Static is 
shown in the window. However, if it shows DHCP, click Change 
TCP/IP to enter the IP address and other network configuration 
values for the machine. Before entering the IP address for the 
machine, you must know the computer’s network configuration 
information. If the computer is set to DHCP, you must contact the 
network administrator to get the static IP address.
Example)
If computer’s network information is as below:
-IP address: 169.254.133.42
-Subnet Mask: 255.255.0.0
Machine’s network information should be as below:
-IP address: 169.254.133. 43 (Use computer’s IP address, with 

changed last three digits.)
-Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)
-Gateway: 169.254.133.1 (Change the last three digits from IP 

address of your machine to 1.)
9.When the wireless network setting is completed, disconnect the USB 

cable between the computer and machine. Click Next.
10.The Wireless Network Setting Complete window appears.

Select Yes if you accept the current settings and continue the setup 
procedure.
Select No if you want to return to the beginning screen. 
Then, click Next.

11.Click Next when the Confirm Printer Connection window appears.
12.Select the components to be installed. Click Next.

After selecting the components, you can also change the machine 
name, set the machine to be shared on the network, set the machine 
as the default machine, and change the port name of each machine. 
Click Next.

13.After the installation is finished, a window asking you to print a test 
page appears. If you want to print a test page, click Print a test 
page.
Otherwise, just click Next and go to step 16.

14.If the test page prints out correctly, click Yes.
If not, click No to reprint it.

15.To register as a user of the machine in order to receive information 
from Samsung, click On-line Registration.

16.Click Finish.
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Installing the machine on an Ad-Hoc wireless 
network (Windows) 
If you do not have an Access Point (AP), you may still connect the machine 
wirelessly to your computer by setting up an Ad-Hoc wireless network by 
following the simple steps below.

Items to prepare
Ensure you have next items ready.
•Network-connected computer
• Software CD provided with your machine
• The machine installed with a wireless network interface
• USB cable

Creating the Ad-Hoc network in Windows
When the items are ready, follow below steps:
1. Check whether the USB cable is connected to the machine.
2.Turn on your computer and the wireless network machine.
3.Insert the supplied software CD into your CD-ROM drive.

•The software CD should automatically run and an installation 
window appear.

•If the installation window does not appear, click Start and then Run. 
Type X:\Setup.exe, replacing “X” with the letter which represents 
your CD-ROM drive. Click OK.

•If you use Windows Vista, Windows 7 or Windows 2008 Server R2 
click Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your CD-ROM drive and click OK.

•If the AutoPlay window appears in Windows Vista, Windows 7 or 
Windows 2008 Server R2, click Run Setup.exe in Install or run 
program field, and click Continue or Yes in the User Account 
Control windows.

4.Select the Wireless Setting and Installation option.
5.Read the License Agreement, and select I accept the terms of the 

License Agreement. Then, click Next.
6.The software searches the wireless network.

 

If the software has failed to search the network, check if the 
USB cable is connected properly between the computer and 
machine, and follow the instruction on the window.

7.After searching the wireless network, a list of wireless network your 
machine has searched appears. 
If you want to use the Samsung default ad-hoc setting, select the last 
wireless network on the list, which Network Name(SSID) is portthru 
and Signal is Printer Self Network.
Then, click Next.
If you want to use other ad-hoc settings, select other wireless 
network from the list. 

 

If you cannot find out the network name you want to choose, or 
if you want to set the ad-hoc configuration manually, click 
Advanced Setting.
•Enter the wireless Network Name: Type in the SSID name 

you want (SSID is case-sensitive).
•Operation Mode: Select Ad-hoc.
•Channel: Select the channel.
•Authentication: Select an authentication type.

Open System: Authentication is not used, and encryption 
may or may not be used depending on the need for data 
security.

Shared Key: Authentication is used. A device that has a 
proper WEP key can access the network.

•Encryption: Select the encryption. (None, WEP64, WEP128)
•Network Key: Enter the encryption network key value.
•Confirm Network Key: Confirm the encryption network key 

value.
•WEP Key Index:  If you are using the WEP Encryption, select 

the appropriate WEP Key Index.

 

The wireless network security window appears when the 
ad-hoc network has security setting.
The wireless network security window appears. Select Open 
System or Shared Key for the authentication and click Next.
•WEP (Wired Equivalent Privacy) is a security protocol 

preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged 
on a wireless network using a 64-bit or 128-bit WEP 
encryption key.

8.The window shows the wireless network setting, and check if settings 
are right. Click Next.

 

Before entering the IP address for the machine, you must know 
the computer’s network configuration information. If the 
computer’s network configuration is set to DHCP, the wireless 
network setting should also be DHCP. Likewise, if the 
computer’s network configuration is set to Static, the wireless 
network setting should also be Static.
If your computer is set to DHCP and you want to use Static 
wireless network setting, you must contact the network 
administrator to get the static IP address.
•For the DHCP method

If the IP address assignment method is DHCP, check if 
DHCP is shown in the Wireless Network Setting Confirm 
window. However, if it shows Static, click Change TCP/IP 
to change the assignment method to Receive IP address 
automatically (DHCP).

•For the Static method
If the IP address assignment method is Static, check if 
Static is shown in the Wireless Network Setting Confirm 
window. However, if it shows DHCP, click Change TCP/IP 
to enter the IP address and other network configuration 
values for the machine.
Example)
If computer’s network information is as below:
-IP address: 169.254.133.42
-Subnet Mask: 255.255.0.0
Machine’s network information should be as below:
-IP address: 169.254.133. 43 (Use the computer’s IP 

address, with changed last three digits.)
-Subnet Mask: 255.255.0.0 (Use the computer’s subnet 

mask.)
-Gateway: 169.254.133.1 (Change the last three digits from 

IP address of your machine to 1.)
9.When the wireless network setting is completed, disconnect the USB 

cable between the computer and machine. Click Next.

 

If the Change PC Network Setting window appears, follow 
the steps on the window.
Click Next if you are finished the computer’s wireless network 
settings.
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If you set the computer’s wireless network as DHCP, it will take 
several minutes to receive the IP address.

10.The Wireless Network Setting Complete window appears.
Select Yes if you accept the current settings and continue the setup 
procedure.
Select No if you want to return to the beginning screen. 
Then, click Next.

11.Click Next when the Confirm Printer Connection window appears.
12.Select the components to be installed. Click Next.

After selecting the components, you can also change the machine 
name, set the machine to be shared on the network, set the machine 
as the default machine, and change the port name of each machine. 
Click Next.

13.After the installation is finished, a window asking you to print a test 
page appears. If you want to print a test page, click Print a test 
page.
Otherwise, just click Next and go to step 16.

14.If the test page prints out correctly, click Yes.
If not, click No to reprint it.

15.To register as a user of the machine in order to receive information 
from Samsung, click On-line Registration.

16.Click Finish.

Installing the machine on a wireless network with an 
Access Point (Macintosh) 

Items to prepare
Ensure you have next items ready.
• Access point
•Network-connected computer
•Software CD that provided with your machine
•The machine installed with a wireless network interface
• USB cable

Creating the infrastructure network in Macintosh
When the items are ready, follow below steps:
1. Check whether the USB cable is connected to the machine.
2.Turn on your computer, access point and machine.
3.Insert the supplied software CD into your CD-ROM drive.
4.Double-click the CD-ROM icon that appears on your Macintosh 

desktop.
5.Double-click the MAC_Installer folder.
6.Double-click the Installer OS X icon.
7.Enter the password and click OK.
8.The Samsung Installer window opens. Click Continue.
9.Read the license agreement and click Continue.
10.Click Agree to agree to the license agreement.
11.Select Easy Install and click Install. Easy Install is recommended 

for most users. All components necessary for machine operations 
will be installed.
If you select Custom Install, you can choose individual components 
to install.

12.When the message which warns that all applications will close on 
your computer appears, click Continue.

13.Select the Wireless Setting and Installation option and then click 
OK.

14.The software searches the wireless network.

 

If the searching has failed, you may check if the USB cable is 
connected between the computer and machine properly, and 
follow the instruction on the window.

15.After searching, the window shows the wireless network devices. 
Select the name (SSID) of access point you are using and click 
Next.

 

If you cannot find out the network name you want to choose, or 
if you want to set the wireless configuration manually, click 
Advanced Setting.
•Enter the wireless Network Name: Type the SSID of 

access point you want (SSID is case-sensitive).
•Operation Mode: Select Infrastructure.
•Authentication: Select an authentication type.

Open System: Authentication is not used, and encryption 
may or may not be used, depending on the need for data 
security.
Shared Key: Authentication is used. A device that has a 
proper WEP key can access the network.
WPA Personal or WPA2 Personal: Select this option to 
authenticate the print server based on WPA Pre-Shared 
Key. This uses a shared secret key (generally called Pre 
Shared Key passphrase) which is manually configured on 
the access point and each of its clients.

•Encryption: Select the encryption. (None, WEP64, WEP128, 
TKIP, AES, TKIP AES)

•Network Key: Enter the encryption network key value.
•Confirm Network Key: Confirm the encryption network key 

value.
•WEP Key Index: If you are using the WEP Encryption, select 

the appropriate WEP Key Index.

 

The wireless network security window does appear when the 
access point has security setting.
The wireless network security window appears. The window 
may differ according to its security mode, WEP or WPA.
•In case of WEP

Select Open System or Shared Key for the authentication 
and enter WEP security key. Click Next.
WEP (Wired Equivalent Privacy) is a security protocol 
preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged 
on a wireless network using a 64-bit or 128-bit WEP 
encryption key.

•In case of WPA
Enter the WPA shared key and click Next.
WPA authorizes and identifies users based on a secret key 
that changes automatically at regular intervals. WPA also 
uses TKIP (Temporal Key Integrity Protocol) and AES 
(Advanced Encryption Standard) for data encryption.

16.The window shows the wireless network setting and check if settings 
are right. Click Next.
•For the DHCP method

If the IP address assignment method is DHCP, check if DHCP is 
shown in the window. However, if it shows Static, click Change 
TCP/IP to change the assignment method to DHCP.

•For the Static method
If the IP address assignment method is Static, check if Static is 
shown in the window. However, if it shows DHCP, click Change 
TCP/IP to enter the IP address and other network configuration 
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values for the machine. Before entering the IP address for the 
machine, you must know the computer’s network configuration 
information. If the computer is set to DHCP, you must contact the 
network administrator to get the static IP address.
Example)
If computer’s network information is as below:
-IP address: 169.254.133.42
-Subnet Mask: 255.255.0.0
Machine’s network information should be as below:
-IP address: 169.254.133. 43 (Use computer’s IP address, with 

changed last three digits.)
-Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)
-Gateway: 169.254.133.1 (Change the last three digits from IP 

address of your machine to 1.)
17.The wireless network is connecting according to the network 

configuration.
18.When the wireless network setting is completed, disconnect the USB 

cable between the computer and machine. Click Next.
19.The Installation process is being executed.
20.The Fax Queue Creator window appears during the installation 

process.
•For CLX-3185WK, click Cancel to go to the next step.
•For CLX-3185FW, select your machine name from the Printer 

Name list and click Create. When the confirmation window 
appears, click OK.

21.Click Continue on the Read Me window.
22.After the installation is finished, click Restart.

Installing the machine on an Ad-Hoc wireless 
network (Macintosh) 
If you do not have a Access Point (AP), you may still connect the machine 
wirelessly to your computer by setting up an Ad-Hoc wireless network by 
following these simple directions.

Items to prepare
Ensure you have next items ready.
•Network-connected computer
• Software CD that provided with your machine
• The machine installed with a wireless network interface
• USB cable

Creating the Ad-Hoc network in Macintosh
When the items are ready, follow below steps:
1. Check whether the USB cable is connected to the machine.
2.Turn on your computer and machine.
3.Insert the supplied software CD into your CD-ROM drive.
4.Double-click the CD-ROM icon that appears on your Macintosh 

desktop.
5.Double-click the MAC_Installer folder.
6.Double-click the Installer OS X icon.
7.Enter the password and click OK.
8.The Samsung Installer window opens. Click Continue.
9.Read the license agreement and click Continue.
10.Click Agree to agree to the license agreement.
11.Select Easy Install and click Install. Easy Install is recommended 

for most users. All components necessary for machine operations 
will be installed.

If you select Custom Install, you can choose individual operations 
will be installed.

12.When the message which warns that all applications will close on 
your computer appears, click Continue.

13.Select the Wireless Setting and Installation option and then click 
OK.

14.The software searches the wireless network.

 

If the searching has failed, you may check if the USB cable is 
connected between the computer and machine properly, and 
follow the instruction on the window.

15.After searching the wireless network, a list of wireless network your 
machine has searched appears. 
If you want to use the Samsung default ad-hoc setting, select the last 
wireless network on the list, which Network Name(SSID) is portthru 
and Link Quality is Printer Self Network.
Then, click Next.
If you want to use other ad-hoc settings, select other wireless 
network from the list. 

 

If you cannot find out the network name you want to choose, or 
if you want to set the ad-hoc configuration manually, click 
Advanced Setting.
•Enter the wireless Network Name: Type in the SSID name 

you want (SSID is case-sensitive).
•Operation Mode: Select Ad-hoc.
•Channel: Select the channel.
•Authentication: Select an authentication type.

Open System: Authentication is not used, and encryption 
may or may not be used, depending on the need for data 
security.
Shared Key: Authentication is used. A device that has a 
proper WEP key can access the network.

•Encryption: Select the encryption. (None, WEP64, WEP128)
•Network Key: Enter the encryption network key value.
•Confirm Network Key: Confirm the encryption network key 

value.
•WEP Key Index:  If you are using the WEP Encryption, select 

the appropriate WEP Key Index.

 

The wireless network security window appears when the 
ad-hoc network has security setting.
The wireless network security window appears. Select Open 
System or Shared Key for the authentication and click Next.
•WEP (Wired Equivalent Privacy) is a security protocol 

preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged 
on a wireless network using a 64-bit or 128-bit WEP 
encryption key.

16.The window which shows the wireless network setting appears. 
Check the settings and click Next.

 

Before entering the IP address for the machine, you must know 
the computer’s network configuration information. If the 
computer’s network configuration is set to DHCP, the wireless 
network setting should also be DHCP. Likewise, if the 
computer’s network configuration is set to Static, the wireless 
network setting should also be Static.
If your computer is set to DHCP and you want to use Static 
wireless network setting, you must contact the network 
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administrator to get the static IP address.
•For the DHCP method

If the IP address assignment method is DHCP, check if 
DHCP is shown in the Wireless Network Setting Confirm 
window. However, if it shows Static, click Change TCP/IP 
to change the assignment method to Receive IP address 
automatically (DHCP).

•For the Static method
If the IP address assignment method is Static, check if 
Static is shown in the Wireless Network Setting Confirm 
window. However, if it shows DHCP, click Change TCP/IP 
to enter the IP address and other network configuration 
values for the machine.
Example)
If computer’s network information is as below:
-IP address: 169.254.133.42
-Subnet Mask: 255.255.0.0
Machine’s network information should be as below:
-IP address: 169.254.133. 43 (Use computer’s IP address, 

with changed last three digits.)
-Subnet Mask: 255.255.0.0 (Use the computer’s subnet 

mask.)
-Gateway: 169.254.133.1 (Change the last three digits from 

IP address of your machine to 1.)
17.The wireless network is connecting according to the network 

configuration.
18.When the wireless network setting is completed, disconnect the USB 

cable between the computer and machine. Click Next.
19.The Installation process is being executed.
20.The Fax Queue Creator window appears during the installation 

process.
•For CLX-3185WK, click Cancel to go to the next step.
•For CLX-3185FW, select your machine name from the Printer 

Name list and click Create. When the confirmation window 
appears, click OK.

21.Click Continue on the Read Me window.
22.After the installation is finished, click Restart.

Setting a wireless network with network cable
Your machine is a network compatible machine. To enable your machine to 
work with your network, you will need to perform some configuration 
procedures.

 

Refer to your network administrator, or the person that set up your 
wireless network for information about your network configuration.

Preparing items
Ensure you have next items ready.
• Access point
• Network-connected computer
• Software CD that provided with your machine
• Wireless network printer (your machine)
• Network cable

Setting IP address
First, you have to set up an IP address for network printing and 
managements. In most cases, a new IP address will be automatically 
assigned by a DHCP (Dynamic Host Configuration Protocol) server located 
on the network.
In a few situations, the IP address must be set manually. This is called a 
static IP and is often required in a corporate Intranets for security reasons.
• DHCP IP assignment: Connect your machine to the network, and wait a 

few minutes for the DHCP server to assign an IP address to the 
machine. Then, print the Network Configuration Report as explained 
above. If the report shows that the IP address has changed, the 
assignment was successful. You will see the new IP address in the 
report. (See "Printing a network configuration report" on page 2.)

• Static IP assignment: Use SetIP program to change the IP address 
from your computer.

In an office environment, we recommend that you contact a network 
administrator to set this address for you.

IP setting using SetIP Program (Windows)
This program is for manually setting the network IP address of your 
machine using its MAC address to communicate with the machine. A 
MAC address is the hardware serial number of the network interface and 
can be found in the Network Configuration Report.
For using SetIP program, disable the computer firewall before continuing 
by performing the following:
1.Open Start > All programs > Control Panel.
2.Double-click Security Center.
3.Click Windows Firewall.
4.Disable the firewall.

Installing the program
1.Insert the software CD provided with your machine. When the driver 

CD runs automatically, close that window.
2.Start Windows Explorer and open the X drive. (X represents your 

CD-ROM drive.)
3.Double-click Application > SetIP.
4.Double-click Setup.exe to install this program.
5.Click OK. If necessary, select a language from the drop-down list.
6.Follow the instructions in the window and complete the installation.

Starting the program
1.Connect your machine to the network with a network cable.
2.Turned on the machine.
3.From the Windows Start menu, select All Programs > Samsung 

Printers > SetIP > SetIP.
4.Click on the  icon (third from left) in the SetIP window to open the 

TCP/IP configuration window.
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5.Enter the machine’s new information into the configuration window as 
follows. In a corporate intranet, you may need to have this 
information assigned by a network manager before proceeding.

•MAC Address: Find the machine’s MAC address from the Network 
Configuration Report and enter it without the colons. For 
example, 00:15:99:29:51:A8 becomes 0015992951A8.

•IP Address: Enter a new IP address for your printer.
For example, if your computer’s IP address is 192.168.1.150, 
enter 192.168.1.X. (X is number between 1 and 254 other than 
the computer’s address.)

•Subnet Mask: Enter a Subnet Mask.
•Default Gateway: Enter a Default Gateway.

6.Click Apply, and then click OK. The machine will automatically print 
the Network Configuration Report. Confirm that all the settings are 
correct.

7.Click Exit to close the SetIP program.
8.If necessary, restart the computer’s firewall.

IP setting using SetIP Program (Macintosh)
For using SetIP program, disable the computer firewall before continuing 
by performing the following:

 

The path and UIs may differ by Macintosh OS version. Refer to the 
Macintosh OS manual.

1.Open System Preferences.
2.Click Security.
3.Click the Firewall menu.
4.Turn firewall off.

 

The following instructions may vary for your model.

1.Connect your machine to the network with a network cable.
2.Insert the Installation CD-ROM, and open the disk window, select 

MAC_Installer > MAC_Printer > SetIP > SetIPApplet.html.
3.Double-click the file and Safari will automatically open, then select 

Trust. The browser will open the SetIPApplet.html page that shows 
the printer’s name and IP address information. 

4.Click on the  icon (third from left) in the SetIP window to open the 
TCP/IP configuration window.

5.Enter the machine’s new information into the configuration window as 
follows. In a corporate intranet, you may need to have this 
information assigned by a network manager before proceeding.
•MAC Address: Find the machine’s MAC address from the Network 

Configuration Report and enter it without the colons. For 

example, 00:15:99:29:51:A8 becomes 0015992951A8.
•IP Address: Enter a new IP address for your printer.

For example, if your computer’s IP address is 192.168.1.150, 
enter 192.168.1.X. (X is number between 1 and 254 other than 
the computer’s address.)

•Subnet Mask: Enter a Subnet Mask.
•Default Gateway: Enter a Default Gateway.

6.Select Apply, then OK, and OK again. The printer will automatically 
print the configuration report. Confirm that all the settings are correct. 
Quit Safari. You may close and eject the installation CD-ROM. If 
necessary, restart the computer’s firewall. You have successfully 
changed the IP address, subnet mask, and gateway.

Configuring the machine’s wireless network
Before starting, you will need to know the network name(SSID) of your 
wireless network and the network key if it is encrypted. This information was 
set when the wireless router(access point) was installed. If you do not know 
about your wireless environment, please ask the person who has set up 
your network.
To configure wireless parameters, you can use SyncThru™ Web Service.

Using SyncThru™ Web Service
Before starting the wireless parameter configuration, make sure cable 
connection status. 
1.Check whether the network cable is connected to the machine. If not, 

connect the machine with a standard network cable.
2.Start a web browser such as Internet Explorer, Safari or Firefox and 

enter your machine’s new IP address in the browser window.
For example:

3.Click Go to access the SyncThru™ Web Service.
4.Click Login on the upper left of the website.

A Login page appears. 
5.Type in the ID and Password then click Login.

If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000 

6.When the SyncThru™ Web Service window opens, click Settings > 
Network Settings.

7.Click Wireless > Wizard.

 

Wizard will help you setup the wireless network configuration. 
However, if you want to set the wireless network directly, select 
Custom.

8.Select the one Network Name(SSID) in the list.
•SSID: SSID (Service Set Identifier) is a name that identifies a 

wireless network. Access points and wireless devices attempting 
to connect to a specific wireless network must use the same 
SSID. The SSID is case-sensitive.

•Operation Mode: Operation Mode refers to the type of wireless 
connections (See "Wireless network name and Network Key" on 
page 1).
-Ad-hoc: Allows wireless devices to communicate directly with 

each other in a peer-to-peer environment.
-Infrastructure: Allows wireless devices to communicate with 

each other through an access point.
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If your network’s Operation Mode is Infrastructure, select the 
SSID of the access point. If the Operation Mode is Ad-hoc, 
select the machine’s SSID. Note that “portthru” is the default 
SSID of your machine.

9.Click Next.
If wireless security setting window appears, enter the registered 
password (network key) and click Next.

10.The confirmation window appears, please check your wireless setup. 
If the setup is right, click Apply.

 

Disconnect the network cable (standard or network). Your 
machine should then start communicating wirelessly with the 
network. In case of Ad-hoc mode, you can use a wireless LAN 
and wired LAN simultaneously.

Resetting factory default values 
Should it become necessary to reset the Samsung printer to its factory 
default settings, please use the following steps. Connect the machine to 
your network, or you may connect the machine directly to a computer using 
the special network cable.

 

If you cannot connect the machine to a computer from its former 
network, it must be temporarily assigned to a new Ad-Hoc network to 
access the SyncThru™ web page. After you have established a direct 
link to the machine, use the special network cable and follow these 
instructions to reset the machine to the factory defaults.

Resetting the machine to factory default settings 
(Windows)
1. Connect the special network cable between the machine and the PC.
2. Open a browser such as Internet Explorer and enter the IP address of 

your machine. The machine’s SyncThru™ Web Service page will 
open.

3. Select Settings > Network Settings in the top menu bar.
4. Select Restore Default in the left side bar, and select the Clear button 

next to Factory Default (or Network). Click OK in each of the following 
three windows that pop up.

5. Disconnect the printer from the network, recycle the power, and print a 
Network Configuration Report to confirm the reset. This will reset all the 
parameters and the printer will no longer be on the network.

Resetting the machine to factory default settings 
(Macintosh)
1. Connect the special network cable between the printer and the 

Macintosh.
2. Open System Preferences and select Print & Fax settings. Select the 

printer you want to reset, opening the Print Queue, and select the 
Utility icon in the top menu bar. Safari will open the printer’s 
SyncThru™ Web Service page.

3. Click Settings > Network Settings in the top menu bar.
4. Click Restore Default in the left side bar, and click the Clear button next 

to Factory Default (or Network). Click OK in each of the following three 
windows that pop up.

5. Disconnect the printer from the network, recycle the power, and print a 
Network Configuration Report to confirm the reset. This will reset all the 
parameters and the printer will no longer be on the network.

Network parameter setting
You can also set up the various network settings through the network 
administration programs such as SyncThru™ Web Admin Service and 
SyncThru™ Web Service.

Completing the Installation
After you have installed your Samsung wireless network printer, print 
another copy of the Network Configuration Report and keep it for future 
reference. You are now ready to use your new Samsung wireless printer on 
your network. 

Troubleshooting

 

Solving problems that might occur during wireless setting and 
installing the machine driver

Wireless network problems
If problems occur while using the machine on a network, check the 
followings.

Printer Not Found
•Your computer or machine may not turn on. Turn on your computer or 

machine.
•USB cable is not connected between your computer and machine. 

Connect machine to your computer using a USB cable.
•The machine does not support wireless network. Check the User’s 

Guide included on the software CD supplied with your machine and 
prepare a wireless network machine.

Connecting Failure - Not Found SSID
•The machine is unable to search network name (SSID), which is you 

selected or entered name. Check the network name (SSID) on your 
access point and re-try to connect.

•Your access point is not turned on. Turn on your access point.

Connecting Failure - Invalid Security
•You configured security incorrectly. Check the configured security on 

your access point and machine.

Connection Failure - General Connection Error
•Your computer is not receiving a signal from your machine. Check the 

USB cable and your machine power.

Connection Failure - Connected Wired Network
•Your machine is connected with wired network cable. Remove the 

wired network cable from your machine.

PC Connecting Error
•The configured network address is unable to connect between your 

computer and machine.
-For DHCP network environment

The machine receives the IP address automatically (DHCP) 
when the computer is configured DHCP.

-For Static network environment
The machine uses the static address when the computer is 
configured with the static address.
If your computer is configured with the following addresses:
-IP address: 192.168.1.100
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-Subnet address: 255.255.255.0
-Gateway address: 192.168.1.1
Type in the following addresses for your machine:
-IP address: 192.168.1.101
-Subnet address: 255.255.255.0
-Gateway address: 192.168.1.1

Solving other problems
If problems occur while using the machine on a network, check the 
followings. 

 

For information on access point (or wireless router), refer to its own 
user's guide. 

• Your computer, access point or machine may not be turned on. Check if 
they are powered on.

• Check the wireless reception around the machine. If the reception is far 
from the machine or there is an obstacle, you might have difficulty 
receiving the signal. 

• Cycle the power for access point (or wireless router), machine and 
computer. Sometimes cycling the power can recover network 
communication.

• Check whether firewall software (V3 or Norton) is blocking the 
communication. 
If the computer and the machine is connected on a same network it 
cannot be searched, firewall software might be blocking the 
communication. Refer to the user's guide for the software to turn it off 
and try searching the machine again.

• Check whether the machine's IP address is allocated correctly. You can 
check the IP address by printing the network configuration report.

• Check whether access point (or wireless router) has a configured 
security (password). If it has a password, refer to the access point (or 
wireless router) administrator.

• Check whether the machine's IP address. Reinstall the machine driver 
and change the settings to connect to the machine on the network. Due 
to the characteristics of DHCP, the allocated IP address could change if 
the machine is not used for a long time or if the access point has been 
reset.

• Check the wireless environment. You might not be able to connect to the 
network in the infrastructure environment where you need to type in a 
user's information before connecting to access point (or wireless router).

• This machine only supports IEEE 802.11 b/g/n and Wi-Fi. Other wireless 
communication (Bluetooth) is not supported.

• When using the Ad-hoc mode, for operating systems such as Windows 
Vista, you might need to set the wireless connection setting every time 
you use the wireless machine. 

• You cannot use infrastructure mode and Ad-hoc mode at the same time 
for Samsung wireless network machine.

• The machine is within the range of the wireless network.
For most networks, the machine should be within 30 meters (100 feet) of 
the wireless access point (or wireless router).

• The machine is located away from obstacles that could block the 
wireless signal.
Remove any large metal objects between the access point (or wireless 
router) and the machine.
Make sure the machine and wireless access point (or wireless router) 
are not separated by poles, walls, or support columns containing metal 
or concrete.

• The machine is located away from other electronic devices that may 
interfere with the wireless signal.

Many devices can interfere with the wireless signal, including baby 
monitors, motors, cordless phones, security system cameras, other 
wireless networks, and some Bluetooth devices.
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1.basic setup
After installation is complete, you may want to set the machine’s default settings. Refer to the next section if you would like 
to set or change values. This chapter gives you step-by-step instructions for setting up the machine.
This chapter includes:
• Altitude adjustment
• Changing the display language
• Setting the date and time (CLX-3185FN/CLX-3185FW only)
• Changing the clock mode (CLX-3185FN/CLX-3185FW only)
• Changing the default mode (CLX-3185FN/CLX-3185FW only)
• Setting sounds

• Entering characters using the number keypad 
(CLX-3185FN/CLX-3185FW only)

• Using the save modes
• Setting the default paper
• Setting job timeout
• Setting the humidity mode

  

Altitude adjustment
The print quality is affected by atmospheric pressure, which is determined 
by the height of the machine above sea level. The following information will 
guide you on how to set your machine to the best print quality or best quality 
of print.
Before you set the altitude value, determine the altitude where you are.

1. Ensure that you have installed the printer driver with the provided Printer 
Software CD. 

2. Double-click the Smart Panel icon on the Windows task bar (or 
Notification Area in Linux). You can also click Smart Panel on the status 
bar in Mac OS X.

3. Click Printer Setting.

 

If your machine is connected to the network, you can set the 
altitude via SyncThru™ Web Service.

4. Click Setting > Altitude Adjustment. Select the appropriate value from 
the drop-down list, and then click Apply.

 

You can also set the altitude in System Setup > Machine Setup > 
Altitude Adj. option on the machine’s display.

Changing the display language
To change the language that appears on the display, follow the steps below.

1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Machine Setup appears and press OK.
4. Press the left/right arrow until Language appears and press OK.
5. Press the left/right arrow to display the language you want.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Setting the date and time 
(CLX-3185FN/CLX-3185FW only)
When you set the time and date, they are used in delay fax and delay print. 
They are printed on reports. If, however, they are not correct, you need to 
change it for the correct time being.

 

If the machine’s power is cut off, you need to reset the correct time 
and date once the power has been restored.

1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Machine Setup appears and press OK.
4. Press the left/right arrow until Date & Time appears and press OK.
5. Enter the correct time and date using left/right arrow or numeric keypad.

Month = 01 to 12
Day = 01 to 31
Year = requires four digits
Hour = 01 to 12
Minute = 00 to 59
You can also select AM or PM by using the number keypad.

6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Changing the clock mode 
(CLX-3185FN/CLX-3185FW only)
You can set your machine to print out the time on your fax using either a 
12-hour or 24-hour format.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.

1 High 3
2 High 2
3 High 1
4 Normal0

4,000 m
(13,123 ft) 

3,000 m
(9,842 ft) 

2,000 m
(6,561 ft) 

1,000 m
(3,280 ft) 

4

3

2

1
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3. Press the left/right arrow until Machine Setup appears and press OK.
4. Press the left/right arrow until Clock Mode appears and press OK.
5. Press the left/right arrow to select the 12-hour or 24-hour clock format 

and press OK.
6. Press Stop/Clear to return to ready mode.

Changing the default mode 
(CLX-3185FN/CLX-3185FW only)
Your machine is preset to Copy mode. You can switch this default mode 
between Fax mode and Copy mode.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Machine Setup appears and press OK.
4. Press the left/right arrow until Default Mode appears and press OK.
5. Press the left/right arrow to select the mode you want.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Setting sounds

 

The setting options may differ according to your model. Check your 
model name.

You can control the following options.
• Key sound: Turns the key sound On or Off. With this option set to On, a 

tone sounds each time a key is pressed.
• Alarm Sound: Turns the alarm sound On or Off. With this option set to 

On, an alarm tone sounds when an error occurs or fax communication 
ends.

• Speaker: Turns On or Off the sounds from the telephone line through 
the speaker, such as a dial tone or a fax tone. With this option set to 
Comm. which means “Common”, the speaker is on until the remote 
machine answers.

 

You can adjust the volume level using On Hook Dial. If your 
machine has a handset, you can adjust the volume level using the 
handset.

• Ringer: Adjusts the ringer volume. For the ringer volume, you can select 
Off, Low, Mid, and High.

Key sound and alarm sound (CLX-3185/CLX-3185N 
only)
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Sound/Volume appears and press OK.
4. Select Key Sound or Alarm Sound.
5. Select On or Off and press OK.
6. If necessary, repeat steps 4 through 5 to set other sounds.
7. Press Stop/Clear to return to ready mode.

Speaker, ringer, key sound, and alarm sound 
(CLX-3185FN/CLX-3185FW only)
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Sound/Volume appears and press OK.

4. Press the left/right arrow until the sound option you want appear and 
press OK.
•Key Sound: you can select On or Off.
•Alarm Sound: you can select On or Off.
•Speaker: you can select Comm., On or Off.
•Ringer: you can select High, Mid, Low or Off.

5. Press the left/right arrow until the desired status or volume for the sound 
you have selected appears and press OK.

6. If necessary, repeat steps 4 through 5 to set other sounds.
7. Press Stop/Clear to return to ready mode.

Speaker volume (CLX-3185FN/CLX-3185FW only)
To adjust the volume using On Hook Dial

1. Press (Fax) on the control panel.
2. Press On Hook Dial. A dial tone sounds from the speaker.
3. Press the left/right arrow until you hear the volume you want.
4. Press On Hook Dial to save the change and return to ready mode.

Entering characters using the number keypad 
(CLX-3185FN/CLX-3185FW only)
As you perform various tasks, you may need to enter names and numbers. 
For example, when you set up your machine, you enter your name or your 
company’s name, and the fax number.

Entering alphanumeric characters
1. When you are prompted to enter a letter, locate the button labeled with 

the character you want. Press the button until the correct letter appears 
on the display. 
For example, to enter the letter O, press 6, labeled with MNO.
Each time you press 6, the display shows a different letter, M, N, O, m, 
n, o and finally 6.
You can enter special characters such as space, plus sign, and etc. For 
details, see the below section.

2. To enter additional letters, repeat step 1.
If the next letter is printed on the same button, move the cursor by 
pressing the left/right arrow button and then press the button labeled 
with the letter you want. The cursor will move to the right and the next 
letter will appear on the display.
You can enter a space by pressing 1 twice.

3. When you have finished entering letters, press OK.

Keypad letters and numbers
Key Assigned numbers, letters, or characters

1 @ / . ‘ 1

2 A B C a b c 2

3 D E F d e f 3

4 G H I g h i 4

5 J K L j k l 5

6 M N O m n o 6

7 P Q R S p q r s 7
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Correcting numbers or names
If you make a mistake while entering a number or name, press the left/right 
arrow button to delete the last digit or character. Then enter the correct 
number or character.

Inserting a pause
With some telephone systems, you must dial an access code (9, for 
example) and listen for a second dial tone. In such cases, you must insert a 
pause in the telephone number. You can insert a pause while you are 
setting up speed dial numbers.
To insert a pause, press Redial/Pause at the appropriate place while 
entering the telephone number. A - appears on the display at the 
corresponding location.

Using the save modes
Using the power saving feature
When you will not be using the machine for a while, you can use this feature 
to save power.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Machine Setup appears and press OK.
4. Press the left/right arrow until Power Save appears and press OK.
5. Press the left/right arrow to select the time you want.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Setting the default paper

 

The setting options may differ according to your model. Check your 
model name.

You can select the paper you would like to keep using for printing job.

From your machine’s control panel
Setting the paper size
1.Press Menu on the control panel.
2.Press the left/right arrow until System Setup appears and press OK.
3.Press the left/right arrow until Paper Setup appears and press OK.
4.Press the left/right arrow until Paper Size appears and press OK.
5.Press the left/right arrow to select the paper size you want.
6.Press OK to save the selection.
7.Press Stop/Clear to return to ready mode.

Setting the paper type
1.Press Menu on the control panel.
2.Press the left/right arrow until System Setup appears and press OK.
3.Press the left/right arrow until Paper Setup appears and press OK.
4.Press the left/right arrow until Paper Type appears and press OK.
5.Press the left/right arrow to select the paper type you want.
6.Press OK to save the selection.
7.Press Stop/Clear to return to ready mode.

From your computer
Windows
1.Click the Windows Start menu. 
2.For Windows 2000, select Settings > Printers.

•For Windows XP/Server 2003, select Printers and Faxes. 
•For Windows Server 2008/Vista, select Control Panel > Hardware 

and Sound > Printers. 
•For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
•For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3.Right-click on your machine.
4.For Windows XP/Server 2003/Server 2008/Vista, press Printing 

Preferences.
For Windows 7 and Windows Server 2008 R2, select the Printing 
Preferences from context menu.

 

If Printing Preferences item has a ► mark, you can select 
other printer drivers connected with the selected printer.

5.Click Paper tab. 
6.Select options such as paper size and type.
7.Press OK.

 

If you want to use special-sized paper such as a billing paper, 
select Paper tab > Size > Edit... in the Printing Preferences (See 
"Opening printing preferences" on page 2).

Macintosh
Macintosh users need to change the default setting manually each time 
they want to print using other settings. 
1.Open a Macintosh application and select the file you want to print.
2.Open the File menu and click Print.
3.Go to Paper Feed pane.
4.Set appropriate tray from which you want to print.
5.Go to Paper pane.
6.Set paper type to correspond to the paper loaded in the tray from 

which you want to print.
7.Click Print to print. 

Linux
1.Open Terminal Program.
2.When the Terminal screen appears, type in the following. 

[root@localhost root]# lpr <FileName>
3.Select Printer and click Properties…
4.Click on the Advanced tab.
5.Select the tray (source) and its options, such as paper size and type.
6.Press OK.

8 T U V t u v 8

9 W X Y Z w x y z 9

0 & + - , 0

* *

# #

Key Assigned numbers, letters, or characters
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Setting job timeout
You can set the time the machine waits before it restores the default copy 
settings if you do not start copying after changing them on the control panel.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Machine Setup appears and press OK.
4. Press the left/right arrow until Timeout appears and press OK.
5. Press the left/right arrow until the time setting you want appears. 

Selecting Off means that the machine dose not restore the default 
settings until you press Black Start or Color Start to begin copying or 
Stop/Clear to cancel.

6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Setting the humidity mode
Print quality is affected by humidity levels. Paper may be damp if your 
location is a humid area: set the humidity mode. 
1. Ensure that you have installed the printer driver with the provided Printer 

Software CD. 
2. Double-click the Smart Panel icon on the Windows task bar (or 

Notification Area in Linux). You can also click Smart Panel on the status 
bar in Mac OS X.

3. Click Printer Setting.

 

If your machine is connected to the network, you can set the 
humidity mode via SyncThru™ Web Service.

4. Click Setting > Humidity. Select the appropriate value from the 
drop-down list, and then click Apply.

 

You can also set the humidity mode in System Setup > Machine 
Setup > Humidity option on the machine’s display.
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1.media and tray
This chapter provides information on how to load originals and print media into your machine.
This chapter includes:
• Loading originals
• Selecting print media
• Changing the tray size for print media
• Loading paper in the tray

• Printing on special media
• Setting the paper size and type
• Using the output support

  

 

Illustrations on this user’s guide may differ from your machine 
depending on its options or models. Check your model name.

Loading originals
You can use the scanner glass to load an original for copying or scanning.

On the scanner glass
Using the scanner glass, you can copy or scan originals. You can get the 
best scan quality, especially for colored or gray-scaled images.
1. Lift and open the scanner lid.

2. Place the original face down on the scanner glass. Align it with the 
registration guide at the top left corner of the glass.

3. Close the scanner lid.

 

•Leaving the scanner lid open while copying may affect copy 
quality and toner consumption.

•Dust on the scanner glass may cause black spots on the printout. 
Always keep it clean (See "Cleaning the scan unit" on page 3).

•If you are copying a page from a book or magazine, lift the 
scanner lid until its hinges are caught by the stopper and then 
close the lid. If the book or magazine is thicker than 30 mm, 
start copying with the scanner lid open.

 

•Be careful not to break the scanner glass. You may get hurt.
•Do not put hands while closing the scanner lid. The scanner lid 

may fall on your hands and get hurt.
•Do not look the light from inside of the scanner while copying or 

scanning. It is harmful to eyes.

In the document feeder (CLX-3185FN/CLX-3185FW 
only)
Using the document feeder, you can load up to 15 sheets of paper (75 g/m2, 
20 lb bond) for one job. 
1. Flex or fan the edge of the paper stack to separate the pages before 

loading originals.
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2. Load the original face up into the document feeder. Make sure that the 
bottom of the original stack matches the paper size marked on the 
document input tray.

3. Adjust the document feeder width guides to the paper size.

 

Dust on the document feeder glass may cause black lines on the 
printout. Always keep the glass clean (See "Cleaning the scan 
unit" on page 3).

Selecting print media
You can print on a variety of print media such as plain paper, envelopes, 
labels, and transparencies. Always use print media that meets the 
guidelines for use with your machine and from the appropriate tray.

Guidelines for selecting the print media
Print media that does not meet the guidelines outlined in this User’s Guide 
may cause the following problems.
• Poor print quality
• Increased paper jams
• Premature wear on the machine
• Permanent fuser damage, not covered under warranty.
Properties such as weight, composition, grain and moisture content are 
important factors that affect the machine’s performance and the output 
quality. When you choose print materials, consider the following factors.
• The type, size and weight of the print media for your machine are 

described in print media specifications (See "Print media specifications" 
on page 3).

• Desired outcome: The print media you choose should be appropriate for 
your project.

• Brightness: Some print media are whiter than others and produce 
sharper and more vibrant images.

• Surface smoothness: The smoothness of the print media affects how 
crisp the printing looks on the paper.

 

•Some print media may meet all of the guidelines in this section and 
still not produce satisfactory results. This may be the result of the 
sheets characteristics, improper handling, unacceptable 
temperature and humidity levels, or other variables over which 
cannot be controlled.

•Before purchasing large quantities of print media, ensure that it 
meets the requirements specified in this user’s guide. 

 

•Using print media that does not meet these specifications may cause 
problems or require repairs. Such repairs are not covered by 
Samsung’s warranty or service agreements.
The amount of paper put into the tray may differ according to 
media type used (See "Print media specifications" on page 3).

•Make sure not to use the inkjet photo paper with this machine. It 
could cause damage to the machine. 

•Using inflammable print media can cause a fire.
•Use designated print media (See "Print media specifications" on 

page 3).

 

The use of inflammable media or foreign materials left in the printer 
may lead to overheating of the unit and, in rare cases may cause a 
fire.

Media sizes supported in each mode

Changing the tray size for print media
To load longer sizes of paper such as Legal-sized paper, you need to adjust 
the paper guides to extend the paper tray. 
To change the tray size to other size, you must adjust the paper length 
guide properly.

Mode Size Source

Copy mode Letter, A4, Legal, 
Oficio, US Folio, 
Executive, JIS B5, A5, 
A6

Tray 1

Print mode All sizes supported by 
the machine.

Tray 1
Manual feeding in the 
tray

Fax mode All sizes supported by 
the machine.

Tray 1

1 Paper extend lever
2 Paper cover
3 Paper length guide
4 Paper width guide

3

2

1

4
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1. Pull the tray out of the machine. Open the paper cover and remove 
paper from the tray if necessary.

2. Pressing and unlatching the guide lock in the top of the tray, pull the tray 
out manually.

3. Place paper with the side you want to print facing up.

4. Slide the paper length guide until it lightly touches the end of the paper 
stack. Squeeze the paper width guide and slide it to the edge of the 
paper stack without causing it to bend.

For paper smaller than Letter-sized, return the paper guides to their 
original positions and adjust the paper length guide and paper width 

guide.

If the paper that you need to print is shorter than 222 mm (8.74 inches), 
press and unlatch the guide lock in the tray. Unextend the tray by 
pushing manually the extended portion back into the tray. Adjust the 
paper length guide and paper width guide.

 

•Do not push the paper width guide too far causing the media to 
warp. 

•Do not use a paper with more than 6 mm (0.24 inch.) curl.
•If you do not adjust the paper width guide, it may cause paper 

jams.

5. Close the paper cover.

Slide the tray back into the machine.
After loading paper, set the paper type and size for the tray (See "Setting 
the paper size and type" on page 6). 

 

•Due to insufficient paper in the tray, the paper length guide can be 
pushed to inside, load paper enough.

•If you experience problems with paper feed, load a paper into the 
tray one by one.

•You can load previously printed paper. The printed side should be 
facing up with an uncurled edge at the front. If you experience 
problems with paper feed, turn the paper around. Note that 
print quality is not guaranteed.

1

1

2
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The tray is preset to Letter or A4 size, depending on your country. To 
change the size to A4 or Letter, you must adjust the lever and paper width 
guide properly.
1. Pull the tray out of the machine. Open the paper cover and remove 

paper from the tray if necessary.
2. If you want to change the size to Letter, turn over the tray, and hold the 

lever at the back and rotate it clockwise.

3. Squeeze the paper width guide and slide it to the edge of the lever.

 

If you want to change the size to A4, first move the paper width 
guide to left and rotate the lever counterclockwise. If you force the 
lever, it could damage the tray.

Loading paper in the tray
In the tray
1. Pull out the paper tray. And adjust the tray size to the media size you are 

loading (See "Changing the tray size for print media" on page 2).
2. Flex or fan the edge of the paper stack to separate the pages before 

loading the paper.

3. Place paper with the side you want to print facing up.

4. Insert the tray back into the machine.
5. When you print a document, set the paper type and size in the tray.

For information about setting the paper type and size (See "Setting the 
paper size and type" on page 6).

Manual feeding in the tray
To load different sizes of paper such as envelope, transparency, labels or 
custom-sized paper, you need to adjust the paper guides for manual 
feeding in the tray. To use manual feeding in the tray, you must adjust the 
paper length/width guide properly.

Tips on using the manual feeding method
•If you select Manual Feeder for Source from your software application, 

you need to press the Color Start or Black Start button each time 
you print a page. Load only one type, size and weight of print media 
at a time in the tray.

•To prevent paper jams, do not add media while printing. This also 
applies to other types of print media.

•Print media should be loaded face up with the top edge going into the 
tray first and be placed in the center of the tray.

•Always load the use recommended print media only to avoid paper 
jams and print quality problems (See "Print media specifications" on 
page 3).

•Flatten any curl on postcards, envelopes and labels before loading 
them into the tray.

Printing on special media
The media types are shown in the Printing Preferences. This paper type 
option allows you to set the type of paper to be loaded in the tray. This 
setting appears in the list so that you can select it. This will let you get the 
best quality printout. If not, the desired print quality may not be achieved.
• Plain: Normal plain paper. Select this type if your printing on 70 to 90 

g/m2 (19 to 24 lbs).
• Thick: 90 to 105 g/m2 (24 to 28 lbs) thick paper.
• Thin: 60 to 70 g/m2 (16 to 19 lbs) thin paper.
• Cotton: 75 to 90 g/m2 (20 to 24 lbs) cotton paper.
• Color: 75 to 90 g/m2 (20 to 24 lbs) color-backgrounded paper.
• Preprinted: 75 to 90 g/m2 (20 to 24 lbs) preprinted/letterhead paper.
• Envelope: 75 to 90 g/m2 (20 to 24 lbs) envelope.
• Recycled: 75 to 90 g/m2 (20 to 24 lbs) recycled paper.

 

When you use recycled paper, printouts might be wrinkled and/or 
jamming may occur due to excessive curl.

• Transparency: 0.104 to 0.124 mm (0.004094 to 0.004882 inches) 
thickness of transparency paper. 

• Labels: 120 to 150 g/m2 (32 to 40 lbs) labels. 
• CardStock: 105 to 163 g/m2 (28 to 43 lbs) cardstock. 
• Bond: 105 to 120 g/m2 (28 to 32 lbs) bond. 

LTR
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• Archive: 70 to 90 g/m2 (19 to 24 lbs). If you need to keep the print-out 
for a long time, such as for archives, select this option.

• Glossy Photo: 111 to 220 g/m2 (30 to 58 lbs) glossy photo paper. See 
"Print media specifications" on page 3.

• Matte Photo: 111 to 220 g/m2 (30 to 58 lbs) matte photo paper. See 
"Print media specifications" on page 3.

Envelopes
Successful printing on envelopes depends upon the quality of the 
envelopes. 
To print an envelope, the stamp area is on the left side and the end of the 
envelope with the stamp area enters the printer first.

• When selecting envelopes, consider the following factors.
-Weight: The weight of the envelope paper should not exceed 90 g/m2 

otherwise, jams may occur.
-Construction: Prior to printing, envelopes should lie flat with less than 

6 mm (0.24 inches) curl, and should not contain air.
-Condition: Envelopes should not be wrinkled, nicked, nor damaged.
-Temperature: Use envelopes that are compatible with the heat and 

pressure of the machine during operation.
• Use only well-constructed envelopes with sharp-and well-creased folds.
• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, coated lining, 

self-adhesive seals, or other synthetic materials.
• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope extends all the way to 

the corner of the envelope.

1 Acceptable
2 Unacceptable

• Envelopes with a peel-off adhesive strip or with more than one flap that 
folds over to seal must use adhesives compatible with the machine’s 
fusing temperature about 170°C(338 °F) for 0.1 second. The extra flaps 
and strips might cause wrinkling, creasing or jams, and may even 
damage the fuser.

• For the best print quality, position margins no closer than 15 mm (0.59 
inches) from the edges of the envelope.

• Avoid printing over the area where the envelope’s seams meet.

Transparencies
To avoid damaging the machine, use only transparencies designed for laser 
printers.

 

In case of color printing using transparencies, the picture quality would 
be lower than mono printing when the printouts are used on the 

overhead projector.

• Transparencies used in the machine must be able to withstand 
machine’s fusing temperature.

• Place them on a flat surface after removing them from the machine.
• Do not leave unused transparencies in the paper tray for long periods of 

time. Dust and dirt may accumulate on them, resulting in spotty printing.
• To avoid smudging caused by fingerprints, handle transparencies 

carefully.
• To avoid fading, do not expose printed transparencies to prolonged 

sunlight.
• Ensure that transparencies are not wrinkled, curled, or have any torn 

edges.
• Do not use transparencies that separate from the backing sheet.
• To prevent transparencies from sticking to each other, do not let the 

printed sheets stack up as they are printed out.
• Recommended media: Xerox 3R91331 (A4), Xerox 3R2780 (Letter). 

Base type transparency (ex. Xerox 3R91331) results in better image 
and paper handling quality than paper backed (ex. Xerox 3R3028) or 
removable stripe (3R3108) ones.

 

•Transparency with static electricity can cause image quality 
problems. 

•Depending on the selection or storage conditions of the transparency, 
jam or image scratch might occur.

Labels
To avoid damaging the machine, use only labels designed for laser printers.

• When selecting labels, consider the following factors.
-Adhesives: The adhesive material should be stable at your machine’s 

fusing temperature (about 170°C(338 °F)).
-Arrangement: Only use labels with no exposed backing between 

them. Labels can peel off sheets that have spaces between the 
labels, causing serious jams.

-Curl: Prior to printing, labels must lie flat with no more than 13 mm 
(0.51 inches) of curl in any direction.

-Condition: Do not use labels with wrinkles, bubbles, or other 
indications of separation.

• Make sure that there is no exposed adhesive material between labels. 
Exposed areas can cause labels to peel off during printing, which can 
cause paper jams. Exposed adhesive can also cause damage to 
machine components.

• Do not run a sheet of labels through the machine more than once. The 
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adhesive backing is designed for only a single pass through the 
machine.

• Do not use labels that are separating from the backing sheet or are 
wrinkled, bubbled or otherwise damaged.

CardStock/Custom-sized paper
Postcards, cards and other custom-sized materials can be printed with your 
machine.

• Do not print on media smaller than 76 mm (3 inches) wide or 152.4 mm 
(6 inches) long.

• In software applications, set the margins at least 6.4 mm (0.25 inches) 
away from the edges of the material.

Letterhead/Preprinted paper
Letterhead/Preprinted materials can be printed with your machine.

• Letterhead/ Preprinted paper must be printed with heat-resistant ink that 
will not melt, vaporize or release hazardous emissions when subjected 
to the machine’s fusing temperature for 0.1 second. Check your 
machine’s specification to view the fusing temperature about 170°C (338 
°F).

• Letterhead/ Preprinted paper ink must be non-flammable and should not 
adversely affect machine rollers.

• Forms and letterhead should be sealed in a moisture-proof wrapping to 
prevent changes during storage.

• Before you load letterhead/preprinted paper, verify that the ink on the 
paper is dry. During the fusing process, wet ink can come off preprinted 
paper, reducing print quality.

Glossy photo

 

Load one paper to the tray at a time, facing glossy side up. 

• Make sure not to use the inkjet photo paper with this machine. It could 
cause damage to the machine.

Matte photo

 

Load one paper in the tray at a time, side to be printed facing up. 

Setting the paper size and type
After loading paper in the paper tray, set the paper size and type using the 
control panel. These settings will apply to copy and scan modes. For 
computer printing, select the paper size and type in the application program 
you use on your computer (See "Opening printing preferences" on page 2).

 

The settings made from the machine driver override the settings on 
the control panel.

Setting the paper size
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Paper Setup appears and press OK.
4. Press the left/right arrow until Paper Size appears and press OK.
5. Press the left/right arrow to select the paper size you want.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

 

If you want to use special-sized paper-such as a billing paper, select 
Edit... in the Paper tab in the Printing Preferences (See "Opening 
printing preferences" on page 2).

Setting the paper type
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Paper Setup appears and press OK.
4. Press the left/right arrow until Paper Type appears and press OK.
5. Press the left/right arrow to select the paper type you want.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Using the output support

 

The surface of the output tray may become hot if you print a large 
number of pages at once. Make sure that you do not touch the 
surface, and do not allow children near it.

 

Illustrations on this user’s guide may differ from your machine 
depending on its options or models. Check your model name.

AAAAA
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The printed pages stack on the output support and it will help the printed 
pages to align.
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1.printing
This chapter explains common printing tasks.
This chapter includes:
• Printer driver features
• Basic printing
• Opening printing preferences
• Using help
• Using special print features

• Changing the default print settings
• Setting your machine as a default machine
• Printing to a file (PRN)
• Macintosh printing
• Linux printing

  

 

The procedures in this chapter are mainly based on Windows XP.

Introducing useful software program
Samsung AnyWeb Print
This tool helps you to screen-capture, preview, scrap and print the screen of 
Windows Internet Explorer more easily, than when you use the ordinary 
program. Click Start > All programs > Samsung Printers > Samsung 
AnyWeb Print > Download the latest version to link the website where 
the tool is available for the download. This tool is available only for Windows 
operating systems.

Samsung Easy Color Manager
This program helps users to adjust color as they like. Users can adjust the 
printout color as they see them on the monitor. The adjusted color can be 
stored on the printer driver and applied to printouts. Click Start > All 
programs > Samsung Printers > Samsung Easy Color Manager > 
Download the latest version to link the website where the tool is available 
for the download. This tool is available only for Windows and Macintosh 
operating systems.

Printer driver features
Your printer drivers support the following standard features.
• Paper orientation, size, source and media type selection
• Number of copies
In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer 
drivers.

 

Some models or operating systems may not support some of the 
feature(s) in the following table.

Printer driver

(●: supported, Blank: not supported) 

Basic printing
Your machine allows you to print from various Windows, Macintosh or Linux 
applications. The exact steps for printing a document may vary depending 
on the application you use.

 

•Your Printing Preferences window that appears in this User’s Guide 
may differ depending on the machine in use. However, the 
composition of the Printing Preferences window is similar. Check 
the operating system(s) that are compatible with your machine. 
Refer to the OS compatibility section of Printer Specifications (See 
"System requirements" on page 2). 

•When you select an option in Printing Preferences, you may see a 
warning mark  or . An exclamation mark ( ) means you 
can select that certain option but it is not recommended, and ( ) 
mark means you cannot select that option due to the machine’s 
settings or environment.

The following procedure describes the general steps required for printing 
from various Windows applications. 

 

Macintosh basic printing (See "Macintosh printing" on page 6).
Linux basic printing (See "Linux printing" on page 7).

The following Printing Preferences window is for Notepad in Windows XP. 
Your Printing Preferences window may differ, depending on your 
operating system or the application you are using. 

Feature Windows

Machine quality option ●

Booklet printing ●

Poster printing ●

Multiple pages per sheet ●

Fit to page printing ●

Reduce and enlarge printing ●

Watermark ●

Overlay ●

Double-sided printing (manual) ●
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1. Open the document you want to print.
2. Select Print from the File menu. The Print window appears. 
3. Select your machine from the Select Printer list.

You can select the basic print settings including the number of copies 
and the print range from within the Print window. 

 

To take advantage of the printer features provided by your printer 
driver, click Properties or Preferences in the application’s Print 
window to change the print setting (See "Opening printing 
preferences" on page 2).

4. To start the print job, click OK or Print in the Print window.

 

If you are using Windows Internet Explorer, the Samsung AnyWeb 
Print will save your time for screen-captured images or printing the 
image. Click Start > All programs > Samsung Printers > Samsung 
AnyWeb Print > Download the latest version to link the website 
where the tool is available for the download.

Canceling a print job
If the print job is waiting in a print queue or print spooler, cancel the job as 
follows.
1. Click the Windows Start menu.
2. For Windows Server 2000, select Settings > Printers.

•For Windows XP/Server 2003, select Printer and Faxes. 
•For Windows Server 2008/Vista, select Control Panel > Hardware 

and Sound > Printers. 
•For Windows 7, select Control Panel > Devices and Printers. 
•For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3. For Windows Server 2000, XP, Server 2003, Vista or Server 2008, 

double-click your machine.
For Windows 7 or Windows Server 2008 R2, right-click your printer icon 
> context menus > See what’s printing.

 

If See what’s printing item has a ► mark, you can select other 
printer drivers connected with the selected printer.

4. From the Document menu, select Cancel.

 

You can also access this window by simply double-clicking the 
machine icon ( ) in the Windows task bar. 

You can also cancel the current job by pressing Stop/Clear on the 
control panel.

Opening printing preferences
You can preview the settings you selected on the upper right of the Printing 
Preferences.
1. Open the document you want to print.
2. Select Print from the file menu. The Print window appears. 
3. Select your machine from the Select Printer. 
4. Click Properties or Preferences. 

Using a favorite setting
The Presets option, which is visible on each preferences tab except for the 
Samsung tab, allows you to save the current preferences for future use.
To save a Presets item, follow the steps below.
1. Change the settings as needed on each tab. 
2. Enter a name for the item in the Presets input box.

3. Click Add. When you save Presets, all current driver settings are saved.
If you click Add, the Add button changes to the Update button. Select more 
options and click Update, settings will be added to the Presets you made.
To use a saved setting, select it from the Presets drop-down list. The 
machine is now set to print according to the setting you selected.
To delete saved settings, select it from the Presets drop-down list and click 
Delete. 
You can also restore the printer driver’s default settings by selecting Default 
Preset from the Presets drop-down list.
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Using help
Click the question mark on the upper-right corner of the window and click on 
the topic you want to know about. Then a pop up window appears with 
information about that option's feature, which is provided from the driver. 

If you want to search information via a keyword, click the Samsung tab in 
the Printing Preferences window and enter a keyword in the input line of 
the Help option. To get information about supplies, driver update, 
registration and so on, click appropriate buttons.

Using special print features
Special print features include the followings.
• "Printing multiple pages on one sheet of paper" on page 3.
• "Printing posters" on page 3.
• "Printing booklets (Manual)" on page 3.
• "Printing on both sides of the paper (Manual)" on page 3.
• "Change percentage of your document" on page 4.
• "Fitting your document to a selected paper size" on page 4.
• "Using watermarks" on page 4.
• "Using overlay" on page 5.
• "Advanced Options" on page 5.

Printing multiple pages on one sheet of paper
You can select the number of pages to print on a single sheet of paper. To 
print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one 
sheet. 
1. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on page 2).
2. Click the Basic tab, select Multiple Pages per Side in the Type 

drop-down list.
3. Select the number of pages you want to print per sheet (2, 4, 6, 9, or 16) 

in the Pages per Side drop-down list.
4. Select the page order from the Page Order drop-down list, if necessary. 
5. Check Print Page Border to print a border around each page on the 

sheet.
6. Click the Paper tab, select the Size, Source and Type.
7. Click OK or Print until you exit the Print window.

Printing posters
This feature allows you to print a single-page document onto 9 sheets of 
paper, for the purpose of pasting the sheets together to form one 
poster-size document.

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 2).

2. Click the Basic tab, select Poster Printing in the Type drop-down list.
3. Select the page layout you want.

Available layouts:
•Poster 2x2: Document will be enlarged and be divided into 4 pages.
•Poster 3x3: Document will be enlarged and be divided into 9 pages.
•Poster 4x4: Document will be enlarged and be divided into 16 pages.

4. Select the Poster Overlap value. Specify Poster Overlap in millimeters 
or inches by selecting the radio button on the upper right of Basic tab to 
make it easier to paste the sheets together.

5. Click the Paper tab, select the Size, Source and Type.
6. Click OK or Print until you exit the Print window.

7. You can complete the poster by pasting the sheets together.

Printing booklets (Manual)
This feature prints your document on both sides of a paper and arranges the 
pages so that the paper can be folded in half after printing to produce a 
booklet.

1. To change the print settings from your software application, access the 
Printing Preferences (See "Opening printing preferences" on page 2).

2. Click the Basic tab, select Booklet Printing from the Type drop-down 
list.

3. Click the Paper tab, select the Size, Source and Type.

 

The Booklet Printing option is not available for all paper sizes. In 
order to find out the available paper size for this feature, select the 
available paper size in the Size option on the Paper tab.
If you select an unavailable paper size, this option can be 
automatically canceled. Select only available paper (paper without 

 or  mark).
4. Click OK or Print until you exit the Print window.

5. After printing, fold and staple the pages.

Printing on both sides of the paper (Manual)
You can print on both sides of a paper (duplex). Before printing, decide how 
you want your document oriented. You can use this feature with Letter, 
Legal, A4, US Folio or Oficio sized paper (See "Print media specifications" 
on page 3).

 

We recommend not to print on both sides of special media such as 
labels, envelopes or thick paper. It may cause a paper jam or damage 
the machine. 

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 2).

2. Click the Advance tab.
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3. From the Double-Sided Printing (Manual) section, select the binding 
option you want.   
•None 
•Long Edge: This option is the conventional layout used in 

bookbinding.

•Short Edge: This option is the conventional layout used in calendars.

4. Click the Paper tab, select the Size, Source and Type.
5. Click OK or Print until you exit the Print window.

 

If your machine does not have a duplex unit, you should complete the 
printing job manually. The machine prints every other page of the 
document first. After that, a message appears on your computer. 
Follow the on-screen instructions to complete the printing job.

Change percentage of your document
You can change the size of a document to appear larger or smaller on the 
printed page by typing in a percentage you want.

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 2).

2. Click the Paper tab.
3. Enter the scaling rate in the Percentage input box.

You can also click the up/down arrows to select the scaling rate. 
4. Select the Size, Source and Type in Paper Options. 
5. Click OK or Print until you exit the Print window.

Fitting your document to a selected paper size
This feature allows you to scale your print job to any selected paper size 
regardless of the document size. This can be useful when you want to 
check fine details on a small document. 

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 2).

2. Click the Paper tab.

3. Select the paper size you want from the Fit to page.
4. Select the Size, Source and Type in Paper Options. 
5. Click OK or Print until you exit the Print window.

Using watermarks
The watermark option allows you to print text over an existing document. 
For example, you use it when you want to have large gray letters reading 
“DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all 
pages of a document. 

There are several predefined watermarks that come with the machine. They 
can be modified, or you can add new ones to the list. 

Using an existing watermark
1.To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 2).

2.Click the Advanced tab, and select the desired watermark from the 
Watermark drop-down list. You will see the selected watermark in 
the preview image. 

3.Click OK or Print until you exit the print window. 

Creating a watermark
1.To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 2).

2.From the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3.Enter a text message in the Watermark Message box. You can enter 
up to 256 characters. The message displays in the preview window.
When the First Page Only box is checked, the watermark prints on 
the first page only.

4.Select watermark options. 
You can select the font name, style, size and shade from the Font 
Attributes section as well as set the angle of the watermark from the 
Message Angle section. 

5.Click Add to add a new watermark to the Current Watermarks list.   
6.When you have finished, click OK or Print until you exit the Print 

window.
To stop printing the watermark, select None from the Watermark 
drop-down list. 

Editing a watermark
1.To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 2).

2.Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3.Select the watermark you want to edit from the Current Watermarks 
list and change the watermark message and options. 

4.Click Update to save the changes.
5.Click OK or Print until you exit the Print window. 
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Deleting a watermark
1.To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 2).

2.Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3.Select the watermark you want to delete from the Current 
Watermarks list and click Delete. 

4.Click OK or Print until you exit the Print window.

Using overlay
An overlay is content you store on your hard disk drive that can be 
superimposed over any document you print. An overlay is often used to take 
the place of letterhead paper. Rather than using preprinted letterhead, you 
can create an overlay containing exactly the same information that is 
currently on your letterhead. To print a letter with your company’s 
letterhead, you do not need to load preprinted letterhead paper in the 
machine, instead you can just print the letterhead overlay on your 
document.

Creating a new page overlay
To use a page overlay, you must create a new page overlay file 
containing your content.
1.Create or open a document containing the content you want to use in 

a new page overlay. Position the items exactly where you want them 
to appear when they are added to the original.

2.To save the document as an overlay, access Printing Preferences 
(See "Opening printing preferences" on page 2).

3.Click the Advanced tab, and select Edit from the Text drop-down list. 
The Edit Overlay window appears.

4.In the Edit Overlay window, click Create. 
5.In the Save As window, type a name of up to eight characters in the 

File name box. Select the destination path, if necessary (The default 
is C:\Formover).

6.Click Save. The name appears on the Overlay List. 
7.Click OK or Print until you exit the Print window.

8.The file is not printed. Instead, it is stored on your computer hard disk 
drive.

 

The overlay document size must match same as the document 
you print. Do not create an overlay with a watermark.

Using a page overlay
After an overlay has been created, it is ready to be printed with your 
document. To print an overlay with a document, do the following.
1.Create or open the document you want to print.
2.To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 2).

3.Click the Advanced tab. 
4.Select the desired overlay from the Text drop-down list. 

5.If the overlay file you want does not appear in theText drop-down list, 
select Edit from the list and click Load. Select the overlay file you 
want to use. 
If you have stored the overlay file you want to use in an external 
source, you can also load the file when you access the Open 
window. 
After you select the file, click Open. The file appears in the Overlay 
List box and is available for printing. Select the overlay from the 
Overlay List box. 

6.If necessary, check Confirm Page Overlay When Printing box. If this 
box is checked, a message window appears each time you submit a 
document for printing, asking you to confirm you wish to print an 
overlay over your document. 
If this box is not checked and an overlay has been selected, the 
overlay automatically prints with your document. 

7.Click OK or Print until you exit the Print window. 
The selected overlay prints over your document. 

 

The resolution of the overlay document must match the resolution 
of the original print job.

Deleting an overlay
You can delete page overlays that you no longer use. 
1.In the Printing Preferences window, click the Advanced tab. 
2.Select Edit in the Overlay drop-down list. 
3.Select the overlay you want to delete from the Overlay List box. 
4.Click Delete. 
5.When the confirmation message window appears, click Yes.
6.Click OK or Print until you exit the Print window.

Advanced Options
Use the following Graphics options to adjust the print quality for your 
specific printing needs.

 

If the option is grayed out or not shown, that option is not applicable 
with the printer language you are using.

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 2).

2. Click the Graphics tab.

 

•The options you can select may vary depending on your machine.

•Refer to the help for each option’s information provided from the 
Printing Preferences.

•Font/Text: Select Darken Text to print text darker than on a normal 
document. Use All Text Black to prints solid black, regardless of the 
color it appears on the screen.

•Graphic Controller: Fine Edge allows you to emphasize edges of 
texts and fine lines for improving readability. Grayscale 
Enhancement allows users to preserve the details of nature photos, 
and improve contrast and readability among gray-scaled colors 
when printing color documents in grayscale.

•Toner Save: Adjusting this option extends the life of your toner 
cartridges and reduces your cost per page without a significant 
reduction in print quality.
-You can move the slider from No Saving to Maximum Saving to 

reduce toner consumption.
3. Click OK or Print until you exit the Print window.
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Changing the default print settings
1. Click the Windows Start menu. 
2. For Windows Server 2000, select Settings > Printers.

•For Windows XP/Server 2003, select Printer and Faxes. 
•For Windows Server 2008/Vista, select Control Panel > Hardware 

and Sound > Printers. 
•For Windows 7, select Control Panel > Devices and Printers. 
•For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3. Right-click your machine.
4. For Windows XP/Server 2003/Server 2008/Vista, press Printing 

Preferences.
For Windows 7 or Windows Server 2008 R2, from context menus, select 
the Printing preferences.

 

If Printing preferences item has a ► mark, you can select other 
printer drivers connected with the selected printer.

5. Change the settings on each tab. 
6. Click OK.

 

If you want to change the settings for each print job, change it in 
Printing Preferences. 

Setting your machine as a default machine
1. Click the Windows Start menu.
2. For Windows Server 2000, select Settings > Printers.

•For Windows XP/Server 2003, select Printer and Faxes. 
•For Windows Server 2008/Vista, select Control Panel > Hardware 

and Sound > Printers. 
•For Windows 7, select Control Panel > Devices and Printers. 
•For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3. Select your machine.
4. Right-click your machine and select Set as Default Printer.

 

For Windows 7 or Windows Server 2008 R2, if Set as default 
printer item has a ► mark, you can select other printer drivers 
connected with the selected printer.

Printing to a file (PRN)
You will sometimes need to save the print data as a file. You can print the 
document to a file instead of routing it directly to a printer. The document is 
saved with the printer formatting, such as font selection and color 
specifications, in a .prn file that can be printed on another printer.
To save a print job as a file:

1. Check the Print to file box at the Print window.

2. Click Print.
3. Type in the destination path and the file name, and then click OK. For 

example c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in 
My Documents. The saved folder may differ depending on your 
operating system.

Macintosh printing
This section explains how to print a document in a Macintosh operating 
system. 

Printing a document
When you print with a Macintosh, you need to check the printer driver 
setting in each application you use. Follow the steps below to print from a 
Macintosh.
1. Open the document you want to print.
2. Open the File menu and click Page Setup.
3. Choose your paper size, orientation, scaling or other options, and make 

sure that your machine is selected.

4. Choose the number of copies you want and indicate which pages you 
want to print. 

5. Click Print.

Changing printer settings
You can use advanced printing features provided by your machine.
Open an application and select Print from the File menu. The machine 
name, which appears in the printer properties pane may differ depending on 
the machine in use. Except for the name, the composition of the printer 
properties pane is similar to the following.
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•The setting options may differ depending on models or Macintosh OS 
versions.

•The following pane may differ depending on your operating system or 
the application you are using.

The following pane is the first pane you will see when you open the printer 
properties pane. Select other advanced features from the drop-down list. 

Layout
The Layout dialog provides options to adjust how the document 
appears on the printed page. You can print multiple pages on one sheet 
of paper. Select Layout from the drop-down list to access the following 
features.
•Pages per Sheet: This option determines how many pages to be 

printed on one page (See "Printing multiple pages on one sheet of 
paper" on page 7).

•Layout Direction: This option allows you to select the printing 
direction on a page similar to the examples on the screen.

•Border: This option allows you to print a border around each page on 
the sheet.

•Reverse Page Orientation: This option allows you to rotate paper 180 
degrees. 

Graphics
The Graphics dialog provides options for selecting Quality and Color 
mode. Select Graphics from the drop-down list to access the graphic 
features.
•Quality: This option allows you to select the printing resolution. The 

higher setting option you choose, the better sharpness and clarity of 
printed characters or images are. A higher setting will also increase 
the time it takes to print a document.

•Color mode: You can set the color options. Setting to Color typically 
produces the best possible print quality for color documents. If you 
want to print a color document in grayscale, select Grayscale.

Paper
Set Paper Type to correspond to the paper loaded in the tray from 
which you want to print. This will let you get the best quality printout. If 
you load a different type of print material, select the corresponding paper 
type.

Printer Features
The Printer Features dialog provides Advanced Options and Color 
Adjust options. Select Printer Features from the drop-down list to 
access the following features.
•Fine Edge: It allows users to emphasize edges of texts and fine lines 

for improving readability and align color channel registration in color 
printing mode.

•RGB Color: You can adjust the appearance of images by changing the 

settings in the RGB Color option.
•Screen: This option allows you to select options to convert 

continuous-tone image into printable binary image.
•Color Adjust: You can adjust the image by changing the settings in 

the Color Adjust option.

Printing multiple pages on one sheet of paper
You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft pages.
1. Open an application, and select Print from the File menu.
2. Select Layout from the drop-down list. In the Pages per Sheet 

drop-down list, select the number of pages you want to print on one 
sheet of paper.

3. Select the other options you want to use.
4. Click Print, then the machine prints the selected number of pages you 

want to print on one sheet of paper.

Linux printing
Printing from applications
There are several Linux applications that allow you to print using the 
Common UNIX Printing System (CUPS). You can print using any of these 
applications.
1. Open an application, and select Print from the File menu.
2. Select Print directly using LPR.
3. From the LPR GUI window, select the model name of your machine from 

the printer list and click Properties.
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4. Change the print job properties using the following four tabs displayed at 
the top of the window.
•General: This option allows you to change the paper size, the paper 

type, and the orientation of the documents. It enables the duplex 
feature, adds start and end banners, and changes the number of 
pages per sheet.

•Text: This option allows you to specify the page margins and set the 
text options, such as spacing or columns.

•Graphics: This option allows you to set image options that are used 
when printing image files, such as color options, image size, or 
image position.

•Advanced: This option allows you to set the print resolution, paper, 
source and special print features.

 

If an option is grayed out, it means that the grayed out option is not 
supported by your machine.

5. Click Apply to apply the changes and close the Properties window.
6. Click OK in the LPR GUI window to start printing.
7. The Printing window appears, allowing you to monitor the status of your 

print job.
To abort the current job, click Cancel.

Printing files
You can print many different types of files on your machine using the 
standard CUPS way, directly from the command line interface. The CUPS 
LPR utility allows you to do that. But the drivers package replaces the 
standard LPR tool by a much more user-friendly LPR GUI program.
To print any document file
1. Type lpr <file_name> from the Linux shell command line and press 

Enter. The LPR GUI window appears.
When you type only lpr and press Enter, the Select file(s) to print 
window appears first. Just select any files you want to print and click 
Open.

2. From the LPR GUI window, select your machine from the list, and 
change the print job properties.

3. Click OK to start printing.

Configuring Printer Properties
Using the Printer Properties window provided by the Printers 
configuration, you can change the various properties for your machine.
1. Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.
2. Select your machine from the available printers list and click Properties.
3. The Printer Properties window opens.

The following five tabs display at the top of the window.

•General: This option allows you to change the printer location and 
name. The name entered in this tab displays on the printer list in 
Printers configuration.

•Connection: This option allows you to view or select another port. If 
you change the machine port from USB to parallel or vice versa 
while in use, you must re-configure the machine port in this tab.

•Driver: This option allows you to view or select another machine 
driver. By clicking Options, you can set the default device options.

•Jobs: This option shows the list of print jobs. Click Cancel job to 
cancel the selected job and select the Show completed jobs check 
box to see previous jobs on the job list.

•Classes: This option shows the class that your machine is in. Click 
Add to Class to add your machine to a specific class or click 
Remove from Class to remove the machine from the selected 
class.

4. Click OK to apply the changes and close the Printer Properties 
window.
Printing_ 8



1.copying
This chapter gives you step-by-step instructions for copying documents.
This chapter includes:
• Basic copying
• Changing the settings for each copy
• Changing the default copy settings

• ID card copying
• Using special copy features
• Deciding the form of copy output

  

 

•The supported setting options may differ according to your model. 
Check your model name.

•It could be printed different color with fluorescent color due to the 
property of scanner.

Basic copying
The following is the normal copy procedure for a machine without an 
Automatic Document Feeder(ADF) such as CLX-3185 and CLX-3185N.
1. Place a single original face down on the scanner glass. For details about 

loading an original, see "Loading originals" on page 1.
2. Enter the number of copies using the left/right arrow if necessary.
3. If you want to customize the copy settings including Reduce/Enlarge, 

Darkness, Original Type and more by using the control panel buttons 
(See "Changing the settings for each copy" on page 1). 

4. Press Color Start to begin color copying.
Or press Black Start to begin black and white copying.

The following is the normal copy procedure for a machine with an ADF such 
as CLX-3185FN and CLX-3185FW.

1. Press (Copy) on the control panel.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "On the scanner glass" on page 1 or "In the document feeder 
(CLX-3185FN/CLX-3185FW only)" on page 1).

3. If you want to customize the copy settings including Reduce/Enlarge, 
Darkness, Original Type and more by using the control panel buttons 
(See "Changing the settings for each copy" on page 1). 

4. Enter the number of copies using the arrow or number keypad, if 
necessary.

5. Press Color Start to begin color copying.
Or press Black Start to begin black and white copying.

 

If you need to cancel the copying job during the operation, press 
Stop/Clear and the copying will stop.

Changing the settings for each copy
Your machine provides default settings for copying so that you can quickly 
and easily make a copy. However, if you want to change the options for 
each copy, use the copy function buttons on the control panel.

 

If you press Stop/Clear while setting the copy options, all of the 
options you have set for the current copy job will be canceled and 
returned to their default status. Or, they will automatically return to 
their default status after the machine completes the copy in progress.

Darkness
If you have an original containing faint marking and dark images, you can 
adjust the brightness to make a copy that is easier to read.
1. Depending on the model, the operating procedure may differ.

•For CLX-3185 and CLX-3185N, press Menu on the control panel.
•For CLX-3185FN and CLX-3185FW, press (Copy) and Menu in 

order on the control panel.
2. Press the left/right arrow until Copy Feature appears and press OK.
3. Press the left/right arrow until Darkness appears and press OK.
4. Press the left/right arrow until the contrast mode you want appears and 

press OK.
•Lightest: Works well with lightest print.
•Light: Works well with light print.
•Normal: Works well with standard typed or printed originals.
•Dark: Works well with dark print.
•Darkest: Works well with darkest print.

5. Press Stop/Clear to return to ready mode.

Original Type
The original type setting is used to improve the copy quality by selecting the 
document type for the current copy job.
1. Depending on the model, the operating procedure may differ.

•For CLX-3185 and CLX-3185N, press Menu on the control panel.
•For CLX-3185FN and CLX-3185FW, press (Copy) and Menu in 

order on the control panel.
2. Press the left/right arrow until Copy Feature appears and press OK.
3. Press the left/right arrow until Original Type appears and press OK.
4. Press the left/right arrow until the image mode you want appears and 

press OK.
•Text/Photo: Use for originals with mixed text and photographs.
•Photo: Use when the originals are photographs.
•Magazine: Use when the originals are the form of magazine.
•Text: Use for originals containing mostly text.

5. Press Stop/Clear to return to ready mode.

Reduced or enlarged copy
You can reduce or enlarge the size of a copied image from 25% to 400% 
when you copy original documents from the scanner glass.

To select from the predefined copy sizes
1.Depending on the model, the operating procedure may differ.

•For CLX-3185 and CLX-3185N, press Menu on the control panel.
•For CLX-3185FN and CLX-3185FW, press (Copy) and Menu in 
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order on the control panel.
2.Press the left/right arrow until Copy Feature appears and press OK.
3.Press the left/right arrow until Reduce/Enlarge appears and press 

OK.
4.Press the left/right arrow until the size setting you want appears and 

press OK.
5.Press Stop/Clear to return to ready mode.

To scale the copy by directly entering the scale rate
1.Depending on the model, the operating procedure may differ.

•For CLX-3185 and CLX-3185N, press Menu on the control panel.
•For CLX-3185FN and CLX-3185FW, press (Copy) and Menu in 

order on the control panel.
2.Press the left/right arrow until Copy Feature appears and press OK.
3.Press the left/right arrow until Reduce/Enlarge appears and press 

OK.
4.Press the left/right arrow until Custom appears and press OK.
5.Press the left/right arrow to enter the copy size you want. Pressing and 

holding the button allows you to quickly scroll to the number you 
want. For CLX-3185FN and CLX-3185FW, you can also use the 
number keypad.

6.Press OK to save the selection.
7.Press Stop/Clear to return to ready mode.

 

When you make a reduced copy, black lines may appear at the 
bottom of your copy.

Changing the default copy settings
The copy options including darkness, original type, copy size and number of 
copies can be set to those most frequently used. When you copy a 
document, the default settings are used unless they have been changed by 
using the corresponding buttons on the control panel.
1. Depending on the model, the operating procedure may differ.

•For CLX-3185 and CLX-3185N, press Menu on the control panel.
•For CLX-3185FN and CLX-3185FW, press (Copy) and Menu in 

order on the control panel.
2. Press the left/right arrow until Copy Setup appears and press OK.
3. Press the left/right arrow until Change Default appears and press OK.
4. Press the left/right arrow until the setup option you want appears and 

press OK.
5. Press the left/right arrow until the setting you want appears and press 

OK.
6. Repeat steps 4 through 5 as needed.
7. Press Stop/Clear to return to ready mode.

 

While you are setting copy options, pressing Stop/Clear cancels the 
changed settings and restores the defaults.

ID card copying
Your machine can print 2-sided originals on one sheet.

The machine prints one side of the original on the upper half of the paper 
and the other side on the lower half without reducing the size of the original. 
This feature is helpful for copying a small-sized item such as business card.

 

The original must be placed on the scanner glass to use this feature.

1. Press ID Copy on the control panel. 
2. Place the front side of an original facing down on the scanner glass 

where arrows indicate as shown. Then, close the scanner lid.

3. Place Front Side and Press [Start] appears on the display.
4. Press Color Start or Black Start.

Your machine begins scanning the front side and shows Place Back 
Side and Press [Start].

5. Turn the original over and place it on the scanner glass where arrows 
indicate as shown. Then, close the scanner lid.

6. Press Color Start to begin color copying.
Or, press Black Start to begin black and white copying.

 

•If you do not press the Color Start or Black Start button, only the 
front side will be copied.

•If the original is larger than the printable area, some portions may not 
be printed.

•If you press Stop/Clear or if no buttons are pressed for approximately 
30 seconds, the machine cancels the copy job and returns to 
ready mode. 

Using special copy features
You can use the following copy features.

2-up or 4-up copying (N-up)
Your machine can print 2 or 4 original images reduced to fit onto one sheet 
of paper.

1. Depending on the model, the operating procedure may differ.
•For CLX-3185 and CLX-3185N, press Menu on the control panel.
•For CLX-3185FN and CLX-3185FW, press (Copy) and Menu in 

order on the control panel.

1
2

1 2

3 4
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2. Press the left/right arrow until Copy Feature appears and press OK. 
3. Press the left/right arrow until Layout appears and press OK.
4. Press the left/right arrow until 2-Up or 4-Up appears and press OK to 

save the selection.
5. Press Stop/Clear to return to ready mode.

 

You cannot adjust the copy size using Reduce/Enlarge menu for 
making a 2- or 4-up copy.

Poster copying
Your machine can print an image onto 9 sheets of paper (3x3). You can 
paste the printed pages together to make one poster-sized document.
This copy feature is available only when you place originals on the scanner 
glass. 

1. Depending on the model, the operating procedure may differ.
•For CLX-3185 and CLX-3185N, press Menu on the control panel.
•For CLX-3185FN and CLX-3185FW, press (Copy) and Menu in 

order on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Copy Feature appears and press OK.
4. Press the left/right arrow until Layout appears and press OK.
5. Press the left/right arrow until Poster Copy appears, and press OK to 

save the selection.
6. Press Stop/Clear to return to ready mode.

 

Your original is divided into 9 portions. Each portion is scanned and 
printed one by one in the following order.

Clone copying
Your machine can print multiple images copies from the original document a 
single page. The number of images is automatically determined by the 
original image and paper size.
This copy feature is available only when you place originals on the scanner 
glass.

1. Depending on the model, the operating procedure may differ.
•For CLX-3185 and CLX-3185N, press Menu on the control panel.
•For CLX-3185FN and CLX-3185FW, press (Copy) and Menu in 

order on the control panel.
2. Press the left/right arrow until Copy Feature appears and press OK.

3. Press the left/right arrow until Layout appears and press OK.
4. Press the left/right arrow until Clone Copy appears and press OK to 

save the selection.
5. Press Stop/Clear to return to ready mode.

 

You cannot adjust the copy size using Reduce/Enlarge menu while 
making a clone copy. 

Erasing background images
You can set the machine to print an image without its background. This 
copy feature removes the background color and can be helpful when 
copying an original containing color in the background such as a newspaper 
or a catalog.
1. Depending on the model, the operating procedure may differ.

•For CLX-3185 and CLX-3185N, press Menu on the control panel.
•For CLX-3185FN and CLX-3185FW, press (Copy) and Menu in 

order on the control panel.
2. Press the left/right arrow until Copy Feature appears and press OK.
3. Press the left/right arrow until Adjust Bkgd. appears and press OK.
4. Press the left/right arrow until the background option you want appears.

•Off: Does not use this feature.
•Auto: Optimizes the background.
•Enhance Lev. 1 - 2: The higher the number is, the more vivid the 

background is.
•Erase Lev. 1 - 4: The higher the number is, the lighter the background 

is.
5. Press OK to save the selection.
6. Press Stop/Clear to return to ready mode.

Gray enhance copying
When you copy the original in black and white, use this feature for the better 
quality of copy-out-put. This feature is only for the copy in black and white.
1. Depending on the model, the operating procedure may differ.

•For CLX-3185 and CLX-3185N, press Menu on the control panel.
•For CLX-3185FN and CLX-3185FW, press (Copy) and Menu in 

order on the control panel.
2. Press the left/right arrow until Copy Feature appears and press OK.
3. Press the left/right arrow until Gray Enhance appears and press OK.
4. Press the left/right arrow to select On or Off.
5. Press OK to save the selection.
6. Press Stop/Clear to return to ready mode.

Deciding the form of copy output 
You can set the machine to sort the copy job. For example, if you make 2 
copies of a 3 page original, one complete 3 page document will print 
followed by a second complete document.
1. Depending on the model, the operating procedure may differ.

•For CLX-3185 and CLX-3185N, place a single original document facing 
down on the scanner glass and press Menu on the control panel.

•For CLX-3185FN and CLX-3185FW, place original documents facing 
up in the document feeder, or you can use the scanner glass with a 
single document facing down and close the scanner lid. Press 

(Copy) and Menu in order on the control panel.
2. Press the left/right arrow until Copy Setup appears and press OK.
3. Press the left/right arrow until Change Default appears and press OK.
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4. Press the left/right arrow until Copy Collation appears and press OK.
5. Press the left/right arrow until On appears and press OK to save the 

selection.
•On: Prints output in sets to match the sequence of originals.

•Off: Prints output sorted into stacks of individual pages.

6. Press Stop/Clear to return to ready mode.
7. Enter the number of copies using the left/right arrow or numeric keypad.
8. Press Start to begin copying.

One complete document will print followed by the second complete 
document.
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1.scanning
Scanning with your machine lets you turn pictures and text into digital files that can be stored on your computer.
This chapter includes:
• Basic scanning method
• Scanning originals and sending to your computer (Scan to PC)
• Scanning by a network connection (Scan to Email) 

(CLX-3185FN/CLX-3185FW only)
• Changing the settings for each scan job
• Changing the default scan settings

• Setting up Address Book (CLX-3185FN/CLX-3185FW only)
• Using Samsung Scan and Fax Manager
• Scanning with TWAIN-enabled software
• Scanning using the WIA driver
• Macintosh scanning
• Linux Scanning

  

 

•The maximum resolution that can be achieved depends upon various 
factors, including a computer speed, available disk space, 
memory, the size of the image being scanned and color bit depth 
settings. Thus, depending on your system and what you are 
scanning, you may not be able to scan at a certain resolution, 
especially using enhanced resolution.

•It could be scanned different color with fluorescent color due to the 
property of scanner.

 

Supported optional devices and features may differ according to your 
model. Check your model name. 
(See "Features by Models" on page 2).

Basic scanning method
You can scan the originals with your machine via an USB cable or the 
network.
• Samsung Scan and Fax Manager: Scan the originals from the control 

panel. Then, the scanned data will be stored in the connected 
computers My Documents folder. When you install all the software in 
the supplied CD, the Samsung Scan and Fax Manager is also 
automatically installed on your computer. This feature can be used via 
the local connection or the network connection (See "Using Samsung 
Scan and Fax Manager" on page 4).

• TWAIN: TWAIN is the one of a preset imaging applications. Scanning 
an image launches the selected application, enabling you to control the 
scanning process. This feature can be used via the local connection or 
the network connection (See "Scanning with TWAIN-enabled software" 
on page 6).

• SmarThru: This program is the accompanying software for your 
machine. You can use this program to scan images or documents. This 
feature can be used via the local connection or the network connection 
(See "SmarThru" on page 3).

• WIA: WIA stands for Windows Images Acquisition. To use this feature, 
your computer must be connected directly with the machine via an USB 
cable (See "Scanning using the WIA driver" on page 6).

Scanning originals and sending to your 
computer (Scan to PC)
You can scan an image on the machine via the Samsung Scan and Fax 
Manager program that is installed in your USB- or network-connected 
computer.

For USB connected machine
This is a basic scanning method for USB-connected machine.
1. Make sure that the machine is connected to your computer and powered 

on.
2. Place a single document face down on the document glass, or load the 

documents face up into the ADF.
For details about loading an original, see "Loading originals" on page 1.

3. Depending on the model, the operating procedure may differ.
•For CLX-3185, CLX-3185N and CLX-3185WK, press Scan to on the 

control panel.

•For CLX-3185FN and CLX-3185FW, press (Scan) on the control 
panel.

4. Press the left/right arrow until Scan to PC appears and press OK.
5. Press the left/right arrow until Local PC appears and press OK.

 

If you see Not Available message, check the port connection.

6. Press the left/right arrow until the application program you want appears 
and press OK.
Default setting is My Documents.

 

To add or delete the folder where the scanned file is saved, add or 
delete the application program in Samsung Scan and Fax 
Manager > Properties > Set Scan Button.

7. Press the left/right arrow until the setting you want appears and press 
OK.
•Resolution: Sets the image resolution.
•Scan Color: Sets the color mode.
•Scan Format: Sets the file format in which the image is to be saved.
•Scan Size: Sets the image size.

 

•Scan Format appears only when you selected the Scan 
destination to My Documents.

•If you want to scan from the default setting, press Start.

8. Scanning begins.

 

•Scanned image is saved in computer’s My Documents > My 
Pictures > Samsung folder.

•You can use Twain driver to scan quickly in Samsung Scan and 
Fax Manager program.

•You can also scan by pressing Window’s Start > Control Panel > 
Samsung Scan and Fax Manager > Quick Scan.
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For network connected machine 
(CLX-3185N/CLX-3185FN/CLX-3185FW/CLX-3185WK 
only)
Make sure the printer driver is installed on your computer using the software 
CD, since the printer driver includes the scan program (See "Installing wired 
network-connected machine’s driver" on page 3).
1. Make sure that your machine and the computer are connected to a 

network and Samsung Scan and Fax Manager is installed on the 
computer.

2. Place a single document face down on the document glass, or load the 
documents face up into the ADF.
For details about loading an original, see "Loading originals" on page 1.

3. Depending on the model, the operating procedure may differ.
•For CLX-3185N and CLX-3185WK, press Scan to on the control panel.

•For CLX-3185FN and CLX-3185FW, press (Scan) on the control 
panel.

4. Press the left/right arrow until Scan to PC appears and press OK.
5. Press the left/right arrow until Network PC appears and press OK.

 

If you see Not Available message, check the port connection.

6. Select your registered computer ID, and enter the Password if 
necessary.

 

•ID is the same ID as the registered Computer ID for Samsung 
Scan and Fax Manager.

•Password is the 4 digit number registered Password for 
Samsung Scan and Fax Manager.

7. Press the left/right arrow until the application program you want appears 
and press OK.
Default setting is My Documents.

 

To add or delete the folder where the scanned file is saved, add or 
delete the application program in Samsung Scan and Fax 
Manager > Properties > Set Scan Button.

8. Press the left/right arrow until the setting you want appears and press 
OK.
•Resolution: Sets the image resolution.
•Scan Color: Sets the color mode.
•Scan Format: Sets the file format in which the image is to be saved.
•Scan Size: Sets the image size.

 

•Scan Format appears only when you selected the Scan 
destination to My Documents.

•If you want to scan from the default setting, press Start.

9. Scanning begins.

 

•Scanned image is saved in computer’s My Documents > My 
Pictures > Samsung folder.

•You can use Twain driver to scan quickly in Samsung Scan and 
Fax Manager program.

•You can also scan by pressing Window’s Start > Control Panel > 
Samsung Scan and Fax Manager > Quick Scan.

Scanning by a network connection (Scan to 
Email) (CLX-3185FN/CLX-3185FW only)
If you have connected your machine to a network and set up network 
parameters correctly, you can scan and send images over the network.

Setting up an e-mail account
To scan and send an image as an email attachment. You need to set up 
network parameters using SyncThru™ Web Service.
1. Enter your machine’s IP address as the URL in a browser and click Go 

to access the SyncThru™ Web Service website.
2. Click Login on the upper right of the website.

The Login window appears.
3. Type in the ID and Password, and then click Login.

If it is your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000 

4. Move the mouse cursor on the Settings of the top menu bar and then 
click Network Settings.

5. Click Outgoing Mail Server(SMTP) on the left pane of the website.
6. Enter the SMTP server domain name or the IP address(dotted decimal 

notation) you want to use on the SMTP Server text box.

 

Only alphabet letters, number(0~9), period(,) and hyphen(-) are 
permitted in these text boxes.

7. Enter the server port number from 1 to 65535 on Port Number text box.
The default port number is 25.

8. Select SMTP Requires Authentication check box in the SMTP Login 
Information section.

9. Enter the login ID on the Login ID text box and the password on the 
Password text box.

10. Enter the password one more time on the Confirm Password to confirm 
your choice.

11. Click Apply.

 

If the authentication method of SMTP server is POP3 before SMTP, 
select the SMTP requires POP3 Before SMTP Authentication 
check box.
a)Enter the POP3 server domain name on the POP3 Server input 

field and the port number from 1 to 65535 on the Port Number text 
boxes respectively.
The default port number is 110.

b)Enter the login ID on the Login ID text box and the password on the 
Password text box.

c)Enter the password one more time on the Confirm Password to 
confirm your choice.

Scanning to Email
You can scan and send an image as an email attachment. First, you need to 
set up your email account in SyncThru™ Web Service (See "Setting up an 
e-mail account" on page 2).
Before scanning, you can set the scan options for your scan job (See 
"Changing the settings for each scan job" on page 3).
1. Make sure that your machine is connected to a network.
2. Place a single document face down on the document glass, or load the 

documents face up into the ADF.
For details about loading an original, see "Loading originals" on page 1.
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3. Press (Scan) on the control panel.
4. Press the left/right arrow until Scan to Email appears on the bottom line 

of the display and press OK.

 

If you registered login ID (user name) and password on 
SyncThru™ Web Service, My Log in ID and Password appear. 
Enter the login ID and password to your machine. Go to step 6.

5. When From appears on the top line of the display, enter the sender’s 
email address and press OK.

6. When DestinationEmail appears on the top line of the display, enter the 
recipient’s email address and press OK.
If you have set up Address Book, you can use a speed button or a speed 
email or group email number to retrieve an address from memory (See 
"Setting up Address Book" on page 6).

7. To enter additional addresses, press OK when Yes appears and repeat 
step 6.
To continue to the next step, press the left/right arrow to select No and 
press OK.

8. If the display asks if you want to send the email to your account, press 
the left/right arrow to select Yes or No and press OK.

9. Enter an email subject and press OK.
10. Press the left/right arrow until the file format you want appears and press 

OK or Start (Black or Color).
The machine begins scanning and then sends the email.

11. If the machine asks if you want to log off your account, press the 
left/right arrow to select Yes or No and press OK.

12. Press Stop/Clear to return to ready mode.

Changing the settings for each scan job
Your machine provides you with the following setting options to allow you to 
customize your scan jobs.
• Scan Size: Sets the image size.
• Original Type: Sets the original document’s type.
• Resolution: Sets the image resolution.
• Scan Color: Sets the color mode.
• Scan Format: Sets the file format in which the image is to be saved. If 

you select TIFF or PDF, you can select to scan multiple pages. 
Depending on the selected scan type, this option may not appear.

To customize the settings before starting a scan job
1. Depending on the model, the operating procedure may differ.

•For CLX-3185, CLX-3185N and CLX-3185WK, press Menu on the 
control panel.

•For CLX-3185FN and CLX-3185FW, press (Scan) and Menu in 
order on the control panel.

2. Press the left/right arrow until Scan Feature appears and press OK.
3. Press the left/right arrow until the scan type you want appears and press 

OK.
4. Press the left/right arrow until the scan setting option you want appears 

and press OK.
5. Press the left/right arrow until the desired status appears and press OK.
6. Repeat steps 5 and 6 to change other settings.
7. When you have finished, press Stop/Clear to return to ready mode.

Changing the default scan settings
To avoid having to customize the scan settings for each job, you can set up 
default scan settings for each scan type.
1. Depending on the model, the operating procedure may differ.

•For CLX-3185, CLX-3185N and CLX-3185WK, press Menu on the 
control panel.

•For CLX-3185FN and CLX-3185FW, press (Scan) and Menu in 
order on the control panel.

2. Press the left/right arrow until Scan Setup appears and press OK.
3. Press the left/right arrow until Change Default appears.
4. Press the left/right arrow until the scan type you want appears and press 

OK.
5. Press the left/right arrow until the scan setting option you want appears 

and press OK.
6. Press the left/right arrow until the desired status appears and press OK.
7. Repeat steps 6 and 7 to change other settings.
8. To change the default settings for other scan types, press Back and 

repeat from step 5.
9. Press Stop/Clear to return mode.

Setting up Address Book 
(CLX-3185FN/CLX-3185FW only)
You can set up address book with the email addresses you use frequently 
via SyncThru™ Web Service and then easily and quickly enter email 
addresses by entering the location numbers assigned to them in address 
book.

Registering speed email numbers
1. Enter your machine’s IP address as the URL in a browser and click Go 

to access SyncThru™ Web Service of your machine.
2. Click Address Book on the menu tab in the top of the website.
3. The Individual Address Book page appears on the middle pane of the 

website.
4. Click Add to enter the contact information you want to register.
5. The Add windows appears.

Enter the contact information such as Name, E-mail address and Fax 
Number. Also, you can specify the Speed No.

6. Click Apply.

 

You can also import and export your address book via SyncThru™ 
Web Service.

Grouping addresses in Groups Address Book
1. Turn your network-connected computer on and open the web browser.
2. Enter your machine’s IP address as the URL in a browser.

(Example: http://123.123.123.123)
3. Press Enter or click Go to access the SyncThru™ Web Service.

 

If necessary, you can change the language in the upper right 
corner of the SyncThru™ Web Service.

4. Click Login.on the upper right of the website.
The Login window appears.

5. Type in the ID and Password, and then click Login.
If it is your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
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•ID: admin 
•Password: sec00000 

 

If you do not use the SyncThru™ Web Service for five minutes, it 
automatically gets logged out.

6. Click Address Book on the top of menu bar.
7. Click E-mail Groups.
8. Click Add Group. Then the Add window appears.
9. Enter the group name you want in the Group Name input area.

Specify the Speed No. from the drop-down list.
10. Select Add individual(s) after this group is created check box.

 

If you do not want to add individual addresses to the group 
address you made, skip this step. You can add individual 
addresses next time.

11. Click Apply. Then the Add window appears.
12. Check the addresses you want to add to E-mail Group Address Book 

from the Individual Address Book.
13. Click the arrow in the middle. The selected addresses are added in 

E-mail Group Address Book.
14. Click Apply.

Using Address Book entries
Speed email numbers
When you are prompted to enter a destination address while sending an 
email, enter the speed email number at which you stored the address 
you want.
•For a one-digit speed email location, press and hold the corresponding 

digit button from the number keypad.
•For a two- or three-digit speed email location, press the first digit 

button(s) and then hold down the last digit button.
You can search through memory for an entry by pressing Address 
Book (See "Searching Address Book for an entry" on page 4“).

Group email numbers
To use a group email entry, you need to search for and select it from 
memory.
When you are prompted to enter a destination address while sending an 
email, press Address Book (See "Searching Address Book for an 
entry" on page 4).

Searching Address Book for an entry
There are two ways to search for an address in memory. You can either 
scan from A to Z sequentially or search by entering the first letters of the 
name associated with the address.

Searching sequentially through memory
1.Press Address Book until Search & Send appears on the bottom line 

of the display and press OK.
2.Press the left/right arrow until the number category you want appears 

and press OK.
3.Press OK when All appears.
4.Press the left/right arrow until the name and address you want 

appears. You can search upwards or downwards through the entire 
memory in alphabetical order.

Searching with a particular first letter
1.Press Address Book until Search & Send appears on the bottom line 

of the display and press OK.
2.Press the left/right arrow until the number category you want appears 

and press OK.
3.Press the left/right arrow until ID appears and press OK.
4.Enter the first few letters of the name you want appears and press OK.
5.Press the left/right arrow until the name you want appears and press 

OK.

Printing Address Book
You can check your address Book settings by printing a list.
1. Press Address Book until Print appears on the bottom of the display.
2. Press OK.
3. Press the left/right arrow until the option you want appears and press 

OK.
4. Press OK when Yes appears to confirm printing.

The selected information prints out.

Using Samsung Scan and Fax Manager
If you have installed the printer driver, the Samsung Scan and Fax Manager 
program is installed too. For program information and the scanner’s status, 
start Samsung Scan and Fax Manager. With this program, you can change 
scan settings and add or delete the folders where scanned documents are 
saved in your computer. 

 

The Samsung Scan and Fax Manager program can only be used in 
the Windows and Mac OS system. If you use the Macintosh, See 
"Setting scan information in Scan and Fax Manager" on page 7.

1.  From the Start menu, click Control Panel > Samsung Scan and Fax 
Manager.

 

You can open Samsung Scan and Fax Manager by right clicking 
the Smart Panel icon in the Windows task bar and selecting Scan 
Manager.

2. Select the appropriate machine from the Samsung Scan and Fax 
Manager window.

3. Press Properties.
4. The Set Scan Button tab allows you to change the file saving 

destination and scan settings, to add or delete application program, and 
to change the file format to be saved.
You can change the scanning machine by using the Change Port tab 
(Local or Network).

5. When setting is done, press OK.
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Set Scan Button tab

Scan Destination
•Available Destination List: Shows the list of applications currently 

linked to scanned images in the PC’s registry. Select the program 
you want to use and click the right arrow and add to Front Panel 
Destination List. 

•Front Panel Destination List: Shows the list of applications to open 
scanned image.

•Add Application: Allows you to add application you want to use to 
Available Destination List.

•Remove Application: Allows you to remove an item added by the 
user in the Available Destination List. 

•File Format: Allows you to select the form of scanned data to be 
saved. You can choose among BMP, JPEG, PDF and TIFF.

Scan Property
•Computer ID: Shows the ID of your computer. 
•Save Location: Allows you to choose the location of the default saving 

folder.
•Resolution: Allows you to choose the scan resolution. 
•Scan Color: Allows you to choose the scan color. 
•Scan Size: Allows you to choose the scan size. 
•ADF Duplex: Automatically scans both sides. If your model does not 

support this option, it will be grayed out. 
•Show Preview: Checking this box allows you to preview applied scan 

options. You can modify the options before scanning. 
•Default: Allows you to go back to default options. 

Change Port tab

Local Scanner
Select when your machine is connected via USB port.

Network Scanner
Select when your machine is connected via network port.
•Auto detection on the network: Automatically detects your machine.
•IP or Host name: Enter in your machine’s IP address to detect your 

machine. 

Scan Assistant
When you press Quick Scan in Samsung Scan and Fax Manager, the 
Scan Assistant window appears. Scan Assistant allows you to adjust 
scan settings and start the scanning process.
In the Basic mode, Scan settings and Preferences are available only. 
If you want to use more settings, press Advanced.

•Favorites: Allows you to save the current preferences settings for 
future use. When you save Favorites, all current scan settings are 
saved. To use a saved setting, select it from the Favorites drop 
down list. The machine is now set to scan according to the setting 
you selected. To delete saved setting, select it from the Favorites 
drop down list and click Delete. To set a favorite as startup, select 
the favorite you want to set as startup, then click the Set as default 
button.
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•Scan settings: The following scan options are available.
-Image Type: Allows you to chose the proper color settings for 

image scanning.
-Resolution: Allows you to choose the image resolution.
-Document Size: Allows you to choose the proper size of the 

scanned image.
-Document Source: Allows you to choose the device (document 

feeder or scan glass) you want to scan with.
-Prompt for additional pages: If this check box is checked, you can 

scan pages continuously. This option is useful when you scan 
multi-page documents and/or when Document Source is set to 
Flatbed (platen glass). In this case a sequence of scanned 
images is processed as a single document.

-Pages to Scan: Allows you to specify how many pages are to be 
scanned. This option is available when Document Source is set 
to ADF(Document feeder).

•Preference: The following scan options are available.
-Auto crop image after preview: If this option is checked, the 

scanning area will be automatically adjusted to the image size.
-Preview on program start: If this option is checked, the scanning 

area will be selected automatically as shown in the preview.
-Blank page detection: This operation automatically detects 

whether the scanned image is blank or not.
-Delete page: Blank pages will be deleted at the end of the 

scanning process.
-Separate files: Blank page will work as a scan job separator. 

That is, when multiple pages are scanned at once a blank 
page will divide scanned image sequence into parts. Each 
part will be treated as a separate document (group).

-Start from scanner: If this option is checked, scanning process 
is managed using scanner touch screen rather than from the 
computer. The option is not available for some scanner 
models.

•Advanced: In the Advanced mode, additional options such as Image 
Adjustment, Image Enhancement, and Additional Settings are 
available.
-Image Adjustment: Allows you to perform some transformations of 

the scanned image. These transformations include automatic 
adjustment of image size, straightening and rotation.

-Image Enhancement: Allows you to remove various defects of the 
image and improve its quality.

-Additional settings: Allows special processing of scanned images. 
These transformations include stitching several partial image 
scans into a single image, processing of scanned books and 
watermark stamping.

 

Click the Help button from the lower-left corner of the window and 
click on any option you want to know about. Then a pop up window 
appears with information about that option's feature which is 
provided from the Scan Assistant.

Scanning with TWAIN-enabled software
If you want to scan documents using other software, you will need to use 
TWAIN-compliant software such as Adobe Photoshop. 
Follow the steps below to scan with TWAIN-compliant software.

1. Make sure that the machine is connected to your computer and powered 
on.

2. Load originals face up into the document feeder, or place a single 
original face down on the scanner glass (See "Loading originals" on 
page 1).

3. Open an application such as Adobe Photoshop.
4. Open the TWAIN window and set the scan options.
5. Scan and save your scanned image.

Scanning using the WIA driver
Your machine also supports the Windows Image Acquisition (WIA) driver for 
scanning images. WIA is one of the standard components provided by 
Microsoft Windows XP and works with digital cameras and scanners. Unlike 
the TWAIN driver, the WIA driver allows you to scan and easily adjust 
images without using additional software.

 

The WIA driver works only on Windows XP/Vista with a USB port.

Windows XP
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "Loading originals" on page 1).

3. From the Start menu, select Control Panel > Scanners and Cameras.
4. Double-click your scanner driver icon. The Scanner and Camera 

wizard appears.
5. Click Next.
6. Set the option in Choose scanning preferences window and click 

Preview to see how your options affect the picture.
7. Click Next.
8. Enter a picture name, and select a file format and destination to save the 

picture.
9. Your picture has been successfully copied to your computer. Choose 

one of the options on screen. 
10. Click Next.
11. Click Finish.

Windows Vista
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "Loading originals" on page 1).

3. From the Start menu select Control Panel > Hardware and Sound > 
Scanners and Cameras. 

4. Double-click Scan a document or picture. Windows Fax and Scan 
application appears.

 

•You can click on View scanners and cameras to view scanners, 
•If there is no Scan a document or picture, open the MS paint 

program and from the File click From Scanner or Camera...
5. Click New Scan. Scan driver appears.
6. Choose your scanning preferences and click Preview to see your 

preferences affect the picture.
7. Click Scan.

 

If you want to cancel the scan job, press the Cancel button on the 
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Scanner and Camera wizard.

Windows 7
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass
(See "Loading originals" on page 1).

3. From the Start menu select Control Panel > Hardware and Sound > 
Devices and Printers. 

4. Click right button of mouse on device driver icon in Printers and Faxes 
> Start Scan. New Scan application appears.

5. Choose your scanning preferences and click Preview to see your 
preferences affect the picture.

6. Click Scan.

Macintosh scanning
You can scan documents using Image Capture program. Mac OS offers 
Image Capture program. 

Scanning with USB
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "Loading originals" on page 1).

3. Start Applications and click Image Capture.

 

If No camera or scanner connected message appears, 
disconnect the USB cable and reconnect it. If the problem persists, 
refer to the Image Capture’s help.image

4. Set the scan options on this program.
5. Scan and save your scanned image.

 

•For more information about using Image Capture, refer to the Image 
Capture’s help.

•Use TWAIN-compliant software to apply more scan options.
•You can also scan using TWAIN-compliant software, such as Adobe 

Photoshop.
•Scan process differ according to TWAIN-compliant software. Please 

refer to the user’s guide of the software.
•If scanning does not operate in Image Capture, update Mac OS to 

the latest version. Image Capture operates properly in Mac OS X 
10.3.9 or higher and Mac OS X 10.4.7 or higher.

Scanning with network
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass (See "Loading originals" on 
page 1).

3. Start Applications and click Image Capture.
4. For Mac OS X 10.4 ~ 10.5

Click Devices and click Browse Devices.
For Mac OS X 10.6
Select your device below SHARED. Skip to step 7.

5. For Mac OS X 10.4

Select your machine in TWAIN devices option. Make sure that Use 
TWAIN software check box is checked, and click Connect.
•If a warning message appears, click Change Port.. to select port. 
•If TWAIN UI appears, from the Preference tab, click Change Port.. to 

select port. 

 

Refer to scan manager for Change port.. use (See "Setting 
scan information in Scan and Fax Manager" on page 7).

For Mac OS X 10.5
Make sure that Connected check box is checked beside your machine 
in Bonjour Devices.
If you want to scan using TWAIN, refer to the Mac OS X 10.4 steps 
above.

6. Set the scan options on this program.
7. Scan and save your scanned image.

 

•For Mac OS X 10.3, use TWAIN-compliant software. 
•For more information about using Image Capture, refer to the Image 

Capture’s help.
•Use TWAIN-compliant software to apply more scan options. 
•You can also scan using TWAIN-compliant software, such as Adobe 

Photoshop.
•Scan process differ according to TWAIN-compliant software. Please 

refer to the user’s guide of the software.
•If scanning does not operate in Image Capture, update Mac OS to 

the latest version. Image Capture operates properly in Mac OS X 
10.4.7 or higher.

Setting scan information in Scan and Fax Manager
When you want to find out about Scan and Fax Manager program 
information, to check the installed scan driver's condition, to change 
scan settings and to add or delete the folders where scanned 
documents to computer are saved in Scan and Fax Manager program, 
follow the below steps.
1.From the Smart Panel menu on Status bar, click Scan and Fax 

Manager. 
2.Select the appropriate machine from the Scan and Fax Manager.
3. Press Properties.
4.Use Set Scan Button to change the file destination or scan settings, 

to add or delete application programs, and to format files. You can 
change the scanning machine by using Change Port (Local or 
Network).

5.When done, press OK.

Linux Scanning
You can scan a document using the Unified Driver Configurator window.

Scanning
1. Double-click the Unified Driver Configurator on your desktop.

2. Click the  button to switch to Scanners configuration.
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3. Select the scanner on the list.

If you use only one machine device and it is connected to the computer 
and turned on, your scanner appears on the list and is automatically 
selected.
If you have two or more scanners connected to your computer, you can 
select any scanner to work at any time. For example, while acquisition is 
in progress on the first scanner, you may select the second scanner, set 
the device options and start the image acquisition simultaneously.

4. Click Properties.
5. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "Loading originals" on page 1).

6. From the Scanner Properties window, click Preview.
The document is scanned and the image preview appears in the 
Preview Pane.

7. Drag the pointer to set the image area to be scanned in the Preview 
Pane. 

8. Change the scan options in the Image Quality and Scan Area sections.
•Image Quality: This option allows you to select the color composition 

and the scan resolution for the image.
•Scan Area: This option allows you to select the page size. The 

Advanced button enables you to set the page size manually.
If you want to use one of the preset scan option settings, select the 
option from the Job Type drop-down list (See "Adding Job Type 

Settings" on page 8).
Click Default to restore the default setting for the scan options.

9. When you have finished, click Scan to start scanning.
The status bar appears on the bottom left of the window to show you the 
progress of the scan. To cancel scanning, click Cancel.

10. The scanned image appears.
If you want to edit the scanned image, use the toolbar (See "Using the 
Image Manager" on page 8).

11. When you are finished, click Save on the toolbar.
12. Select the file directory where you want to save the image and enter the 

file name.
13. Click Save.

Adding Job Type Settings
You can save your scan option settings for later use.

To save a new Job Type setting
1.Change the options from the Scanner Properties window.
2.Click Save As.
3.Enter the name for your setting.
4.Click OK. 

Your setting is added to the Saved Settings drop-down list.

To save a Job Type setting for the next scan job
1.Select the setting you want to use from the Job Type drop-down list.
2.The next time you open the Scanner Properties window, the saved 

setting is automatically selected for the scan job.

To delete a Job Type setting
1.Select the setting you want to delete from the Job Type drop-down 

list.
2.Click Delete.

The setting is deleted from the list.

Using the Image Manager
The Image Manager application provides you with menu commands and 
tools to edit your scanned image.

Use the following tools to edit the image.
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For further details about the Image Manager application, refer to the on 
screen help.

Tools Name Function

Save Saves the image.

Undo Cancels your last action.

Redo Restores the action you canceled.

Scroll Allows you to scroll through the image.

Crop Crops the selected image area.

Zoom Out Zooms the image out.

Zoom In Zooms the image in.

Scale Allows you to scale the image size; you can 
enter the size manually, or set the rate to scale 
proportionally, vertically, or horizontally.

Rotate Allows you to rotate the image; you can select 
the number of degrees from the drop-down list.

Flip Allows you to flip the image vertically or 
horizontally. 

Brightness Allows you to adjust the brightness or contrast 
of the image, or to invert the image.

Properties Shows the properties of the image.
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1.faxing (clx-3185fn/clx-3185fw only)
This chapter gives you information about using your machine as a fax machine.
This chapter includes:
• Preparing to fax
• Using a fax in your computer
• Sending a fax in your machine
• Receiving a fax in your machine

• Adjusting the document settings
• Forwarding a fax to another destination
• Setting up Address Book
• Printing sent fax report automatically

  

 

•You cannot use this machine as a fax via the internet phone. For 
more information ask your internet service provider.

•We recommend using traditional analog phone services (PSTN: 
Public Switched Telephone Network) when connecting telephone 
lines to use a fax machine. If you use other Internet services (DSL, 
ISDN, VolP), you can improve the connection quality by using the 
Micro-filter. The Micro-filter eliminates unnecessary noise signals 
and improves connection quality or Internet quality. Since the DSL 
Micro-filter is not provided with the machine, contact your Internet 
service provider for use on DSL Micro-filter.

1 Line port
2 Micro filter
3 DSL modem / Telephone line

 

Supported optional devices and features may differ according to your 
model. Check your model name.
(See "Features by Models" on page 2).

Preparing to fax
Before you send or receive a fax, you need to connect the supplied line cord 
to your telephone wall jack. Refer to the Quick Installation Guide how to 
make a connection. The method of making a telephone connection is 
different from one country to another.

Using a fax in your computer
You can send and receive a fax from your computer without going to the 
machine.

Sending a fax (Windows)
To send a fax from your computer, the Samsung Network PC Fax program 
must be installed. This program will be installed when you installed the 
printer driver. 
1. Open the document to be sent.
2. Select Print from the File menu. 

The Print window will be displayed. It may look slightly different 

depending on your application.
3. Select Samsung Network PC Fax from the Print window
4. Click Print or OK. Then, a windows like the image below will appear.

5. Enter the recipients’ number and set the options if necessary.
If you want to use a cover page, check Use cover page.
Check Notify me on delivery, when the fax is delivered to the recipient 
successfully. 

6. Click Send.

 

For the more information about Samsung Network PC Fax, click 
Help. 

Checking a sent fax list (Windows)
You can check a sent fax list on your computer.
From the Start menu, click Programs or All Programs > Samsung 
Printers > Network PC Fax > Fax Journal. Then, the Fax Journal 
appears with the fax list you have sent.

Sending a fax (Macintosh)
To send a fax from your computer, the Fax Utilities program must be 
installed. This program is installed when you install the printer driver.
The following steps are based on the Mac OS X 10.5 or 10.6. Depending on 
the OS version, the following steps will be different.
1. Open the document to be sent.
2. Select Print from the File menu.

The Print window will be displayed. It may look slightly different 
depending on your application.
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In case of Mac OS X 10.3 or 10.4, select PDF and Fax PDF.

3. Select CLX-3180 Series fax-USB from the drop-down list in Printer.
4. Choose the number of copies you want and indicate which pages you 

want to fax.
5. Choose your paper size, orientation, and scale.
6. Enter the recipients’ fax number into To’s input area. You can also use 

Addresses pressing button, if you have stored frequently used fax 
numbers.

7. If necessary, enter the access code in Dialing Prefix input area.
8. If necessary, you can send the fax with cover page, check Use Cover 

Page.
Enter the subject and message of the fax job.

 

You can set more detailed options for cover page option in 
Samsung Fax Cover Page. Select Samsung Fax Cover Page 
from the drop-down list under Orientation.

9. Click Fax.
10. The Fax Journal icon appears on your Macintosh dock. Click the icon.

You can see the status of the fax job. You can also delete, hold, resume, 
and pause the fax job.

Sending a fax in your machine
This part explains how to send a fax and the special methods of 
transmission.

 

When you place the originals, you can use either the document feeder 
or the scanner glass (See "Loading originals" on page 1). If the 
originals are placed on both the document feeder and the scanner 
glass, the machine will read the originals on the document feeder first, 
which has higher priority in scanning.

Setting the fax header
In some countries, you are required by law to indicate your fax number on 
any fax you send. 
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Machine Setup appears and press OK.
4. Press the left/right arrow until Machine ID appears and press OK.
5. Enter your name or the company name using the number keypad. You 

can enter alphanumeric characters using the number keypad, and 
include special symbols by pressing the 1 button. For details on how to 
enter alphanumeric characters, see "Entering characters using the 
number keypad (CLX-3185FN/CLX-3185FW only)" on page 2.

6. Press OK to save the ID.
7. Press the left/right arrow until Machine Fax No. appears and press OK.
8. Enter your fax number using the number keypad and press OK.
9. Press Stop/Clear to return to ready mode.

Sending a fax 
1. Press (Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "On the scanner glass" on page 1 or "In the document feeder 
(CLX-3185FN/CLX-3185FW only)" on page 1).

3. Adjust the resolution and the darkness to suit your fax needs (See 
"Adjusting the document settings" on page 5).

4. Enter the receiving fax machine’s number.
You can use speed dial numbers, or group dial numbers. For details 
about storing and searching for a number, see "Setting up Address 
Book" on page 6.

5. Press Color Start or Black Start on the control panel. The machine 
starts to scan and send a fax to destinations.

 

•If you want to send fax directly from your computer, use Samsung 
Network PC Fax (See "Sending a fax (Windows)" on page 1).

•When you want to cancel a fax job, press Stop/Clear before the 
machine start transmission.

•If you used the scanner glass, the machine shows the message 
asking to place another page.

Sending a fax manually
This method is sending a fax using On Hook Dial on the control panel.

1. Press (Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
3. Adjust the resolution and the darkness to suit your fax needs (See 

"Adjusting the document settings" on page 5).
4. Press On Hook Dial on the control panel or lift the handset.
5. Enter a fax number using the number keypad on the control panel.
6. Press Color Start or Black Start when you hear a high-pitched fax 

signal from the remote fax machine.

 

When you want to cancel a fax job, press Stop/Clear at any time while 
sending.

Confirming a transmission
When the last page of your original has been sent successfully, the machine 
beeps and returns to ready mode.
When something goes wrong while sending your fax, an error message 
appears on the display. You must treat the malfunction according to the 
error messages on the display (See "Understanding display messages" on 
page 5 for a list of error messages and their meanings. If you receive an 
error message, press Stop/Clear to clear the message and try to send the 
fax again.
You can set your machine to print a confirmation report automatically each 
time sending a fax is completed (See "Printing sent fax report automatically" 
on page 8).

Automatic redialing
When the number you have dialed is busy or there is no answer when you 
send a fax, the machine automatically redials the number every three 
minutes, up to seven times according to the factory default settings.
When the display shows Retry Redial?, press OK to redial the number 
without waiting. To cancel the automatic redialing, press Stop/Clear.
To change the time interval between redials and the number of redial 
attempts (See "Changing the fax setup options" on page 1).

Redialing the last number
To redial the number you called last
1. Press Redial/Pause on the control panel.
2. When an original is loaded in the document feeder, the machine 

automatically begins to send.
If an original is placed on the scanner glass, select Yes to add another 
page. Load another original and press OK. When you have finished, 
select No at the Another Page? prompt.
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Sending a fax to multiple destinations
You can use the Multiple Send feature, which allows you to send a fax to 
multiple locations. Originals are automatically stored in memory and sent to 
a remote station. After transmission, the originals are automatically erased 
from memory. You cannot send a color fax using this feature.

1. Press (Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
3. Adjust the resolution and the darkness to suit your fax needs (See 

"Adjusting the document settings" on page 5).
4. Press Menu on the control panel.
5. Press the left/right arrow until Fax Feature appears and press OK.
6. Press the left/right arrow until Multi Send appears and press OK.
7. Enter the number of the first receiving fax machine and press OK.

You can press speed dial numbers or select group dial number using 
Address book button. For details, see "Setting up Address Book" on 
page 6.

8. Enter the second fax number and press OK.
The display asks you to enter another fax number to send the document.

9. To enter more fax numbers, press OK when Yes appears and repeat 
steps 7 and 8. You can add up to 10 destinations.

10. Press OK to start storing the scanned original data into memory.

 

Once you entered a group dial number, you cannot enter another 
group dial numbers anymore.

11. When you have finished entering fax numbers, press the left/right arrow 
to select No at the Another No.? prompt and press OK.

12. If an original is placed on the scanner glass, select Yes to add another 
pages. Load another original and press OK.
When you have finished, select No at the Another Page? prompt.
The machine begins sending the fax to the numbers you entered in the 
order in which you entered them.

Delaying a fax transmission
You can set your machine to send a fax at a later time when you will not be 
present. You cannot send a color fax using this feature.

1. Press (Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
3. Adjust the resolution and the darkness to suit your fax needs (See 

"Adjusting the document settings" on page 5).
4. Press Menu on the control panel.
5. Press the left/right arrow until Fax Feature appears and press OK.
6. Press the left/right arrow until Delay Send appears and press OK.
7. Enter the number of the receiving fax machine and press OK.

You can press speed dial numbers or select group dial number using 
Address book button. For details, see "Setting up Address Book" on 
page 6.

8. The display asks you to enter another fax number to send the document.
9. To enter more fax numbers, press OK when Yes appears and repeat 

steps 7. You can add up to 10 destinations.

 

Once you entered a group dial number, you cannot enter another 
group dial numbers anymore.

10. When you have finished entering fax numbers, press the left/right arrow 
to select No at the Another No.? prompt and press OK.

11. Enter the job name you want and press OK.
For details on how to enter alphanumeric characters, see "Entering 
characters using the number keypad (CLX-3185FN/CLX-3185FW only)" 
on page 2.
If you do not want to assign a name, skip this step.

12. Enter the time using the number keypad and press OK.

 

If you set a time earlier than the current time, the fax will be sent at 
that time on the following day.

The original is scanned into memory before transmission.
13. If an original is placed on the scanner glass, select Yes to add another 

pages. Load another original and press OK.
When you have finished, select No at the Another Page? prompt.
The machine returns to ready mode. The display reminds you that you 
are in ready mode and that a delayed fax is set.

Adding documents to a reserved delay fax job
You can add additional documents to the delayed fax job which is saved 
in memory.
1.Load the originals to be added and adjust document settings.

2.Press (Fax) on the control panel.
3.Press Menu on the control panel.
4.Press the left/right arrow until Fax Feature appears and press OK.
5.Press the left/right arrow until Add Page appears and press OK.
6.Press the left/right arrow until the fax job you want appears and press 

OK.
When you have finished, select No at the Another Page? prompt. 
The machine scans the original into memory.

7.Press Stop/Clear to return to ready mode.

Canceling a reserved delay fax job
You can cancel the delayed fax job which is saved in memory.
1.Press Menu on the control panel.

2.Press (Fax) on the control panel.
3.Press the left/right arrow until Fax Feature appears and press OK.
4.Press the left/right arrow until Cancel Job appears and press OK.
5.Press the left/right arrow until the fax job you want appears and press 

OK.
6.Press OK when Yes appears.

The selected fax is deleted from memory.
7.Press Stop/Clear to return to ready mode.

Sending a priority fax
This function is used when a high priority fax need to be sent ahead of 
reserved operations. The original is scanned into memory and immediately 
transmitted when the current operation is finished. In addition, priority 
transmission will interrupt a sending to multiple destinations between 
stations (example, when the transmission to station A ends, before 
transmission to station B begins) or between redial attempts.

1. Press (Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
3. Adjust the resolution and the darkness to suit your fax needs (See 

"Adjusting the document settings" on page 5).
4. Press Menu on the control panel.
5. Press the left/right arrow until Fax Feature appears and press OK.
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6. Press the left/right arrow until Priority Send appears and press OK.
7. Enter the number of the receiving fax machine and press OK.

You can press speed dial numbers or select group dial number using 
Address book button. For details, see "Setting up Address Book" on 
page 6.

8. Enter the job name you want and press OK.
The original is scanned into memory before transmission.

9. If an original is placed on the scanner glass, select Yes to add another 
pages. Load another original and press OK.
When you have finished, select No at the Another Page? prompt.
The machine starts to scan and send a fax to destinations.

Receiving a fax in your machine
This part explains how to receive a fax, and the special receiving methods 
available.

Changing the receive modes
Your machine is preset to Fax mode at the factory. When you receive a fax, 
the machine answers the call on a specified number of rings and 
automatically receives the fax. But if you want to change the Fax mode to 
another mode, follow the steps below.

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Setup appears and press OK.
4. Press the left/right arrow until Receiving appears and press OK.
5. Press the left/right arrow until Receive Mode appears and press OK.
6. Press the left/right arrow until the fax reception mode you want appears.

•Fax: Answers an incoming fax call and immediately goes into the fax 
reception mode.

•Tel: Receives a fax by pressing On Hook Dial and then Start. If your 
machine has a handset, you can receive a fax by picking up the 
handset.

•Ans/Fax: Is for when an answering machine attached to your machine. 
Your machine answers an incoming call, and the caller can leave a 
message on the answering machine. If the fax machine senses a fax 
tone on the line, the machine automatically switches to Fax mode to 
receive the fax.

•DRPD: you can receive a call using the Distinctive Ring Pattern 
Detection (DRPD) feature. Distinctive Ring is a telephone company 
service which enables an user to use a single telephone line to 
answer several different telephone numbers. For further details, see 
"Receiving faxes using DRPD mode" on page 4.

7. Press OK to save your selection.
8. Press Stop/Clear to return to ready mode.

 

•To use the Ans/Fax mode, attach an answering machine to the 
EXT socket on the back of your machine. 

•If you do not want other people to view your received documents, 
you can use secure receiving mode. In this mode, all of the 
received faxes are stored in memory. For further details, see 
"Receiving in secure receiving mode" on page 5.

Receiving automatically in Fax mode
Your machine is preset Fax mode at the factory. When you receive a fax, 
the machine answers the call on a specified number of rings and 
automatically receives the fax.
To change the number of rings, see "Fax setup (CLX-3185FN/CLX-3185FW 
only)" on page 1.

Receiving manually in Tel mode
You can receive a fax call by pressing On Hook Dial and then pressing 
Black Start or Color Start when you hear a fax tone from the remote 
machine.
The machine begins receiving a fax and returns to ready mode when the 
reception is completed.

Receiving faxes manually using an extension 
telephone
This feature works best when you are using an extension telephone 
connected to the EXT socket on the back of your machine. You can receive 
a fax from someone you are talking to on the extension telephone, without 
going to the fax machine.
When you receive a call on the extension phone and hear fax tones, press 
the keys *9* on the extension phone. The machine receives the fax.
Press the buttons slowly in sequence. If you still hear the fax tone from the 
remote machine, try pressing *9* once again.
*9* is the remote receive code preset at the factory. The first and the last 
asterisks are fixed, but you can change the middle number to whatever you 
wish. For details about changing the code, see "Changing the fax setup 
options" on page 1

Receiving automatically in Answering Machine/Fax 
mode
To use this mode, you must attach an answering machine to the EXT socket 
on the back of your machine (See "Rear view" on page 5).
If the caller leaves a message, the answering machine stores the message 
as it would normally. If your machine detects a fax tone on the line, it 
automatically starts to receive the fax.

 

•If you have set your machine to this mode and your answering 
machine is switched off, or no answering machine is connected to 
EXT socket, your machine automatically goes into Fax mode after 
a predefined number of rings.

•If your answering machine has a user-selectable ring counter, set the 
machine to answer incoming calls within 1 ring.

•If you are in Tel mode when the answering machine is connected to 
your machine, you must switch off the answering machine. 
Otherwise, the outgoing message from the answering machine will 
interrupt your phone conversation.

Receiving faxes using DRPD mode
Distinctive Ring is a telephone company service which enables an user to 
use a single telephone line to answer several different telephone numbers. 
The particular number someone uses to call you is identified by different 
ringing patterns, which consist of various combinations of long and short 
ringing sounds. This feature is often used by answering services who 
answer telephones for many different clients and need to know which 
number someone is calling in on to properly answer the phone.
Using the Distinctive Ring Pattern Detection (DRPD) feature, your fax 
machine can learn the ring pattern you designate to be answered. Unless 
you change it, this ringing pattern will continue to be recognized and 
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answered as a fax call, and all other ringing patterns will be forwarded to the 
extension telephone or answering machine plugged into the EXT socket. 
You can easily suspend or change DRPD at any time.
Before using the DRPD option, Distinctive Ring service must be installed on 
your telephone line by the telephone company. To set up DRPD, you will 
need another telephone line at your location, or someone available to dial 
your fax number from outside.
To set up the DRPD mode

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Setup appears and press OK.
4. Press the left/right arrow until Receiving appears and press OK.
5. Press the left/right arrow until Receive Mode appears and press OK.
6. Press the left/right arrow until DRPD appears and press OK.

Waiting Ring appears on the display.
7. Call your fax number from another telephone. It is not necessary to 

place the call from a fax machine.
8. When your machine begins to ring, do not answer the call. The machine 

requires several rings to learn the pattern.
When the machine completes learning, the display shows Completed 
DRPD Setup. If the DRPD setup fails, Error DRPD Ring appears.
Press OK when DRPD appears and start over from step 6.

 

•DRPD must be set up again if you re-assign your fax number, or 
connect the machine to another telephone line. 

•After DRPD has been set up, call your fax number again to verify 
that the machine answers with a fax tone. Then have a call 
placed to a different number assigned to that same line to be 
sure the call is forwarded to the extension telephone or 
answering machine plugged into the EXT socket.

Receiving in secure receiving mode
You may need to prevent your received faxes from being accessed by 
unauthorized people. You can turn on secure receiving mode to restrict 
printing of received faxes when the machine is unattended. In secure 
receiving mode, all incoming faxes go into memory. When the mode is 
deactivated, any stored faxes are printed.

Activating secure receiving mode
1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appears and press OK.
4. Press the left/right arrow until Secure Receive appears and press OK.
5. Press the left/right arrow until On appears and press OK.
6. Enter a four-digit password you want to use and press OK.

 

You can activate secure receiving mode without setting a 
password, but cannot protect your faxes.

7. Re-enter the password to confirm it and press OK.
8. Press Stop/Clear to return to ready mode.
When a fax is received in secure receiving mode, your machine stores it in 
memory and shows Secure Receive to let you know that there is a fax 
received.

Printing received faxes
1.Access the Secure Receive menu by following steps 1 through 4 in 

“Activating secure receiving mode.”
2.Press the left/right arrow until Print appears and press OK.

3.Enter the four-digit password and press OK.
The machine prints all of the faxes stored in memory.

Deactivating secure receiving mode
1.Access the Secure Receive menu by following steps 1 through 4 in 

“Activating secure receiving mode.”
2.Press the left/right arrow until Off appears and press OK.
3.Enter the four-digit password and press OK.

The mode is deactivated and the machine prints all faxes stored in 
memory.

4.Press Stop/Clear to return to ready mode.

Receiving faxes in memory
Since your machine is a multi-tasking device, it can receive faxes while you 
are making copies or printing. If you receive a fax while you are copying or 
printing, your machine stores incoming faxes in its memory. Then, as soon 
as you finish copying or printing, the machine automatically prints the fax. 

Adjusting the document settings
Before starting a fax, change the following settings according to your 
original’s status to get the best quality.

Resolution
The default document settings produces good results when using typical 
text-based originals. However, if you send originals that are of poor quality, 
or contain photographs, you can adjust the resolution to produce a higher 
quality fax. 

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appears and press OK.
4. Press the left/right arrow until Resolution appears and press OK.
5. Press the left/right arrow until the option you want appears and press 

OK.
6. Press Stop/Clear to return to ready mode.
Recommended resolution settings for different original document types are 
described in the table below.

mode recommended for

Standard Originals with normal sized characters

Fine Originals containing small characters or thin lines or 
originals printed using a dot-matrix printer

Super Fine Originals containing extremely fine detail. Super Fine 
mode is enabled only if the machine with which you are 
communicating also supports the Super Fine resolution.

 

•For memory transmission, Super Fine mode is 
not available. The resolution setting is 
automatically changed to Fine.

•When your machine is set to Super Fine 
resolution and the fax machine with which you 
are communicating does not support Super 
Fine resolution, the machine transmits using 
the highest resolution mode supported by the 
other fax machine.

Photo Fax Originals containing shades of gray or photographs
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The resolution setting is applied to the current fax job. To change the 
default setting, see "Change Default" on page 2.

Darkness
You can select the degree of darkness of the original document. 

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appears and press OK.
4. Press the left/right arrow until Darkness appears and press OK.
5. Press the left/right arrow until the option you want appears and press 

OK.
6. Press Stop/Clear to return to ready mode.

 

The darkness setting is applied to the current fax job. To change the 
default setting, see "Change Default" on page 2.

Forwarding a fax to another destination
You can set the machine to forward the received or sent fax to other 
destination by a fax. If you are out of office but have to receive the fax, this 
feature may be useful.

Forwarding a sent fax to another destination
You can set the machine to forward every fax you sent to another 
destination.

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appears and press OK.
4. Press the left/right arrow until Forward appears and press OK.
5. Press the left/right arrow until Fax appears and press OK.
6. Press the left/right arrow until Send Forward appears and press OK.
7. Press the left/right arrow until On appears and press OK.
8. Enter the number of the fax machine to which faxes are to be sent and 

press OK.
9. Press Stop/Clear to return to ready mode.

Subsequent sent faxes will be forwarded to the specified fax machine.

Forwarding a received fax to another destination
With this feature, you can forward every fax you received to another 
destination. When the machine receives a fax, a fax is stored in the memory 
then, the machine sends it to the destination you have set.

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appears and press OK.
4. Press the left/right arrow until Forward appears and press OK.
5. Press the left/right arrow until Fax appears and press OK.
6. Press the left/right arrow until Rcv. Forward appears and press OK.
7. Press the left/right arrow until Forward appears and press OK.

To set the machine to print out a fax when fax forwarding has been 
completed, select Forward & Print. 

8. Enter the number of the fax machine to which faxes are to be sent and 
press OK.

9. Enter the starting time using left/right arrow or numeric keypad and 
press OK.

10. Enter the ending time using left/right arrow or numeric keypad and press 
OK.

11. Press Stop/Clear to return to ready mode.
Subsequent sent faxes will be forwarded to the specified fax machine.

Forwarding a sent fax to email address
You can set the machine to forward every fax you sent to another 
destination.

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appears and press OK.
4. Press the left/right arrow until Forward appears and press OK.
5. Press the left/right arrow until E-mail appears and press OK.
6. Press the left/right arrow until Send Forward appears and press OK.
7. Press the left/right arrow until On appears and press OK.
8. Enter the sender’s email address when From appears on the display 

and press OK.
9. Enter the recipient’s email address when DestinationEmail appears on 

the display and press OK.
10. Then, the setting is saved.
11. Press Stop/Clear to return to ready mode.

Subsequent sent faxes will be forwarded to the specified email address.

Forwarding a received fax to email address
With this feature, you can forward every fax you received to another 
destination. When the machine receives a fax, a fax is stored in the memory 
then, the machine sends it to the destination you have set.

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appears and press OK.
4. Press the left/right arrow until Forward appears and press OK.
5. Press the left/right arrow until E-mail appears and press OK.
6. Press the left/right arrow until Rcv. Forward appears and press OK.
7. Press the left/right arrow until Forward appears and press OK.

To set the machine to print out a fax when fax forwarding has been 
completed, select Forward & Print. 

8. Enter the sender’s email address when From appears on the display 
and press OK.

9. Enter the recipient’s email address when DestinationEmail appears on 
the display and press OK.

10. Then, the setting is saved.
11. Press Stop/Clear to return to ready mode.

Subsequent sent faxes will be forwarded to the specified email address.

Setting up Address Book
You can set up Address Book with the fax numbers you use most 
frequently. Your machine provides you with the following features for setting 
up Address Book.

 

Before beginning to store fax numbers, make sure that your machine 
is in Fax mode.

Speed dial numbers
You can store up to 240 frequently-used fax numbers in speed dial 
numbers.
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Registering a speed dial number
1.Press (Fax) on the control panel.
2.Press Address Book on the control panel.
3.Press the left/right arrow until New & Edit appears and press OK.
4.Press the left/right arrow until Speed Dial appears and press OK.
5.Enter a speed dial number between 1 and 240 and press OK.

If an entry is already stored in the number you choose, the display 
shows the message to allow you to change it. To start over with 
another speed dial number, press Back.

6.Enter the name you want and press OK.
For details on how to enter alphanumeric characters (See "Entering 
characters using the number keypad (CLX-3185FN/CLX-3185FW 
only)" on page 2).

7.Enter the fax number you want and press OK.
8.Press Stop/Clear to return to ready mode.

Editing speed dial numbers
1.Press (Fax) on the control panel.
2.Press Address Book on the control panel.
3.Press the left/right arrow until New & Edit appears and press OK.
4.Press the left/right arrow until Speed Dial appears and press OK.
5.Enter the speed dial number you want to edit and press OK.
6.Change the name and press OK.
7.Change the fax number and press OK.
8.Press Stop/Clear to return to ready mode.

Using speed dial numbers
When you are prompted to enter a destination number while sending a 
fax, enter the speed dial number at which you stored the number you 
want.
•For a one-digit (0-9) speed dial number, press and hold the 

corresponding digit button on the number keypad.
•For a two- or three-digit speed dial number, press the first digit button(s) 

and then hold down the last digit button.
You can also search through memory for an entry by pressing Address 
Book (See "Searching Address Book for an entry" on page 7).

Group dial numbers
If you frequently send the same document to several destinations, you can 
group these destinations and set them under a group dial number. You can 
then use a group dial number to send a document to all of the destinations 
within the group. You can set up to 200 (1 through 200) group dial numbers 
using the destination’s existing speed dial numbers.

Registering a group dial number
1.Press (Fax) on the control panel.
2.Press Address Book on the control panel.
3.Press the left/right arrow until New & Edit appears and press OK.
4.Press the left/right arrow until Group Dial appears and press OK.
5.Enter a group dial number between 1 and 200 and press OK.

If an entry is already stored in the number you choose, the display 
shows the message to allow you to change it.

6.Enter the name you want and press OK.
For details on how to enter alphanumeric characters (See "Entering 
characters using the number keypad (CLX-3185FN/CLX-3185FW 
only)" on page 2).

7.Enter the speed dial number you want and press OK.
8.Press OK when the speed dial information appears correctly.
9.Press OK when Yes appears at the Add? prompt.
10.Press OK when Yes appears at the Another No.? prompt.

Repeat steps 7 and 10 to include other speed dial numbers into the 
group.

11.When you have finished, press the left/right arrow to select No at the 
Another No.? prompt and press OK.

12.Press Stop/Clear to return to ready mode.

Editing a group dial number
1.Press (Fax) on the control panel.
2.Press Address Book on the control panel.
3.Press the left/right arrow until New & Edit appears and press OK.
4.Press the left/right arrow until Group Dial appears and press OK.
5.Enter the group dial number you want to edit and press OK.
6.Enter the name you want to edit and press OK.
7.Enter the speed dial number you want to add or delete and press OK.
8.Press OK when the speed dial information appears correctly.

If you entered a new speed dial number, Add? appears.
If you enter a speed dial number stored in the group, Delete? 
appears.

9.Press OK to add or delete the number.
10.Press OK when Yes appears to add or delete more numbers and 

repeat steps 7 and 8.
11.When you have finished, press the left/right arrow to select No at the 

Another No.? and press OK.
12.Press Stop/Clear to return to ready mode.

Using group dial numbers
To use a group dial entry, you need to search for and select it from 
memory.
When you are prompted to enter a fax number while sending a fax, 
press Address Book. See below.

Searching Address Book for an entry
There are two ways to search for a number in memory. You can either scan 
from A to Z sequentially, or you can search by entering the first letters of the 
name associated with the number.

Searching sequentially through the memory
1.Press (Fax) on the control panel.
2.Press Address Book on the control panel.
3.Press the left/right arrow until Search & Dial appears and press OK.
4.Press the left/right arrow until the number category you want appears 

and press OK.
5.Press the left/right arrow until All appears and press OK.
6.Press the left/right arrow until the name and number you want 

appears.

Searching with a particular first letter through the 
memory
1.Press (Fax) on the control panel.
2.Press Address Book on the control panel.
3.Press the left/right arrow until Search & Dial appears and press OK.
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4.Press the left/right arrow until the number category you want appears 
and press OK.

5.Press the left/right arrow until ID appears and press OK.
6.Enter the first few letters of the name you want.
7.Press the left/right arrow until the name and number you want 

appears.

Deleting a Address Book for entry
1.Press (Fax) on the control panel.
2.Press Address Book on the control panel.
3.Press the left/right arrow until Delete appears and press OK.
4.Press the left/right arrow until the number category you want appears 

and press OK.
5.Press the left/right arrow until the searching method you want appears 

and press OK.
Select Search All to search for an entry by scanning through all 
entries in Address Book.
Select Search ID to search for an entry by the first few letters of the 
name.

6.Press the left/right arrow until the name you want appears and press 
OK.
Or, enter the first letters. Press the left/right arrow until the name you 
want appears and press OK.

7.Press OK when Yes appears to confirm the deletion.
8.Press Stop/Clear to return to ready mode.

Printing Address Book
You can check your Address Book settings by printing a list.

1.Press (Fax) on the control panel.
2.Press Address Book on the control panel.
3.Press the left/right arrow until Print appears and press OK.

The machine begins printing.

Printing sent fax report automatically
You can set the machine to print a report with detailed information about the 
previous 50 communication operations, including time and dates.

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Setup appears and press OK.
4. Press the left/right arrow until Auto Report appears and press OK.
5. Press the left/right arrow until On appears and press OK.
6. Press Stop/Clear to return to ready mode.
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1.using usb memory device 
(clx-3185n/clx-3185fn/clx-3185wk/clx-3185f
w only)
This chapter explains how to use a USB memory device with your machine.
This chapter includes:
• About USB memory
• Plugging in a USB memory device
• Scanning to a USB memory device

• Printing from a USB memory device
• Backing up data
• Managing USB memory

  

About USB memory
USB memory devices are available with a variety of memory capacities to 
give you more room for storing documents, presentations, downloaded 
music and videos, high resolution photographs or whatever other files you 
want to store or move.
You can do the following on your machine using a USB memory device.
• Scan documents and save them on a USB memory device
• Print data stored on a USB memory device
• Restore backup files to the machine’s memory
• Format the USB memory device
• Check the available memory space

Plugging in a USB memory device
The USB memory port on the front of your machine is designed for USB 
V1.1 and USB V2.0 memory devices. Your machine supports USB memory 
devices with FAT16/FAT32 and sector size of 512 bytes.
Check your USB memory device’s file system from your dealer.
You must use only an authorized USB memory device with an A plug type 
connector.

Use only a metal-shielded USB memory device.

Only use a USB memory device that has obtained compatibility certification; 
otherwise, the machine might not recognize it.
Insert a USB memory device into the USB memory port on the front of your 
machine.

 

•Do not remove the USB memory device while the machine is in 
operation or writing to or reading from USB memory. The machine 
warranty does not cover damage caused by user’s misuse. 

•If your USB memory device has certain features such as security 
settings and password settings, your machine may not 
automatically detect it. For details about these features, see the 
user’s guide of the USB memory device.

Scanning to a USB memory device

 

Illustrations on this user’s guide may differ from your machine 
depending on its options or models. Check your model name.

You can scan a document and save the scanned image onto a USB 
memory device. There are two ways of doing this: you can scan to the 
device using the default settings or you can customize your own scan 
settings.

Scanning
1. Insert a USB memory device into the USB memory port on your 

machine.
2. Place a single original face down on the scanner glass.

For details about loading an original, see "Loading originals" on page 1.

3. Press (Scan) on the control panel.
4. Press OK when Scan to USB appears on the bottom line of the display.

Press Color Start or Black Start when Ready to Scan appears.
Regardless of the button you press, the color mode is decided as 
customized (See “"Customizing Scan to USB" on page 2).

A B
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Your machine begins scanning the original, and then asks if you want to 
scan another page.

5. Press OK when Yes appears to scan more pages. Load another original 
to be scanned and press Color Start or Black Start.
Regardless of the button you press, the color mode is decided as 
customized (See “"Customizing Scan to USB" on page 2).
Otherwise, press the left/right arrow to select No and press OK.

After scanning is complete, you can remove the USB memory device from 
the machine.

Customizing Scan to USB 
You can specify image size, file format, or color mode for each scanning to 
USB job.

1. Press (Scan) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Scan Feature appears and press OK.
4. Press OK when USB Feature appears.
5. Press the left/right arrow until the setting option you want appears and 

press OK.
You can set the following options.
•Scan Size: Sets the image size.
•Original Type: Sets the original document’s type.
•Resolution: Sets the image resolution.
•Scan Color: Sets the color mode. If you select Mono in this option, you 

cannot select JPEG in Scan Format.
•Scan Format: Sets the file format in which the image is to be saved. 

When you select TIFF or PDF, you can select to scan multiple 
pages. If you select JPEG in this option, you cannot select Mono in 
Scan Color.

6. Press the left/right arrow until the desired status appears and press OK.
7. Repeat steps 4 and 5 to set other setting options.
8. When you have finished, press Stop/Clear to return to ready mode.
You can change the default scan settings. For details, see "Changing the 
default scan settings" on page 3.

Printing from a USB memory device
You can directly print files stored on a USB memory device. You can print 
TIFF, BMP, JPEG and PRN files.
File types supported by Direct Print option
• PRN: Only files created by provided driver with your machine are 

compatible. 
• PRN files can be created by selecting the Print to file check box when 

you print a document. The document will be saved as a PRN file, rather 
than printed on paper. Only PRN files created in this fashion can be 
printed directly from USB memory. See "Printing to a file (PRN)" on 
page 6 to learn how to create a PRN file.

• BMP: BMP Uncompressed
• TIFF: TIFF 6.0 Baseline
• JPEG: JPEG Baseline

To print a document from a USB memory device
1. Insert a USB memory device into the USB memory port on your 

machine, and then press Direct USB. If one has already been inserted, 
press Direct USB.

2. Press OK when USB print appears.

Your machine automatically detects the device and reads data stored on 
it.

3. Press the left/right arrow until the folder or file you want appears and 
press OK.
If you see [D] in the front of a folder name, there are one or more files or 
folders in the selected folder.

4. If you selected a file, skip to the next step.
If you selected a folder, press the left/right arrow until the file you want 
appears.

5. Press the left/right arrow to select the number of copies to be printed or 
enter the number.

6. Press OK, Color Start or Black Start to start printing the selected file. 
There are two types of mode as following.
• OK or Color Start: Color print
• Black Start: Black and White print
After printing the file, the display asks if you want to print another job.

7. Press OK when Yes appears to print another job, and repeat from step 
2. 
Otherwise, press the left/right arrow to select No and press OK.

8. Press Stop/Clear to return to ready mode.

Backing up data 
Data in the machine’s memory can be accidentally erased due to power 
failure or storage failure. Backup helps you protect the system settings by 
storing them as backup files on a USB memory device.

Backing up data
1. Insert the USB memory device into the USB memory port on your 

machine.
2. Press Menu on the control panel.
3. Press the left/right arrow until System Setup appears and press OK.
4. Press OK when Machine Setup appears.
5. Press the left/right arrow until Export Setting appears and press OK. 
6. Press the left/right arrow until the option you want appears.

For CLX-3185N/3185WK, Setup Data option is only available.
For CLX-3185FN/3185FW, Setup Data and Address Book options are 
available.

7. Press OK to begin backing up the data.
The data is backed up to the USB memory.
Press Stop/Clear to return to ready mode.

Restoring data
1. Insert the USB memory device on which the backup data is stored in to 

the USB memory port.
2. Press Menu on the control panel.
3. Press the left/right arrow until System Setup appears and press OK.
4. Press OK when Machine Setup appears.
5. Press the left/right arrow until Import Setting appears and press OK. 
6. Press the left/right arrow until the data type you want appears and press 

OK.
For CLX-3185N, Setup Data option is only available.
For CLX-3185FN/3185FW, Setup Data and Address Book options are 
available.

7. Press the left/right arrow until the file containing the data you want to 
restore appears and press OK.
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8. Press OK when Yes appears to restore the backup file to the machine.
9. Press Stop/Clear to return to ready mode.

Managing USB memory
You can delete image files stored on a USB memory device one by one or 
all at once by reformatting the device.

 

After deleting files or reformatting a USB memory device, files cannot 
be restored. Therefore, confirm that you no longer need the data 
before deleting it.

Deleting an image file
1. Insert the USB memory device into the USB memory port on your 

machine.
2. Press Direct USB.
3. Press the left/right arrow until File Manage appears and press OK.
4. Press OK when Delete appears. 
5. Press the left/right arrow until the folder or file you want to delete 

appears and press OK.

 

If you see [D] in the front of a folder name, there are one or more 
files or folders in the selected folder.

If you selected a file, the display shows the size of the file for about 
2 seconds. Go to the next step.
If you selected a folder, press the left/right arrow until the file you want to 
delete appears and press OK.

6. Press OK when Yes appears to confirm your selection.
7. Press Stop/Clear to return to ready mode.

Formatting a USB memory device
1. Insert the USB memory device into the USB memory port on your 

machine.
2. Press Direct USB.
3. Press the left/right arrow until File Manage appears and press OK.
4. Press the left/right arrow until Format appears and press OK.
5. Press OK when Yes appears to confirm your selection.
6. Press Stop/Clear to return to ready mode.

Viewing the USB memory status
You can check the amount of memory space available for scanning and 
saving documents.
1. Insert the USB memory device into the USB memory port on your 

machine.
2. Press Direct USB.
3. Press the left/right arrow until Check Space appears and press OK.
4. The available memory space appears on the display.

Press Stop/Clear to return to ready mode.
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1.machine status and advanced feature
This chapter explains how to browse the current status of your machine, and the method of setting for the advanced 
machine setup. Read this chapter carefully in order to use your machine's diverse features.
This chapter includes:
• Fax setup (CLX-3185FN/CLX-3185FW only)
• Copy setup
• Printing a report

• Clearing memory
• Network (CLX-3185N/CLX-3185WK/CLX-3185FN/CLX-3185FW only)
• Menu overview

  

 

Some menus may not appear on the display depending on options or 
models. If so, it is not applicable to your machine.

Fax setup (CLX-3185FN/CLX-3185FW only)
Changing the fax setup options
Your machine provides you with various user-selectable options for setting 
up the fax system. You can change the default settings for your preferences 
and needs.
To change the fax setup options:

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Setup appears and press OK.
4. Press the left/right arrow until the fax setup item you want appears and 

press OK.
5. Press the left/right arrow until the option you want appears and press 

OK.
6. Press the left/right arrow until the desired status appears or enter the 

value for the option you have selected, and press OK.
7. Repeat steps 4 through 6 if necessary.
8. Press Stop/Clear to return to ready mode.

Sending Receiving
Option Description

Redial Times You can specify the number of redial attempts. If 
you enter 0, the machine will not redial.

Redial Term Your machine can automatically redial a remote 
fax machine if it was busy. You can set an 
interval between attempts.

Prefix Dial You can set a prefix of up to five digits. This 
number dials before any automatic dial number 
is started. It is useful for accessing a PABX 
exchange.

ECM Mode This mode helps with poor line quality and 
makes sure any faxes you send are sent 
smoothly to any other ECM-equipped fax 
machine. Sending a fax using ECM may take 
more time.

Send Report You can set your machine to print a confirmation 
report showing whether a transmission was 
successful, how many pages were sent, and 
more. The available options are On, Off, and 
On-Error, which prints only when a transmission 
is not successful.

Image TCR This function allows users to know what fax 
messages have been sent by showing sent 
messages in the transmission report. 
The first page of the message is turned into an 
image file that is printed on the transmission 
report so the users can see what messages 
have been sent.
However, you can not use this function when 
sending fax without saving the data in the 
memory.

Option Description

Receive Mode You can select the default fax receiving mode. 
For details on receiving faxes in each mode, see 
"Changing the receive modes" on page 4.

Ring To Answer You can specify the number of times the 
machine rings before answering an incoming 
call.

Stamp RCV Name This option allows the machine to automatically 
print the page number, and the date and time of 
reception at the bottom of each page of a 
received fax.

RCV Start Code This code allows you to initiate fax reception 
from an extension phone plugged into the EXT 
socket on the back of the machine. If you pick up 
the extension phone and hear fax tones, enter 
the code. It is preset to *9* at the factory.

Option Description
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Change Default

Auto Report
You can set the machine to print a report with detailed information about the 
previous 50 communication operations including time and dates.
For further details, see "Printing sent fax report automatically" on page 8.

Copy setup
Changing the copy setup options
For copy output, you can set up several options in advance.
1. Depending on the model, the operating procedure may differ.

•For CLX-3185, CLX-3185N and CLX-3185WK, press Menu on the 
control panel.

•For CLX-3185FN and CLX-3185FW, press (Copy) and Menu in 
order on the control panel.

2. Press the left/right arrow until Copy Setup appears and press OK.
3. Press the left/right arrow until Change Default appears and press OK.
4. Press the left/right arrow until the copy setup item you want appears and 

press OK.
5. Press the left/right arrow until the setup option you want appears and 

press OK.
6. Press the left/right arrow until the setting you want appears and press 

OK.

Auto Reduction When receiving a fax containing pages as long 
as or longer than the paper loaded in the paper 
tray, the machine can reduce the size of the 
original to fit the size of the paper loaded in the 
machine. 
Turn on this feature if you want to automatically 
reduce an incoming page.
With this feature set to Off, the machine cannot 
reduce the original to fit onto one page. The 
original will be divided and printed in actual size 
on two or more pages.

Discard Size When receiving a fax containing pages as long 
as or longer than the paper in your machine, you 
can set the machine to discard a specific length 
from the end of the received fax. The machine 
will print the received fax on one or more sheets 
of paper, minus the data that would have been 
on the specified discard segment. 
When the received fax contains pages larger 
than the paper in your machine, and Auto 
Reduction has been turned on, the machine will 
reduce the fax to fit on the existing paper, and 
nothing will be discarded.

Junk Fax Setup This setting may not be available depending on 
your country. Using this feature, the system will 
not accept faxes sent from remote stations 
whose numbers are stored in the memory as 
junk fax numbers. This feature is useful for 
blocking any unwanted faxes.
When you turn on this feature, you can access 
the following options to set junk fax numbers.
• Add: Allows you to set up to 10 fax numbers.
• Delete: Allows you to delete the desired junk 

fax number. If you select Delete All, it allows 
you to delete all junk fax numbers.

DRPD Mode This mode enables a user to use a single 
telephone line to answer several different 
telephone numbers. In this menu, you can set 
the machine to recognize which ring patterns to 
answer. For details about this feature, see 
"Receiving faxes using DRPD mode" on page 4.

Option Description

Option Description

Resolution Changing the resolution setting affects the 
appearance of the received document.
• Standard: Originals with normal sized 

characters.
• Fine: Originals containing small characters 

or thin lines or originals printed using a 
dot-matrix printer.

• Super Fine: Originals containing extremely 
fine detail. Super Fine mode is enabled only 
if the machine with which you are 
communicating also supports the Super 
Fine resolution.

 

•For memory transmission, Super Fine 
mode is not available. The 
resolution setting is automatically 
changed to Fine.

•When your machine is set to Super 
Fine resolution and the fax 
machine with which you are 
communicating does not support 
Super Fine resolution, the machine 
transmits using the highest 
resolution mode supported by the 
other fax machine.

• Photo Fax: Originals containing shades of 
gray or photographs.

Darkness You can select the default contrast mode to fax 
your originals lighter or darker.

Scan Size You can select the size of original.
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7. Repeat steps 4 through 6, as needed.
8. Press Stop/Clear to return to ready mode.

Change Default

Printing a report
You can print a report on the machine's configuration or font list, etc.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Report appears and press OK.
4. Press the left/right arrow until the report or list you want to print appears 

and press OK.
To print all reports and lists, select All Report.

5. Press OK when Yes appears to confirm printing.
The selected information prints out.

 

You can also print the machine's status information and browse status 
with SyncThru™ Web Service. Open the Web browser on your 
network-connected computer and type the IP address of your 
machine. When SyncThru™ Web Service opens, click Information > 
Print information.

Clearing memory
You can selectively clear information stored in your machine’s memory.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Clear Setting appears and press OK.
4. Press the left/right arrow until the item you want to clear appears and 

press OK.
5. Press OK when Yes appears to confirm clearing.
6. Repeat steps 4 through 5 to clear another item.
7. Press Stop/Clear to return to ready mode.

 

Some menus may not appear on the display depending on options or 
models. If so, it is not applicable to your machine.

Option Description

Scan Size You can select the size of original.

Copies You can enter the number of copies using the 
number keypad.

Copy Collation You can set the machine to sort the copy job. 
For further details, see "Deciding the form of 
copy output" on page 3.

Reduce/Enlarge You can reduce or enlarge the size of a copied 
image.

Darkness You can adjust the brightness level to make a 
copy that is easier to read, when the original 
contains faint markings and dark images.

Original Type You can improve the copy quality by selecting 
the document type for the current copy job.

Eco Copy You can cut toner consumption and paper usage 
by using this option.

Option Description

All Report You can print reports and lists about all options.

Configuration This list shows the status of the user-selectable 
options. You may print this list to confirm your 
changes after changing settings.

Supplies Info This list shows the current status of 
consumables in your machine.

Address Book This list shows all of the fax numbers currently 
stored in the machine’s memory.

Send Report This report shows the fax number, the number of 
pages, the elapsed time of the job, the 
communication mode, and the communication 
results for a particular fax job.
You can set up your machine to automatically 
print a transmission confirmation report after 
each fax job (See "Sending" on page 1).

Sent Report This report shows information on the faxes you 
have recently sent.
You can set the machine to automatically print 
this report every 50 communications (See 
"Sending" on page 1).

Fax RCV Report This report shows information on the faxes you 
have recently received. 

Schedule Jobs This list shows the documents currently stored 
for delayed faxes along with the starting time 
and type of each operation. 

JunkFax Report This list shows the fax numbers specified as junk 
fax numbers. To add or delete numbers to or 
from this list, access the Junk Fax Setup menu 
(See "Receiving" on page 1).

Network Info. This list shows information on your machine’s 
network connection and configuration.

User Auth List This list shows authorized users, who are 
allowed to use the email function.

PCL Font List This list shows all the PCL fonts currently 
available to your machine.

Fax Option This list shows the status of the user-selectable 
options for fax. You may print this list to confirm 
your changes after changing fax settings.

Option Description

All settings Clears all of the data stored in memory and 
resets all of your settings to the factory default.

Fax Setup Restores all of the fax options to the factory 
default.

Copy Setup Restores all of the copy options to the factory 
default.

Option Description
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Network 
(CLX-3185N/CLX-3185WK/CLX-3185FN/CLX-3185
FW only)
You may set up the network with the machine's display screen. Before doing 
that, you must have the relevant information concerning the type of network 
protocols and computer system you use. If you are not sure which setting to 
use, contact your network administrator to configure this machine to the 
network.
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appears and press OK.
3. Press the left/right arrow until the setup option you want appears and 

press OK.
4. Press the left/right arrow until the setting you want appears and press 

OK.
5. Repeat steps 3 through 4, as needed.
6. Press Stop/Clear to return to ready mode.

Menu overview
The control panel provides access to various menus to set up the machine 
or use the machine’s functions. These menus can be accessed by pressing 
Menu.

 

Some menus may not appear on the display depending on options or 
models. If so, it is not applicable to your machine. 

Scan Setup Restores all of the scan options to the factory 
default.

System Setup Restores all of the system options to the factory 
default.

Network Setup Restores all of the network options to the factory 
default.

Address Book Clears all of the fax numbers entries stored in 
memory.

Sent Report Clears all records of sent faxes. 

Fax RCV Report Clears all records of received faxes.

Option Description

TCP/IP Select appropriate protocol and configure 
parameters to use the network environment.

 

There are lots of parameters to be set. If 
you are not sure, leave as is, or consult the 
network administrator.

TCP/IP (IPv6) Selects this option to use the network 
environment through IPv6 (See "IPv6 
Configuration" on page 6).

Ethernet Speed Configure the network transmission speed.

Wireless Selects this option to use the wireless network 
(See "Wireless network setup 
(CLX-3185FW/CLX-3185WK only)" on page 1).

Clear Setting Reverts the network settings to the default 
values.

Network Info. This list shows information on your machine’s 
network connection and configuration.

Option Description

Items Option

Fax Featureb Darkness
Resolution
Scan Size
Multi Send
Delay Send
Priority Send
Forward
Secure Receive
Add Page
Cancel Job

Fax Setupb Sending
Redial Times
Redial Term
Prefix Dial
ECM Mode
Send Report
Image TCR

Receiving
Receive Mode
Ring To Answer
Stamp RCV Name
RCV Start Code
Auto Reduction
Discard Size
Junk Fax Setup
DRPD Mode

Change Default
Resolution
Darkness
Scan Size

Auto Report

Copy Feature Scan Size
Reduce/Enlarge
Darkness
Original Type
Layout
Adjust Bkgd.
Gray Enhance
Eco Copy
Machine status and advanced feature_ 4



Copy Setup Change Default
Scan Size
Copies
Copy Collation
Reduce/Enlarge
Darkness
Original Type
Eco Copya

Scan Feature USB Feature
Scan Size
Original Type
Resolution
Scan Color
Scan Format

E-mail Feature
Scan Size
Original Type
Resolution
Scan Color

Scan Setup Change Default
USB Default
E-mail Default

Items Option

System Setup Machine Setup
Machine ID
Machine Fax Nob

Date & Timeb

Clock Modeb

Language
Default Mode
Power Save
Timeout
Altitude Adj.
Auto Continue
Import Setting
Export Setting

Paper Setup
Paper Size
Paper Type

Sound/Volume
Key Sound
Alarm Sound
Speakerb

Ringerb

Report
All Report
Configuration
Supplies Info
Address Bookb

Send Reportb

Sent Reportb

Fax RCV Reportb

Schedule Jobsb

JunkFax Reportb

Network Info.c

User Auth Listc

PCL Font List
Fax Optionb

Maintenance
Supplies Life
Color
Serial Number

Clear Setting
All Settings
Fax Setupb

Copy Setup
Scan Setup
System Setup
Network Setupc

Address Bookb

Sent Reportb

Fax RCV Reportb

Items Option
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Networkc TCP/IP
DHCP
BOOTP
Static

TCP/IP (IPv6)
IPv6 Activate
DHCPv6 Config

Ethernet Speed
Auto
10M Half
10M Full
100M Half
100M Full

Wirelessd

WPS Setting
WLAN Setting
WLAN Default
WLAN Signal

Clear Setting
Network Info.

a.CLX-3185/CLX-3185N/CLX-3185FN only
b.CLX-3185FN/CLX-3185FW only
c. CLX-3185N/CLX-3185FN/CLX-3185FW/CLX-3185WK only
d.CLX-3185WK/CLX-3185FW only

Items Option
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1.management tools
This chapter introduces management tools provided to help you make full use of your machine. 
This chapter includes:
• Introducing useful management tools
• Using SyncThru™ Web Service 

(CLX-3185N/CLX-3185WK/CLX-3185FN/CLX-3185FW only)

• Using the Smart Panel program
• SmarThru
• Using the Linux Unified Driver Configurator

  

 

Supported optional devices and features may differ according to your 
model. Check your model name. 
(See "Features by Models" on page 2).

Introducing useful management tools
The programs below help you to use your machine conveniently.
• "Using SyncThru™ Web Service 

(CLX-3185N/CLX-3185WK/CLX-3185FN/CLX-3185FW only)" on 
page 1.

• "Using the Smart Panel program" on page 2.
• "SmarThru" on page 3.
• "Using the Linux Unified Driver Configurator" on page 3.

Using SyncThru™ Web Service 
(CLX-3185N/CLX-3185WK/CLX-3185FN/CLX-3185
FW only)

 

Internet Explorer 6.0 or higher is the minimum requirement for 
SyncThru™ Web Service.

If you have connected your machine to a network and set up TCP/IP 
network parameters correctly, you can manage the machine via SyncThru™ 
Web Service, an embedded web server. Use SyncThru™ Web Service to:
• View the machine’s device information and check its current status.
• Change TCP/IP parameters and set up other network parameters.
• Change printer preference.
• Set the email notifications advising of the machine’s status.
• Get support for using the machine.

To access SyncThru™ Web Service
1. Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.

Logging into SyncThru™ Web Service
Before configuring options in SyncThru™ Web Service, you need to 
log-in as an administrator. You can still use SyncThru™ Web Service 
without logging in but you won’t have access to Settings tab and 
Security tab. 
1.Click Login on the upper right of the SyncThru™ Web Service 

website.
A log-in page appears. 

2.Type in the ID and Password then click Login.

If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000

SyncThru™ Web Service overview

 

Some tabs may not appear depending on your model.

Information tab
This tab gives you general information about your machine. You can 
check things, such as remaining amount of toner. You can also print 
reports such as an error report and so on. 
•Active Alerts: This item allows you to check the alerts occurred in the 

machine and their severity.
•Supplies: This item allows you to check how many pages are printed 

and amount of toner left in the cartridge.
•Usage Counters: This item allows you to check the usage count by 

print types: simplex, duplex.

•Current Settings: This item allows you to check the machine and 
network information. 

•Print information: This item allows you to print reports such as 
system related reports, e-mail address and font reports.

Settings tab
This tab allows you to set configurations provided by your machine and 
network. You need to log-in as an administrator to view this tab. 
•Machine Settings tab: This tab allows you to set options provided by 

your machine. 
-System: You can set settings related to your machine.
-Printer: You can set settings related to printing jobs. 
-E-mail Notification: You can set e-mail notification feature and 

e-mail address of recipients who will receive the notification.
•Network Settings tab: This tab allows you to view and change the 

network environment. You can set things, such as TCP/IP, network 
protocols and so on. 
-SNMP: You can exchange of management information between 

network devices using SNMP.

-Outgoing Mail Server(SMTP): You can set the outgoing e-mail 
server.

-Restore Default: You can restore default network settings.

Security tab
This tab allows you to set system and network security information. You 
need to log-in as an administrator to view this tab.
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•System Security: You can set the system administrator’s information 
and also enable or disable machine features.

•Network Security: You can set settings for HTTPs, IPSec, IPv4/IPv6 
filtering, 802.1x, Authentication servers.

Maintenance tab
This tab allows you to maintain your machine by upgrading firmware and 
setting contact information for sending emails. You can also connect to 
Samsung website or download drivers by selecting the Link menu.
•Firmware Upgrade: You can upgrade your machine’s firmware.
•Contact Information: You can view the contact information.
•Link: You can view the links to useful sites where you can download or 

check information.

E-mail notification setup
You can receive emails about your machine’s status by setting this option. 
By setting information such as IP address, host name, e-mail address and 
SMTP server information, the machine status (toner cartridge shortage or 
machine error) will be sent to a certain person's e-mail automatically. This 
option may be used more frequently by a machine administrator. 
1. Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.
3. From the Settings tab, select Machine Settings > E-mail Notification. 

 

If you have not configured outgoing server environment, go to 
Settings > Network Settings > Outgoing Mail Server(SMTP) to 
configure network environment before setting e-mail notification. 

4. Select Enable check box to use the E-mail Notification.
5. Click Add button to add e-mail notification user. 

Set the recipient name and e-mail address(es) with notification items 
you want to receive an alert for.

6. Click Apply.

 

If the firewall is activated, the e-mail may not be sent successfully. In 
that case, contact the a network administrator.

Setting the system administrator information
Set the system administrator information. This setting is necessary for using 
the e-mail notification option.
1. Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.
3. From the Security tab, select System Security > System 

Administrator
4. Enter the name of the administrator, phone number, location and E-mail 

address. 
5. Click Apply. 

Using the Smart Panel program
The Smart Panel is a program that monitors and informs you of the machine 
status, and allows you to customize the machine’s settings. For Windows 
and Macintosh, Smart Panel is installed automatically when you install the 
machine software. For Linux, you can download Smart Panel from the 
Samsung website and install (See "Installing the SmartPanel" on page 5).

 

To use this program, your computer has to meet the following system 
requirements:
•Windows. Check that your computer’s CPU, RAM and HDD meet or 

exceed specification (See "System requirements" on page 2).
•Mac OS X 10.3 or higher. Check that your computer’s CPU, RAM and 

HDD meet or exceed specification (See "System requirements" on 
page 2).

•Linux. Check that your computer’s CPU, RAM and HDD meet or 
exceed specification (See "System requirements" on page 2).

•Internet Explorer version 5.0 or higher for flash animation in HTML 
Help.

If you need to know the exact model name of your machine, you can 
check the supplied software CD.

Understanding Smart Panel
If an error occurs while operating, you can check the error from the Smart 
Panel.
You can also launch Smart Panel manually. Double-click the Smart Panel 
icon on the Windows task bar (in Windows), or Notification Area (in Linux).

Or, if you are a Windows user, you can launch it from the Start menu, select 
Programs or All Programs > Samsung Printers > your printer driver 
name > Smart Panel.

 

•If you have already installed more than one Samsung machine, first 
select the correct machine model you want in order to access the 
corresponding Smart Panel.
Right-click (in Windows or Linux) the Smart Panel icon and select 
your machine.

•The Smart Panel window and its contents shown in this user’s guide 
may differ depending on the machine or operating system in use.

In case of Mac OS 10.3
1. Click System Preferences > Print & Fax
2. Click Set up Printers....
3. Select printer in list and double click it.
4. Click Utility.
In case of Mac OS 10.4
1. Click System Preferences > Print & Fax
2. Select printer in list and click Printer Queue....
3. Click Utility.
In case of Mac OS 10.5
1. Click System Preferences > Print & Fax
2. Select printer in list and click Open Printer Queue....
3. Click Utility.
In case of Mac OS 10.6
1. Click System Preferences > Print & Fax
2. Select printer in list and click Open Printer Queue....

Windows Double-click this icon in Windows.

Linux Click this icon in Linux.
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3. Click Printer Setup > Utility tab > Open Printer Utility.
The Smart Panel program displays the current status of the machine, the 
estimated level of toner remaining in each toner cartridge, and various other 
types of information. You can also change settings.

Changing the Smart Panel Program Settings
Right-click (in Windows or Linux) the Smart Panel icon and select Options. 
Select the settings you want from the Options window.

SmarThru
The supplied software CD provides you with SmarThru. SmarThru offers 
you convenient features to use with your machine. 

Starting SmarThru
Follow the steps below to start SmarThru.
1. Make sure that your machine and computer are turned on and properly 

connected to each other.
2. Once you have installed SmarThru, you will see the SmarThru icon on 

your desktop.
3. Double-click the SmarThru icon.

4. The SmarThru appears.

•Scan to: Allows you to scan an image and save it to an application or 
folder, email it, or publish it on a website.

•Image: Allows you to edit an image you have saved as a graphic file 
and send it to a selected application or folder, email it, or publish it on 
a website.

•Print: Allows you to print images you have saved. You can print images 
in black and white or color mode if your machine supports it.

For more information about SmarThru, click  at the top right corner 
of the window. The SmarThru help window appears; you can see it 
supplied on the SmarThru program.

 

Follow the steps below to uninstall SmarThru. Before you begin the 
uninstall, ensure that all applications are closed on your computer. 
a)From the Start menu, select Programs or All Programs.
b)Select Samsung Printers > SmarThru 4 > Uninstall SmarThru 4.
c)When your computer asks you to confirm your selection, read the 

statement and click OK. 
d)Click Finish.

Using the Linux Unified Driver Configurator
The Unified Driver Configurator is a tool primarily intended for configuring 
machine devices. You need to install Unified Linux Driver to use Unified 
Driver Configurator (See "Installing the Unified Linux Driver" on page 4).
After the driver is installed on your Linux system, the Unified Driver 
Configurator icon will automatically be created on your desktop.

Opening the Unified Driver Configurator
1. Double-click the Unified Driver Configurator on the desktop.

You can also click the Startup Menu icon and select Samsung Unified 
Driver > Unified Driver Configurator.

2. Click each button on the left to switch to the corresponding configuration 
window.

 

1

Toner Level You can view the level of toner remaining in each 
toner cartridge. The machine and the number of 
toner cartridge(s) shown in the above window may 
differ depending on the machine in use. Some 
machines do not have this feature.

 

2
Buy Now You can order replacement toner cartridge(s) from 

online.

 

3

User’s Guide You can view the online User’s Guide.

 

This button changes to Troubleshooting 
Guide when error occurs. You can directly 
open the troubleshooting section in the 
user’s guide. 

 

4

Printer 
Setting

You can configure various machine settings in the 
Printer Settings Utility window. Some machines do 
not have this feature.

 

If you connect your machine to a network, 
the SyncThru™ Web Service window 
appears instead of the Printer Settings Utility 
window.

 

5

Driver Setting You can set all of the machine options you need in 
the Printing Preferences window. This feature is 
available only for Windows (See "Opening printing 
preferences" on page 2).

1

2

3

4

5
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 To use the on screen help, click Help.

3. After changing the configurations, click Exit to close the Unified Driver 
Configurator.

Printers configuration window
Printers configuration has the two tabs: Printers and Classes.

Printers tab
View the current system’s printer configuration by clicking on the 
machine icon button on the left side of the Unified Driver Configurator 
window.

The printer control buttons are as follows:
•Refresh: Renews the available machines list.
•Add Printer: Allows you to add a new machines.

•Remove Printer: Removes the selected machine.
•Set as Default: Sets the current selected machine as a default 

machine.
•Stop/Start: Stops/starts the machine.
•Test: Allows you to print a test page to ensure the machine is working 

properly.
•Properties: Allows you to view and change the printer properties.

Classes tab
The Classes tab shows a list of available machine classes.

•Refresh: Renews the classes list.
•Add Class: Allows you to add a new machine class.
•Remove Class: Removes the selected machine class.

1 Printers 
Configuration 

2 Scanners 
Configuration 

3 Ports 
Configuration 

 

1 Switches to Printers configuration.
 

2 Shows all of the installed machine.
 

3 Shows the status, model name and URL of your machine.

 

1 Shows all of the machine classes.

 

2
Shows the status of the class and the number of machines in the 
class.
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Scanners configuration
In this window, you can monitor the activity of scanner devices, view a list of 
installed Samsung machine devices, change device properties, and scan 
images.

• Properties: Allows you to change the scan properties and scan a 
document.

Ports configuration
In this window, you can view the list of available ports, check the status of 
each port, and release a port that is stalled in a busy state when its owner 
has terminated the job for any reason.

• Refresh: Renews the available ports list.
• Release port: Releases the selected port.

Sharing Ports Between Printers and Scanners
Your machine may be connected to a host computer via a parallel port 
or USB port. Since the machine device contains more than one device 
(printer and scanner), it is necessary to organize proper access of 
“consumer” applications to these devices via the single I/O port.
The Unified Linux Driver package provides an appropriate port sharing 
mechanism that is used by Samsung printer and scanner drivers. The 
drivers talk to their devices via so-called machine ports. The current 
status of any machine port can be viewed via the Ports configuration. 
The port sharing prevents you from accessing one functional block of 
the machine device, while another block is in use.
When you install a new machine device onto your system, it is strongly 
recommended you do this with the assistance of an Unified Driver 
Configurator. In this case you will be asked to choose I/O port for the 
new device. This choice will provide the most suitable configuration for 
machine’s functionality. For machine scanners, I/O ports are being 
chosen by scanner drivers automatically, so proper settings are applied 
by default.

 

1 Switches to Scanners configuration.
 

2 Shows all of the installed scanners.
 

3 Shows the vendor, model name and type of your scanner.

 

1 Switches to Ports configuration.
 

2 Shows all of the available ports.

 

3 Shows the port type, device connected to the port, and status.
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1.maintenance
This chapter provides information about maintaining your machine and the toner cartridge.
This chapter includes:
• Adjusting the color contrast
• Finding the serial number
• Cleaning the machine

• Storing the toner cartridge
• Maintenance parts
• Tips for moving & storing your machine

  

Adjusting the color contrast
Color menu allows you to adjust the color setting.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Maintenance appears and press OK.
4. Press the left/right arrow until Color appears and press OK.
5. Press the left/right arrow until Custom Color appears and press OK.
6. Press the left/right arrow until the color menu you want to appears on 

display and press OK.

 

You can adjust the contrast of each color independently. Default 
optimizes the color contrast automatically. Manual Adjust allows 
you to manually adjust the color contrast for each cartridge. 
Default setting is recommended for getting best color quality.

7. Press Stop/Clear to return to ready mode.

 

If you have moved the machine, it is strongly recommended to operate 
this menu manually.

Finding the serial number
When you call for service or register as a user on the Samsung website, the 
machine’s serial number by taking the following steps.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Maintenance appears and press OK.
4. Press the left/right arrow until Serial Number appears and press OK.
5. Check your machine’s serial number.
6. Press Stop/Clear to return to ready mode.

Cleaning the machine
If printing quality problems occur or if you use your machine in a dusty 
environment, you need to clean your machine regularly to keep the most 
optimum print quality.

 

•Cleaning the cabinet of the machine with cleaning materials 
containing large amounts of alcohol, solvent or other strong 
substances can discolor or distort the cabinet. 

•If your machine or the surrounding area is contaminated with toner, 
we recommend that you use a cloth or tissue dampened with water 
to clean it. If you use a vacuum cleaner, toner blows in the air and 
might be harmful if inhaled.

Cleaning the outside
Clean the machine cabinet with a soft and lint-free cloth. Dampen the cloth 
slightly with water, but be careful not to let any water drip onto or into the 
machine.

Cleaning the inside
During the printing process, paper, toner and dust particles can accumulate 
inside the machine. This buildup can cause print quality problems such as 
toner specks or smearing. Cleaning the inside of the machine clears and 
reduces these problems.
1. Turn the machine off and unplug the power cord. Wait for the machine to 

cool down.
2. Using the handle, completely open the front door.

3. Grasp the handles on the toner cartridge and pull to remove four 
cartridges from the machine.
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4. Pull the waste toner container out of the machine using the handle.

5. Pull the imaging unit out of the machine using the groove on the front of 
the imaging unit.

 

Do not touch the green surface of the drum located in the imaging 
unit. Use the handle on the cartridge to avoid touching this area.

6. With a dry and lint-free cloth, wipe away any dust and spilled toner from 
the toner cartridges area and their cavities.

 

•If toner gets on your clothing, wipe it off with a dry cloth and wash 
it in cold water. Hot water sets toner into fabric.

•If your machine or its surrounding is contaminated with toner, we 
recommend you use a cloth or tissue dampened with water to 
clean. If you use a vacuum cleaner, toner blows into the air 
then might be harmful if inhaled.

 

After cleaning, let the machine to dry completely.

7. Holding the groove on the front of the imaging unit, push imaging unit 
into the machine.

 

Do not touch the green surface of the drum located in the imaging 
unit. Use the handle on the cartridge to avoid touching this area.

8. Insert the waste toner container into position and then push it to make 
sure that it is firmly seated in place.

9. Slide four toner cartridges back into the machine.

10. Reinstall all the compartments into the machine and close the front door.

 

If the front door is not completely closed, the machine will not 
operate.

11. Plug in the power cord and turn the machine on.
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Cleaning the scan unit
Keeping the scan unit clean helps ensure the best possible copies. We 
suggest that you clean the scan unit at the start of each day and during the 
day as needed.

 

The procedure may differ depending on your model. Check your 
model name.

The following procedure is for CLX-3185, CLX-3185N and CLX-3185WK.
1. Slightly dampen a soft, lint-free cloth or paper towel with water.
2. Open the scanner lid.
3. Wipe the surface of the scanner glass until it is clean and dry.

4. Wipe the underside of the scanner lid and white sheet until it is clean 
and dry.

5. Close the scanner lid.
The following procedure is for CLX-3185FN and CLX-3185FW.
1. Slightly dampen a soft, lint-free cloth or paper towel with water.
2. Open the scanner lid.
3. Wipe the surface of the scanner glass until it is clean and dry.

4. Wipe the underside of the scanner lid and white sheet until it is clean 
and dry.

5. Push the ADF sheet with any tool such as tweezers carefully.

6. Hold the edge of the ADF sheet and wipe both sides of the ADF sheet 
until it is clean and dry.

7. Push the ADF sheet back into the machine smoothly.

8. Close the scanner lid.

1 Scanner lid
2 Scanner glass
3 ADF sheet
4 White sheet

4

3 1

2
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Storing the toner cartridge
Toner cartridges contain components that are sensitive to light, temperature 
and humidity. Samsung suggests users follow the recommendations to 
ensure the optimum performance, highest quality and longest life from your 
new Samsung toner cartridge.
Store this cartridge in the same environment in which the printer will be 
used. This should be in controlled office temperature and humidity 
conditions. The toner cartridge should remain in its original and unopened 
package until installation – If original packaging is not available, cover the 
top opening of the cartridge with paper and store in a dark cabinet.
Opening the cartridge package prior to use dramatically shortens its useful 
shelf and operating life. Do not store on the floor. If the toner cartridge is 
removed from the printer, follow the instruction below to store the toner 
cartridge properly.
• Store the cartridge inside the protective bag from the original package. 
• Store lying flat (not standing on end) with the same side facing up as if it 

was installed in the machine.
• Do not store consumable in any of the following conditions:

-Temperature greater than 40°C (104°F).
-Humidity range less than 20% and not greater than 80%.
-An environment with extreme changes in humidity or temperature.
-Direct sunlight or room light.
-Dusty places.
-A car for a long period of time.
-An environment where corrosive gases are present.
-An environment with salty air.

Handling instructions
• Do not touch the surface of the photoconductive drum in the cartridge.
• Do not expose the cartridge to unnecessary vibrations or shock.
• Never manually rotate the drum, especially in the reverse direction; this 

can cause internal damage and toner spillage.

Use of non-Samsung and refilled toner cartridge
Samsung Electronics does not recommend or approve the use of 
non-Samsung brand toner cartridges in your printer including generic, store 
brand, refilled or remanufactured toner cartridges.

 

Samsung’s printer warranty does not cover damage to the machine 
caused by the use of a refilled, remanufactured or non-Samsung 
brand toner cartridge.

Estimated cartridge life
Estimated cartridge life (the life of the toner cartridge yield) depends on the 
amount of toner that print jobs require. The actual print yield may vary 
depending on the print density of the pages you print on, operating 
environment, printing interval, media type and/or media size. For example, if 
you print a lot of graphics, the consumption of the toner is high and you may 
need to change the cartridge more often.

Maintenance parts
To avoid print quality and paper feed problems resulting from worn parts, 
and to maintain your machine in top working condition, the following items 
will need to be replaced after the specified number of pages, or when the life 
span of each item has expired.

We highly recommend that this maintenance be performed by an authorized 
service provider, dealer or the retailer where you bought the machine. The 
warranty does not cover the replacement of the maintenance parts after 
their lifespan.

 

The battery inside the machine is a service component. Do not 
change it by yourself.
There is risk of explosion if battery is replaced by an incorrect type. 
Dispose of used batteries according to your local environmental 
guidelines. Don’t puncture or incinerate the battery.

Checking replacables
If you experience frequent paper jams or printing problems, check the 
number of pages the machine has printed or scanned. Replace the 
corresponding parts, if necessary.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Maintenance appears and press OK.
4. Press the left/right arrow until Supplies Life appears and press OK.
5. Press the left/right arrow until the item you want appears and press OK.

•Supplies Info: Prints the supply information page.
•Total: Displays the total number of pages printed.
•ADF Scan: Displays the number of pages printed by using the ADF.
•Platen Scan: Displays the number of pages scanned by using scanner 

glass.
•Imaging Unit, Transfer Belt, Fuser, TransferRoller, Tray1 Roller: 

Displays the number of pages printed by each item.
6. If you selected to print a supply information page, press OK to confirm.
7. Press Stop/Clear to return to ready mode.

Tips for moving & storing your machine
• When moving the machine, do not tilt or turn it upside down. Otherwise, 

the inside of the machine may be contaminated by toner, which can 
cause damage to the machine or reduce print quality.

• When moving the machine, make sure at least two people are holding 
the machine securely. 

Items Yield (Average)

Fuser unit Approx. 50,000 black pages or 12,500 color pages

Transfer roller Approx. 50,000 black pages or 12,500 color pages

Transfer unit (ITB) Approx. 50,000 black pages or 12,500 color pages

Pick-up roller Approx. 50,000 pages
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1.troubleshooting
This chapter gives helpful information for what to do if you encounter an error.
This chapter includes:
• Redistributing toner
• Tips for avoiding paper jams
• Clearing original document jams (CLX-3185FN/CLX-3185FW only)

• Clearing paper jams
• Understanding display messages
• Solving other problems

  

Redistributing toner
When the toner cartridge is near the end of its life,
• White streaks or light printing occurs. 
• Prepare toner appears on the display.
• The Status LED blinks red. 
If this happens, you can temporarily improve print quality by redistributing 
the remaining toner in the cartridge. In some cases, white streaks or light 
printing will still occur even after you have redistributed the toner.
1. Using the handle, completely open the front door.

2. Grasp the handles on the toner cartridge and pull to remove the 
cartridge from the machine.

3. Thoroughly roll the cartridge five or six times to distribute the toner 
evenly inside the cartridge.

 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

 

Do not touch the green underside of the toner cartridge. Use the 
handle on the cartridge to avoid touching this area. 

4. Make sure that the color of the toner cartridge matches the color slot and 
then grasp the handles on the toner cartridge. Insert the cartridge until it 
clicks into place.

5. Close the front door. Make sure the door is securely latched.

 

If the front door is not completely closed, the machine will not operate.

Tips for avoiding paper jams
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, refer to the guidelines below: (See "Clearing 
paper jams" on page 2). 
• Ensure that the adjustable guides are positioned correctly (See "Loading 
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paper in the tray" on page 4).
• Do not overload the tray. Ensure that the paper level is below the paper 

capacity mark on the inside of the tray.
• Do not remove paper from the tray while your machine is printing.
• Flex, fan, and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media (See "Setting the paper size and 

type" on page 6).
• Ensure that the recommended side of the print media is facing up in the 

tray.

Clearing original document jams 
(CLX-3185FN/CLX-3185FW only)
When an original document jams in the document feeder, a warning 
message appears on the display.

 

To avoid tearing the document, remove the jammed document slowly 
and carefully.

 

To prevent document jams, use the scanner glass for thick, thin or 
mixed paper-type originals.

1. Remove any remaining pages from the document feeder.
2. Open the document feeder cover.

3. Gently remove the jammed paper from the document feeder.

 

If you see no paper in this area, go to step 5.

4. Close the document feeder cover. Reload the pages you removed, if 
any, in the document feeder.

5. Open the scanner lid.
6. Seize the misfeed paper, and remove the paper from the feed area by 

carefully pulling it to the right using both hands.

7. Close the scanner lid. Load the removed pages back into the document 
feeder.

Clearing paper jams
When a paper jam occurs, the warning message appears on the display 
screen. Refer to the table below to locate and clear the paper jam.

1 scanner lid

Message Location of Jam Go to

Paper jam
in Tray 1

In the paper feed area 
and inside the machine

See "In the tray" on 
page 3.

Paper jam
inside machine

Inside the machine See "In the fuser unit 
area" on page 3.

Paper jam
in exit area

Inside the machine and in 
the paper exit area

See "In the paper exit 
area" on page 4.

1
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Some messages may not appear on the display depending on options 
or models.

 

To avoid tearing the paper, pull the jammed paper out slowly and 
carefully. Follow the instructions in the following sections to clear the 
jam. 

In the tray

 

Click this link to open an animation about clearing a jam.

1. Open and close the front door. The jammed paper is automatically 
ejected from the machine.
If the paper does not eject, go to the next step.

2. Pull out tray 1 out of the machine.

3. Remove the jammed paper by gently pulling it straight out.

If the paper does not eject when you pull, or if you do not see the paper 
in this area, check the fuser area around the toner cartridge (See "In the 
fuser unit area" on page 3).

4. Insert the tray 1 back into the machine until it snaps into place. Printing 
automatically resumes.

In the fuser unit area

 

Click this link to open an animation about clearing a jam.

If paper is jammed in the fuser unit area, follow the next steps to release the 
jammed paper.

1. Open the scan unit first and then inner cover.

 

Do not touch the fuser inside the inner cover. It is hot and could cause 
burns! Take care when removing paper from the machine.

1. Holding the inner cover open, carefully take the jammed paper out of the 
machine. The inner cover will then close automatically. Lower down the 
scan unit gently until it is completely closed. Make sure that it is securely 
latched. Printing automatically resumes.

 

Be careful not to pinch your fingers!

If you do not see the paper, lower down the scan unit gently until it is 
completely closed. Go to the next step.

2. To remove the jammed paper, open the rear door.

1

2
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3. Carefully remove the paper by pulling in the direction as shown below. 
Most of the jammed paper can be removed in this step.

4. Close the rear door. Printing automatically resumes.

In the paper exit area

 

Click this link to open an animation about clearing a jam.

1. Open and close the front door. The jammed paper is automatically 
ejected from the machine.

2. Gently pull the paper out the output tray.

If you do not see the jammed paper or if there is any resistance when 
you pull, stop and go to the next step.

3. Open the rear door.

4. If you see the jammed paper, pull it straight up. Skip to step 10.

If you do not see the paper or if there is any resistance when you pull, 
stop and go to the next step.

5. Pull up the fuser lever.

 

The fuser area is hot. Take care when removing paper from the 
machine.

6. Open the scan unit first and then inner cover.

1

2
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7. Carefully take the jammed paper out of the machine.

8. Lower down the scan unit gently and slowly until it completely closed. 
Make sure that it is securely latched.

 

Be careful no to pinch your fingers!

9. Pull down the fuser lever.

10. Close the rear door. Printing automatically resumes.

Understanding display messages
Messages appear on the control panel display to indicate the machine’s 
status or errors. Refer to the tables below to understand the messages’ and 
their meaning, and correct the problem, if necessary.

Checking display messages

 

•If a message is not in the table, reboot the power and try the printing 
job again. If the problem persists, call a service representative.

•When you call for service, provide the service representative with the 
contents of display message.

•Some messages may not appear on the display depending on the 
options or models.

•[error number] indicates the error number. 
•[tray type] indicates the tray number. 
•[media type] indicates the media type.
•[media size] indicates the media size.
•[color] indicates the color of toner or imaging unit.

Message Meaning Suggested solutions

[COMM. Error] The machine has a 
communication 
problem.

Ask the sender to try 
again.

[Incompatible] The machine has 
received a fax from 
which is registered as 
a junk fax.

The received fax data 
will be deleted. 
Reconfirm junk fax setup 
(See "Changing the fax 
setup options" on 
page 1).

[Line Busy] The receiving fax 
machine did not 
answer or the line is 
already engaged.

Try again after a few 
minutes.

[Line Error] Your machine cannot 
connect with the 
receiving fax machine 
or has lost contact 
because of a problem 
with the phone line.

Try again. If the problem 
persists, wait an hour or 
so for the line to clear 
and try again. Or, Turn 
the ECM mode on (See 
"Fax setup 
(CLX-3185FN/CLX-3185
FW only)" on page 1).

BOOTP problem 
Auto IP Run

The IP address 
assignment is failed. 
This happens when 
Auto IP for BOOTP is 
set in SyncThru Web 
Service.

Change the IP address 
assignment method to 
DHCP or Static. If you do 
not change this option, 
the BOOTP server 
continually asks to 
assign the IP address.

BOOTP problem 
Reconfigure DHCP

The IP address 
assignment is failed. 
This happens when 
Auto IP for BOOTP is 
not set in SyncThru 
Web Service.

Change the IP address 
assignment method to 
DHCP or Static. If you do 
not change this option, 
the BOOTP server 
continually asks to 
assign the IP address.
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DHCP problem: 
Auto IP Run

The IP address 
assignment is failed. 
This happens when 
Auto IP for DHCP is 
set in SyncThru Web 
Service.

Change the IP address 
assignment method to 
BOOTP or Static. If you 
do not change this 
option, the DHCP server 
continually asks to 
assign the IP address.

DHCP problem 
Reconfigure 
BOOTP

The IP address 
assignment is failed. 
This happens when 
Auto IP for DHCP is 
not set SyncThru Web 
Service.

Change the IP address 
assignment method to 
BOOTP or Static. If you 
do not change this 
option, the DHCP server 
continually asks to 
assign the IP address.

Document Jam. 
Remove Jam

The loaded original 
document has 
jammed in the ADF.

Clear the jam (See 
"Clearing original 
document jams 
(CLX-3185FN/CLX-3185
FW only)" on page 2).

Door Open
Close it

The front door is not 
securely latched.

Close the door until it 
locks into place.

Error [error number]
Call for service

A system error has 
occurred.

Turn the power button off 
and on. If the problem 
persists, call a service 
representative.

Error [error number]
Turn off then on

A system error has 
occurred.

Turn the power button off 
and on. If the problem 
persists, call a service 
representative.

Install Toner
▼

The toner cartridge is 
installed improperly or 
not installed.

Reinstall the toner 
cartridge two or three 
times to confirm it is 
seated properly. If the 
problem persists, the 
toner cartridge is not 
being detected. Contact 
the service 
representatives.

Memory Full 
Remove Job

The memory is full. Press the left/right arrow 
to highlight Cancel or 
Start, then press OK. If 
you select Cancel, the 
machine stops the fax 
job. If you select Start, 
the machine only sends 
scanned documents of 
the fax job.

Network Problem: 
IP Conflict

The IP address is 
used elsewhere.

Check the IP address or 
obtain a new IP address.

No Answer The receiving fax 
machine has not 
answered after 
several redial 
attempts.

Try again. Make sure 
that the receiving 
machine is operational.

Message Meaning Suggested solutions

Not Compatible
[color] toner

The toner cartridge is 
not suitable for your 
machine.

Install the corresponding 
toner cartridge with a 
Samsung-genuine 
cartridge (See 
"Replacing the toner 
cartridge" on page 2).

Not installed
Waste tank

The waste toner 
container is not 
installed.

Install the waste toner 
container.

Not original
[color] toner

The toner cartridge is 
not a 
Samsung-genuine 
toner cartridge.

Install the corresponding 
toner cartridge with a 
Samsung-genuine 
cartridge (See 
"Replacing the toner 
cartridge" on page 2).

Output bin full
Remove media

The output tray is full. 
Or the sensor is not 
facing down.

Remove papers from the 
output tray, the machine 
resumes printing.

Paper Empty
in Tray1

There is no paper in 
tray 1.

Load paper in tray 1 (See 
"Loading paper in the 
tray" on page 4).

Paper jam
in exit area

Paper has jammed in 
the paper exit area.

Clear the jam (See "In 
the paper exit area" on 
page 4).

Paper jam
in Tray 1

Paper has jammed in 
the Tray 1 area.

Clear the jam (See "In 
the tray" on page 3).

Paper jam
inside machine

Paper has jammed 
inside the machine.

Clear the jam (See "In 
the fuser unit area" on 
page 3).

Prepare IMG unit
▼

The estimated life of 
imaging unit is close.

Prepare a imaging unit 
for replacement (See 
"Available supplies" on 
page 1).

Prepare new 
Transfer belt

The estimated life of 
transfer unit (ITB) is 
close.

The estimated life of a 
transfer unit (ITB) is 
close (See "Available 
maintenance parts" on 
page 1).

Remove seal tape
& Install Toner

The machine cannot 
detect a toner 
cartridge.

Remove the sealing tape 
from the toner cartridge. 
Refer to the Quick 
Installation Guide.

Replace new 
Transfer belt

The transfer unit (ITB) 
has almost reached its 
estimated life.

Prepare the transfer unit 
(ITB) with a new one 
(See "Available 
maintenance parts" on 
page 1).

Replace new 
Transfer roller

The transfer roller has 
almost reached its 
estimated life.

Replace the transfer 
roller with a new one 
(See "Available 
maintenance parts" on 
page 1).

Message Meaning Suggested solutions
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Prepare toner
▼

Small amount of toner 
is left in the indicated 
cartridge. The 
estimated cartridge 
life of toner is close.

Prepare a new cartridge 
for a replacement. You 
may temporarily increase 
the printing quality by 
redistributing the toner 
(See "Redistributing 
toner" on page 1).

Replace
Fuser soon

The estimated life of 
fuser unit is close.

Prepare a fuser unit for 
replacement (See 
"Available maintenance 
parts" on page 1).

Message Meaning Suggested solutions

Replace Toner
▼

The indicated toner 
cartridge has almost 
reached its estimated 
cartridge life. The 
machine might stop 
printing.

 

Estimated 
cartridge life 
means the 
expected or 
estimated toner 
cartridge life, 
which indicates 
the average 
capacity of 
print-outs and is 
designed 
pursuant to 
ISO/IEC 19798.

• If Stop or Continue 
appears in the LCD 
display, choose one of 
them. If you select 
Stop, the machine 
stops printing and you 
cannot print anymore 
without changing the 
cartridge. If you select 
Continue, the 
machine keeps 
printing but the 
printing quality cannot 
be guaranteed.
Replace the toner 
cartridge for the best 
print quality when this 
message appears. 
Using a cartridge 
beyond this stage can 
result in printing 
quality issues (See 
"Replacing the toner 
cartridge" on page 2).

 

Samsung does not 
recommend using 
non-genuine 
Samsung toner 
cartridge such as 
refilled or 
remanufactured. 
Samsung cannot 
guarantee 
non-genuine 
Samsung toner 
cartridge's quality. 
Service or repair 
required as a result 
of using 
non-genuine 
Samsung toner 
cartridges will not be 
covered under the 
machine warranty.

• If the machine stops 
printing, replace the 
toner cartridge (See 
"Replacing the toner 
cartridge" on page 2).

Replace new
Fuser unit

The fuser unit has 
almost reached its 
estimated life.

Replace the fuser unit 
with a new one (See 
"Available maintenance 
parts" on page 1).

Replace IMG unit
▼

The imaging unit has 
almost reached its 
estimated life.

Replace the imaging unit 
with a new one (See 
"Replacing the imaging 
unit" on page 3).

Message Meaning Suggested solutions
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Solving other problems
The following chart lists some trouble conditions that may occur and the 
recommended solutions. Follow the suggested solutions until the problem is 
corrected. If the problem persists, contact a service representative.
Other problems include:
• See "Power problems" on page 8.
• See "Paper feeding problems" on page 9.
• See "Printing problems" on page 10.
• See "Printing quality problems" on page 11.
• See "Copying problems" on page 14.
• See "Scanning problems" on page 14.
• See "Fax problems" on page 15.
• See "Samsung Scan and Fax Manager Problem" on page 15.
• See "Common Windows problems" on page 15.
• See "Common Linux problems" on page 16.
• See "Common Macintosh problems" on page 17.

Power problems

 

Click this link to open an animation about solving power problems.

Self Diagnostics
Please wait

The engine in your 
printer is checking 
some problems 
detected.

Please wait a few 
minutes.

Toner Supply Err.
▼

The machine cannot 
detect a toner 
cartridge.

Remove the toner 
hopper sheet from the 
toner cartridge (See 
"Replacing the toner 
cartridge" on page 2). Or 
open and close the front 
door. If the problem 
persists, turn the power 
button off and on.

Too many Faxes 
Remove Job

Too many faxes are 
received.

Remove received faxes.

Message Meaning Suggested solutions
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Paper feeding problems

Condition Suggested solutions

The machine is 
not receiving 
power, 
or the connection 
cable between the 
computer and the 
machine is not 
connected 
properly.

• Plug in the power cord and press (power) on 
the control panel.

• Disconnect the machine cable and reconnect it.
-For Local Printing

-For Network Printing 
(CLX-3185N/CLX-3185FN/CLX-3185FW 
only) 

Condition Suggested solutions

Paper jams during 
printing.

Clear the paper jam (See "Clearing paper jams" 
on page 2).

Paper sticks 
together.

• Ensure there is not too much paper in the 
tray. The tray can hold up to 130 sheets of 
paper, depending on the thickness of your 
paper.

• Make sure that you are using the correct type 
of paper (See "Setting the paper size and 
type" on page 6).

• Remove paper from the tray and flex or fan 
the paper.

• Humid conditions may cause some paper to 
stick together, replace with a new stack.

Multiple sheets of 
paper do not feed.

Different types of paper may be stacked in the 
tray. Load paper of only one type, size and 
weight.

Paper does not feed 
into the machine.

• Remove any obstructions from inside the 
machine.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the 
machine (See "Selecting print media" on 
page 2).

The paper keeps 
jamming.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the machine (See "Selecting print 
media" on page 2).

• There may be debris inside the machine. 
Open the front door and remove any debris.

Envelopes skew or 
fail to feed correctly.

Ensure that the paper guides are against both 
sides of the envelopes.

Condition Suggested solutions
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Printing problems

Condition Possible cause Suggested solutions

The machine 
does not print.

The machine is not 
receiving power.

Check the power cord 
connections. Check the 
power switch and the power 
source.

The machine is not 
selected as the 
default machine.

Select your machine as your 
default machine in your 
Windows.

Check the machine for the following.
• The front door or rear door is not closed. Close 

the door.
• Paper is jammed. Clear the paper jam (See 

"Clearing paper jams" on page 2).
• No paper is loaded. Load paper (See "Loading 

paper in the tray" on page 4).
• The toner cartridge is not installed. Install the 

toner cartridge.
If a system error occurs, contact a service 
representative.

The connection 
cable between the 
computer and the 
machine is not 
connected properly.

Disconnect the machine 
cable and reconnect it.

The connection 
cable between the 
computer and the 
machine is 
defective.

If possible, attach the cable to 
another computer that is 
working properly and print a 
job. You can also try using a 
different machine cable.

The port setting is 
incorrect.

Check the Windows printer 
setting to make sure that the 
print job is sent to the correct 
port. If the computer has 
more than one port, make 
sure that the machine is 
attached to the correct one.

The machine may 
be configured 
incorrectly. 

Check the Printing 
Preferences to ensure that 
all of the print settings are 
correct (See "Opening 
printing preferences" on 
page 2).

The printer driver 
may be incorrectly 
installed.

Repair the machine software 
(See "Installing USB 
connected machine’s driver" 
on page 3).

The machine is 
malfunctioning.

Check the display message 
on the control panel to see if 
the machine is indicating a 
system error. If the error 
cannot be cleared, contact a 
service representative.

The machine 
does not print. 

The document size 
is so big that the 
hard disk space of 
the computer is not 
enough to access 
the print job.

Allocate more hard disk 
space on your computer for 
spooling, and try printing.

The output tray is 
full.

It can hold up to 80 ( 80 g/m2) 
sheets of plain paper. Once 
the paper is removed from 
the output tray, the machine 
resumes printing.

If the machine is 
used for a long time 
continuously, the 
printing speed could 
be slowed down, or 
the machine could 
pause to cool down.

Wait for the machine to cool 
down. Printing automatically 
resumes after the machine is 
cooled down.

The machine 
selects print 
materials from 
the wrong paper 
source.

The paper source 
selection in the 
printer properties 
may be incorrect.

For many software 
applications, the paper 
source selection is found 
under the Paper tab within 
the printer properties. Select 
the correct paper source. See 
the printer driver help screen.

A print job is 
extremely slow.

The job may be very 
complex.

Reduce the complexity of the 
page or try adjusting the print 
quality settings.

Half the page is 
blank.

The page 
orientation setting 
may be incorrect.

Change the page orientation 
in your application. See the 
printer driver help screen.

The paper size and 
the paper size 
settings do not 
match.

Ensure that the paper size in 
the printer driver settings 
matches the paper in the tray.
Or, ensure that the paper size 
in the printer driver settings 
matches the paper selection 
in the software application 
settings you use.

Condition Possible cause Suggested solutions
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, 
you may notice a reduction in print quality. See the table below to clear the 
problem. 

The machine 
prints, but the 
text is wrong, 
garbled or 
incomplete.

The machine cable 
is loose or 
defective.

Disconnect the machine 
cable and reconnect. Try a 
print job that you have 
already printed successfully. 
If possible, attach the cable 
and the machine to another 
computer and try a print job 
that you know works. Finally, 
try a new printer cable.

The wrong printer 
driver was selected.

Check the application’s 
printer selection menu to 
ensure that your machine is 
selected.

The software 
application is 
malfunctioning.

Try printing a job from 
another application.

The operating 
system is 
malfunctioning.

Exit Windows and reboot the 
computer. Turn the machine 
off and back on again.

Pages print, but 
they are blank.

The toner cartridge 
is defective or out of 
toner.

Redistribute the toner, if 
necessary (See 
"Redistributing toner" on 
page 1).
If necessary, replace the 
toner cartridge (See 
"Replacing the toner 
cartridge" on page 2).

The file may have 
blank pages.

Check the file to ensure that it 
does not contain blank 
pages.

Some parts such as 
the controller or the 
board may be 
defective.

Contact a service 
representative.

The machine 
does not print 
PDF file 
correctly. Some 
graphics, text or 
illustrations are 
missing.

Incompatibility 
between the PDF 
file and the Acrobat 
products

Printing the PDF file as an 
image may solve this 
problem. Turn on Print As 
Image from the Acrobat 
printing options. 

 

It will take longer to 
print when you print a 
PDF file as an image.

The print quality 
of photos is not 
good. Images 
are not clear.

The resolution of 
the photo is very 
low. 

Reduce the photo size. If you 
increase the photo size in the 
software application, the 
resolution will be reduced. 

Before printing, 
the machine 
emits vapor near 
the output tray.

Using damp paper 
can cause vapor 
during printing.

This is not a problem. Just 
keep printing.

Condition Possible cause Suggested solutions

The printed 
paper is curled.

Paper curl occurs 
due to many 
different factors 
such as 
temperature, 
humidity, paper 
type, high coverage 
printing, etc.

Use the Paper Curl 
Reduction option. Go to 
Printing Preferences (See 
"Opening printing 
preferences" on page 2), click 
Advanced tab, and click the 
Paper Curl Reduction check 
box. This option will optimize 
environmental factors to 
reduce the paper curl level.

The printed 
billing paper is 
curled.

The paper type 
setting does not 
match.

Change the printer option and 
try again. Go to Printing 
Preferences, click Paper 
tab, and set type to Thick 
(See "Opening printing 
preferences" on page 2).

Condition Suggested Solutions

Light or faded print If a vertical white streak or faded area appears on 
the page:
• The toner supply is low. You may be able to 

temporarily extend the toner cartridge life (See 
"Redistributing toner" on page 1). If this does 
not improve the print quality, install a new 
toner cartridge.

• The paper may not meet paper specification; 
for example, the paper may be too moist or 
rough (See "Selecting print media" on page 2).

• If the entire page is light, the print resolution 
setting is too low or the toner save mode is on. 
Adjust the print resolution and turn the toner 
save mode off. See the help screen of the 
printer driver.

• A combination of faded or smeared defects 
may indicate that the toner cartridge needs 
cleaning.

• The surface of the Laser Scanning Unit (LSU) 
part inside the machine may be dirty. Clean 
the LSU, contact a service representative.

The top half of the 
paper is printed 
lighter than the 
rest of the paper

The toner might not adhere properly to this type of 
paper.
• Change the printer option and try again. 

Go to the Printing Preferences, click the 
Paper tab, and set the paper type to 
Recycled.

Condition Possible cause Suggested solutions
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Toner specks • The paper may not meet specification, for 
example, the paper may be too moist or rough 
(See "Selecting print media" on page 2).

• The paper path may need cleaning (See 
"Cleaning the inside" on page 1).

Dropouts If faded areas, generally rounded, occur randomly 
on the page:
• A single sheet of paper may be defective. Try 

reprinting the job.
• The moisture content of the paper is uneven 

or the paper has moist spots on its surface. 
Try a different brand of paper (See "Selecting 
print media" on page 2).

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go to 
Printing Preferences, click Paper tab, and 
set type to Thick (See "Opening printing 
preferences" on page 2).

If these steps do not correct the problem, contact 
a service representative.

White Spots If white spots appear on the page:
• The paper is too rough and a lot of dirt from a 

paper falls to the inner devices within the 
machine, which means the transfer belt may 
be dirty. Clean the inside of your machine. 
Contact a service representative.

• The paper path may need cleaning. Contact a 
service representative.

Vertical lines If black vertical streaks appear on the page:
• The drum inside the toner cartridge has 

probably been scratched. Remove the toner 
cartridge and install a new one (See 
"Replacing the toner cartridge" on page 2).

If white vertical streaks appear on the page:
• The surface of the LSU part inside the 

machine may be dirty. Clean the LSU, contact 
a service representative.

Condition Suggested Solutions

Black background If the amount of background shading becomes 
unacceptable:
• Change to a lighter weight paper (See 

"Selecting print media" on page 2).
• Check the environmental conditions: very dry 

(low humidity) or high humidity (higher than 
80% RH) conditions can increase the amount 
of background shading.

• Remove the old toner cartridge and, install a 
new one (See "Replacing the toner cartridge" 
on page 2).

Toner smear • Clean the inside of the machine (See "Cleaning 
the inside" on page 1).

• Check the paper type and quality (See 
"Selecting print media" on page 2).

• Remove the toner cartridge and then, install a 
new one (See "Replacing the toner cartridge" 
on page 2).

Vertical repetitive 
defects

If marks repeatedly appear on the printed side of 
the page at even intervals:
• The toner cartridge may be damaged. If a 

repetitive mark occurs on the page, print a 
cleaning sheet several times to clean the 
cartridge. After the printout, if you still have the 
same problems, remove the toner cartridge 
and install a new one (See "Replacing the 
toner cartridge" on page 2).

• Parts of the machine may have toner on them. 
If the defects occur on the back of the page, 
the problem will likely correct itself after a few 
more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

Background 
scatter

Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing with 

a fresh ream of paper. Do not open packages 
of paper until necessary so that the paper 
does not absorb too much moisture.

• If background scatter occurs on an envelope, 
change the printing layout to avoid printing 
over areas that have overlapping seams on 
the reverse side. Printing on seams can cause 
problems.

• If background scatter covers the entire surface 
area of a printed page, adjust the print 
resolution through your software application or 
the printer properties.

Condition Suggested Solutions

A

Troubleshooting_ 12



Toner particles are 
around bold 
characters or 
pictures

The toner might not adhere properly to this type of 
paper.
• Change the printer option and try again. 

Go to the Printing Preferences, click the 
Paper tab, and set the paper type to 
Recycled.

Misformed 
characters

• If characters are improperly formed and 
producing hollow images, the paper stock may 
be too slick. Try different paper (See "Selecting 
print media" on page 2).

• If characters are improperly formed and 
producing a wavy effect, the scanner unit may 
need service, For service, contact a service 
representative.

Page skew • Ensure that the paper is loaded properly.
• Check the paper type and quality (See 

"Selecting print media" on page 2).
• Ensure that the paper or other material is 

loaded correctly and the guides are not too tight 
or too loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper curl 
(See "Selecting print media" on page 2).

• Turn the stack of paper over in the tray. Also try 
rotating the paper 180° in the tray.

Wrinkles or 
creases

• Ensure that the paper is loaded properly.
• Check the paper type and quality (See 

"Selecting print media" on page 2).
• Turn the stack of paper over in the tray. Also try 

rotating the paper 180° in the tray.

Condition Suggested Solutions

A a B b CA a B b CA a B b CA a B b C cA a B b C c

Back of printouts 
are dirty

Check for leaking toner. Clean the inside of the 
machine (See "Cleaning the inside" on page 1).

Solid Color or 
Black pages

• The toner cartridge may not be installed 
properly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective and need 
replacing. Remove the toner cartridge and 
install a new one (See "Replacing the toner 
cartridge" on page 2).

• The machine may require repair. Contact a 
service representative.

Loose toner • Clean the inside of the machine (See "Cleaning 
the inside" on page 1).

• Check the paper type and quality (See 
"Selecting print media" on page 2).

• Remove the toner cartridge and install a new 
one (See "Replacing the toner cartridge" on 
page 2).

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Character Voids Character voids are white areas within parts of 
characters that should be solid black.
• If you are using transparencies, try another 

type of transparency. Because of the 
composition of transparencies, some 
character voids are normal. 

• You may be printing on the wrong surface of 
the paper. Remove the paper and turn it over. 

• The paper may not meet paper specifications 
(See "Selecting print media" on page 2).

Horizontal stripes If horizontally aligned black streaks or smears 
appear:
• The toner cartridge may be installed 

improperly. Remove the cartridge and reinsert 
it.

• The toner cartridge may be defective. Remove 
the toner cartridge and install a new one (See 
"Replacing the toner cartridge" on page 2).

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Condition Suggested Solutions

A

A
A a B b C
A a B b C
A a B b C
A a B b C
A a B b C
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Copying problems

Scanning problems

Curl If the printed paper is curled or paper does not 
feed into the machine:
• Turn over the stack of paper in the tray. Also 

try rotating the paper 180° in the tray. 
• Change the printer option and try again. Go to 

printer properties, click Paper tab and set type 
to Thin Paper (See "Opening printing 
preferences" on page 2).

An unknown image 
repetitively 
appears on a few 
sheets or loose 
toner, light print, or 
contamination 
occurs.

Your machine is probably being used at an 
altitude of 1,000 m (3,281 ft.) or above.
The high altitude may affect the print quality such 
as loose toner or light imaging. You can select a 
correct altitude of your machine location (See 
"Altitude adjustment" on page 1).

Condition Suggested solution

Copies are too light 
or too dark.

Use Darkness in Copy feature to lighten or 
darken the backgrounds of copies (See 
"Changing the settings for each copy" on 
page 1).

Smears, lines, 
marks, or spots 
appear on copies.

• If the defects are on the original, use 
Darkness in Copy feature to lighten the 
background of your copies (See "Changing 
the settings for each copy" on page 1).

• If there are no defects on the original, clean 
the scan unit (See "Cleaning the scan unit" on 
page 3).

Copy image is 
skewed.

• Ensure that the original is face down on the 
scanner glass.

• Check that the copy paper is loaded correctly.

Blank copies print 
out.

Ensure that the original is face down on the 
scanner glass.

Image rubs off the 
copy easily.

• Replace the paper in the tray with paper from 
a new package.

• In high humidity areas, do not leave paper in 
the machine for extended periods of time.

Frequent copy paper 
jams occur.

• Fan the stack of paper, then turn it over in the 
tray. Replace the paper in the tray with a fresh 
supply. Check/adjust the paper guides, if 
necessary.

• Ensure that the paper is the proper paper 
weight.

• Check for copy paper or pieces of copy paper 
remaining in the machine after a paper jam 
has been cleared.

Condition Suggested Solutions

Toner cartridge 
produces fewer 
copies than 
expected before 
running out of toner.

• Your originals may contain pictures, solids, or 
heavy lines. For example, your originals may 
be forms, newsletters, books, or other 
documents that use more toner.

• The scanner lid may be left open while copies 
are being made.

• Turn the machine off and back on. 

Condition Suggested solutions

The scanner does not 
work. 

• Make sure that you place the original to be 
scanned face down on the scanner glass.

• There may not be enough available memory 
to hold the document you want to scan. Try 
the Prescan function to see if that works. 
Try lowering the scan resolution rate.

• Check that the machine cable is connected 
properly.

• Make sure that the machine cable is not 
defective. Switch the cable with a known 
good cable. If necessary, replace the cable.

• Check that the scanner is configured 
correctly. Check scan setting in the 
SmarThru or the application you want to use 
to make certain that the scanner job is being 
sent to the correct port (for example, 
USB001).

The unit scans very 
slowly. 

• Check if the machine is printing received 
data. If so, scan the document after the 
received data has been printed.

• Graphics are scanned more slowly than text.
• Communication speed slows in scan mode 

because of the large amount of memory 
required to analyze and reproduce the 
scanned image. Set your computer to the 
ECP printer mode through BIOS setting. It 
will help to increase the speed. For details 
about how to set BIOS, refer to your 
computer user’s guide.

Condition Suggested solution
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Fax problems

Samsung Scan and Fax Manager Problem

Common Windows problems

Message appears on 
your computer 
screen:
• Device can’t be 

set to the H/W 
mode you want.

• Port is being used 
by another 
program. 

• Port is Disabled.
• Scanner is busy 

receiving or 
printing data. 
When the current 
job is completed, 
try again.

• Invalid handle.
• Scanning has 

failed.

• There may be a copying or printing job in 
progress. Try your job again when that job is 
finished.

• The selected port is currently being used. 
Restart your computer and try again.

• The machine cable may be improperly 
connected or the power may be off.

• The scanner driver is not installed or the 
operating environment is not set up properly.

• Ensure that the machine is properly 
connected and the power is on, then restart 
your computer.

• The USB cable may be improperly 
connected or the power may be off.

condition suggested solutions

The machine is not 
working, there is no 
display, or the 
buttons are not 
working.

• Unplug the power cord and plug it in again.
• Ensure that there is power being supplied to 

the electrical outlet.

No dial tone. • Check that the phone line is properly 
connected.

• Check that the phone socket on the wall is 
working by plugging in another phone.

The numbers stored 
in memory do not 
dial correctly.

Make sure that the numbers are stored in 
memory correctly. Print an Address Book list 
(See "Setting up Address Book" on page 6).

The original does 
not feed into the 
machine.

• Make sure that the paper is not wrinkled and 
you are inserting it in correctly. Check that the 
original is the right size, not too thick or thin.

• Make sure that the document feeder is firmly 
closed.

• The document feeder rubber pad may need to 
be replaced. Contact a service 
representative.

Faxes are not 
received 
automatically.

• The receiving mode should be set to fax.
• Make sure that there is paper in the tray.
• Check to see if the display shows any error 

message. If it does, clear the problem.

The machine does 
not send.

• Make sure that the original is loaded in the 
document feeder or on the scanner glass. 

• Check the fax machine you are sending to, to 
see if it can receive your fax.

Condition Suggested solutions

The incoming fax 
has blank spaces or 
is of poor-quality.

• The fax machine sending you the fax may be 
faulty. 

• A noisy phone line can cause line errors.
• Check your machine by making a copy.
• A toner cartridge has reached its estimated 

cartridge life. Replace the toner cartridge 
(See "Replacing the toner cartridge" on 
page 2).

Some of the words 
on an incoming fax 
are stretched.

The fax machine sending the fax had a 
temporary document jam. 

There are lines on 
the originals you 
sent.

Check your scan unit for marks and clean it (See 
"Cleaning the scan unit" on page 3).

The machine dials a 
number, but the 
connection with the 
other fax machine 
fails.

The other fax machine may be turned off, out of 
paper, or cannot answer incoming calls. Speak 
with the other machine operator and ask her/him 
to solve out the problem.

Faxes do not store in 
memory.

There may not be enough memory space to 
store the fax. If the display indicating the 
memory status shows, delete any faxes you no 
longer need from the memory, and then try to 
store the fax again. Call a service 
representative.

Blank areas appear 
at the bottom of 
each page or on 
other pages, with a 
small strip of text at 
the top

You may have chosen the wrong paper settings 
in the user option setting. For details about 
paper settings, see "Setting the paper size and 
type" on page 6.

Condition suggested solution

Samsung Scan and 
Fax Manager does 
not work. 

Check your system requirements. Samsung 
Scan and Fax Manager works in Windows and 
Mac OS (See "System requirements" on page 2).

Condition Suggested solutions

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the printer’s startup group, then 
restart Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool 32” or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

condition suggested solutions
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Refer to the Microsoft Windows User’s Guide that came with your 
computer for further information on Windows error messages.

Common Linux problems

“Fail To Print”, “A 
printer timeout error 
occurred” messages 
appear.

These messages may appear during printing. 
Just keep waiting until the machine finishes 
printing. If the message appears in standby 
mode or after printing has been completed, 
check the connection and/or whether an error 
has occurred.

Condition Suggested solutions

condition Suggested solutions

The machine does 
not print.

• Check if the printer driver is installed in your 
system. Open Unified Driver Configurator and 
switch to the Printers tab in Printers 
configuration window to look at the list of 
available machines. Make sure that your 
machine is displayed on the list. If not, open 
Add new printer wizard to set up your 
device.

• Check if the machine is started. Open 
Printers configuration and select your 
machine on the printers list. Look at the 
description in the Selected printer pane. If its 
status contains Stopped string, press the 
Start button. After that normal operation of 
the machine should be restored. The 
“stopped” status might be activated when 
some problems in printing occurred. For 
instance, this could be an attempt to print a 
document when the port is claimed by a 
scanning application.

• Ensure the port is not busy. Since functional 
components of machine (printer and scanner) 
share the same I/O interface (port), the 
situation of simultaneous access of different 
user applications to the same port is possible. 
To avoid possible conflicts, only one of them 
at a time is allowed to gain control over the 
device. The other user will encounter “device 
busy” response. You should open ports 
configuration and select the port assigned to 
your machine. In the Selected port pane you 
can see if the port is occupied by some other 
application. If this is the case, you should 
either wait for completion of the current job or 
press the Release port button, if you are sure 
that the present application is not functioning 
properly.

• Check if your application has special print 
option such as “-oraw”. If “-oraw” is specified 
in the command line parameter, then remove 
it to print properly. For Gimp front-end, select 
“print” -> “Setup printer” and edit command 
line parameter in the command item.

• The CUPS (Common Unix Printing System) 
version distributed with SuSE Linux 9.2 
(cups-1.1.21) has a problem with ipp (Internet 
Printing Protocol) printing.Use the socket 
printing instead of ipp or install a later version 
of CUPS (cups-1.1.22 or higher).

The machine does 
not print whole 
pages, and output is 
printed on half the 
page.

It is a known problem that occurs when a color 
machine is used on version 8.51 or earlier of 
Ghostscript, 64-bit Linux OS, and has been 
reported to bugs.ghostscript.com as Ghostscript 
Bug 688252.The problem is solved in AFPL 
Ghostscript v. 8.52 or above. Download the 
latest version of AFPL Ghostscript from 
http://sourceforge.net/projects/ghostscript/ and 
install it to solve this problem.
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Refer to the Linux User’s Guide that came with your computer for 
further information on Linux error messages.

Common Macintosh problems

 

Refer to the Macintosh User’s Guide that came with your computer for 
further information on Macintosh error messages.

I cannot scan via 
Gimp Front-end.

Check if Gimp Front-end has Xsane: Device 
dialog on the Acquire menu. If not, you should 
install Xsane plug-in for Gimp on the your 
computer. You can find Xsane plug-in package 
for Gimp on Linux distribution CD or Gimp home 
page. For the detailed information, refer to the 
Help for Linux distribution CD or Gimp Front-end 
application. 
If you wish to use another kind of scan 
application, refer to application’s Help.

I encounter the 
“Cannot open port 
device file” error 
when printing a 
document.

Avoid changing print job parameters (via LPR 
GUI, for example) while a print job is in progress. 
Known versions of CUPS server break the print 
job whenever print options are changed and 
then try to restart the job from the beginning. 
Since Unified Linux Driver locks the port while 
printing, the abrupt termination of the driver 
keeps the port locked and unavailable for 
subsequent print jobs. If this situation occurs, try 
to release the port by selecting Release port in 
Port configuration window.

The machine does 
not appear on the 
scanners list.

• Ensure your machine is attached to your 
computer, connected properly via the USB 
port, and is turned on.

• Ensure the scanner driver for your machine is 
installed in your system. Open Unified Linux 
Driver configurator, switch to Scanners 
configuration, then press Drivers. Make 
sure that driver with a name corresponding to 
your machine's name is listed in the window. 

• Ensure the port is not busy. Since functional 
components of machine (printer and scanner) 
share the same I/O interface (port), the 
situation of simultaneous access of different 
user applications to the same port is possible. 
To avoid possible conflicts, only one of them 
at a time is allowed to gain control over the 
device. The other user will encounter “device 
busy” response. This usually happens when 
starting a scan procedure. An appropriate 
message box appears.
To identify the source of the problem, open 
the Ports configuration and select the port 
assigned to your scanner, port's symbol 
/dev/mfp0 corresponds to LP:0 designation 
displayed in the scanners’ options, /dev/mfp1 
relates to LP:1, and so on. USB ports start at 
/dev/mfp4, so scanner on USB:0 relates to 
/dev/mfp4 respectively and so forth 
sequentially. In the Selected port pane, you 
can see if the port is occupied by another 
application. If this is the case, you should 
either wait for completion of the current job or 
press the Release port button, if you are sure 
that the present port application is not 
functioning properly.

condition Suggested solutions

The machine does 
not scan.

• Ensure a document is loaded into the 
machine, ensure your machine is connected 
to the computer.

• If there is an I/O error while scanning.

condition Suggested solutions

The machine does 
not print PDF files 
correctly. Some 
parts of graphics, 
text, or illustrations 
are missing.

Printing the PDF file as an image may enable 
the file to print. Turn on Print As Image from the 
Acrobat printing options. 

 

It will take longer to print when you print a 
PDF file as an image.

The document has 
printed, but the print 
job has not 
disappeared from 
the spooler in Mac 
OS X 10.3.2.

Update your Mac OS to Mac OS X 10.3.3. or 
higher.

Some letters are not 
displayed normally 
during the cover 
page printing.

Mac OS cannot create the font during the cover 
page printing. The English alphabet and 
numbers are displayed normally on the cover 
page.

When printing a 
document in Mac OS 
with Acrobat 
Reader 6.0 or higher, 
colors print 
incorrectly.

Make sure that the resolution setting in your 
machine driver matches the one in Acrobat 
Reader.

condition Suggested solutions
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1.supplies and accessories
This chapter provides information about purchasing supplies, accessories and maintenance parts available for your 
machine.
This chapter includes:
• How to purchase
• Available supplies
• Available maintenance parts
• Checking replaceable’s lifespan

• Replacing the toner cartridge
• Replacing the imaging unit
• Replacing the waste toner container

  

 

•Illustrations on this user’s guide may differ from your machine 
depending on its options or models. Check your model name.

•Available accessories may differ from country to country. Contact 
your sales representatives to obtain the list of available supplies 
and maintenance parts.

How to purchase
To order Samsung-authorized supplies, accessories and maintenance 
parts, contact your local Samsung dealer or the retailer where you 
purchased your machine. You can also visit www.samsung.com/supplies, 
and then select your country/region to obtain the information on calling for 
service.

Available supplies
When supplies reach their lifespan, you can order the following types of 
supplies for your machine.

 

When purchasing new toner cartridges or other supplies, these must 
be purchased in the same country as the machine you are using. 
Otherwise, new toner cartridges or other supplies will be incompatible 
with your machine due to different configurations of toner cartridges 
and other supplies according to the specific country conditions.

Available maintenance parts
To avoid print quality and paper feed problems resulting from worn parts 
and to maintain your machine in top working condition, the following parts 
will need to be replaced after printing the specified number of pages or 
when the life span of each item has expired.

To purchase maintenance parts, contact the source where you purchased 
the machine. 
Replacing maintenance parts can be performed only by an authorized 
service provider, dealer or the retailer where you purchased the 
machine. The warranty does not cover the replacement of any 
maintenance parts after their lifespan.

Type Average yielda

a.Declared yield value in accordance with ISO/IEC 19798.

Part name

Standard yield 
toner cartridge

• Average 
continuous black 
cartridge yield: 
1,500 standard 
pages (Black)

• Average 
continuous color 
cartridge yield: 
1,000 standard 
pages 
(Yellow/Magenta/C
yan)

K407(CLT-K407S): Black
C407(CLT-C407S): Cyan
M407(CLT-M407S): Magenta
Y407(CLT-Y407S): Yellow
Region Ab

K4072(CLT-K4072S): Black
C4072(CLT-C4072S): Cyan
M4072(CLT-M4072S): Magenta
Y4072(CLT-Y4072S): Yellow
Region Bc

K4073(CLT-K4073S): Black
C4073(CLT-C4073S): Cyan
M4073(CLT-M4073S): Magenta
Y4073(CLT-Y4073S): Yellow

Imaging unit Approx. 24,000 
imagesd

CLT-R407

Waste toner 
container

Approx. 10,000 
imagesd (Full color 
5% image)

CLT-W409

b.Region A: Albania, Austria, Belgium, Bosnia, Bulgaria, Croatia, Cyprus, 
Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, 
Hungary, Italy, Latvia, Lithuania, Macedonia, Netherlands, Norway, 
Poland, Portugal, romania, Serbia, Slovakia, Slovenia, Spain, Sweden, 
Switzerland, UK.

c. Region B: Bangladesh, China, India, Nepal, Vietnam.
d. Image counts based on one color on each page. If you print documents 

in full color (Cyan, Magenta, Yellow, Black), the life of this item will be 
reduced by 25%.

Items Average yielda

a.Yield is affected by operating system used, computing performance, 
application software, connecting method, media type, media size and 
job complexity.

Fuser unit Approx. 50,000 black pages or 12,500 color pages

Transfer roller Approx. 50,000 black pages or 12,500 color pages

Transfer unit (ITB) Approx. 50,000 black pages or 12,500 color pages

Pick-up roller Approx. 50,000 pages
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Checking replaceable’s lifespan
If you experience frequent paper jams or printing problems, check the 
number of pages the machine has printed. Replace the corresponding 
parts, if necessary.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Maintenance appears and press OK.
4. Press the left/right arrow until Supplies Life appears and press OK.
5. Press the left/right arrow until the item you want appears and press OK.

•Supplies Info: Prints the supply information page.
•Total: Displays the total number of pages printed in color mode or black 

and white mode.
•ADF Scan: Displays the number of pages scanned using the ADF.
•Platen Scan: Displays the number of pages scanned using the scanner 

glass.
•Imaging Unit: Displays the number of pages scanned and printed.
•Transfer Belt: Displays the number of pages scanned and printed.
•Fuser: Displays the number of pages scanned and printed.
•TransferRoller: Displays the number of pages scanned and printed.
•Tray 1 Roller: Displays the number of pages scanned and printed.

6. Press Stop/Clear to return to ready mode.

Replacing the toner cartridge
The machine uses four colors and has a different toner cartridge for each 
one: yellow (Y), magenta (M), cyan (C) and black (K).
The status LED and the toner-related message on the display indicate 
which toner cartridge should be replaced.
At this stage, the indicated toner cartridge needs to be replaced. Before 
replacing the toner cartridge, check the model number for the toner 
cartridge used in your machine.

 

Click this link to open an animation about replacing the toner cartridge.

1. Turn the machine off, then wait a few minutes for the machine to cool.
2. Using the handle, completely open the front door.

3. Grasp the handles on the toner cartridge and pull to remove the 
cartridge from the machine.

4. Take a new toner cartridge out of its package.

 

Don’t use sharp objects such as a knife or scissors to open the 
toner cartridge package. You could damage the surface of the 
toner cartridge.

5. Pull out the hopper sheet from a new toner cartridge.

6. Holding both handles on the toner cartridge, thoroughly rock it from side 
to side to evenly distribute the toner.

7. Place the toner cartridge on a flat surface as shown below and remove 
the protecting cap.
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If toner gets on your clothing, wipe it off with a dry cloth and wash it 
in cold water. Hot water sets toner into fabric.

8. Make sure that the color of the toner cartridge matches the color slot and 
then grasp the handles on the toner cartridge. Insert the cartridge until it 
clicks into place.

9. Close the front door. Make sure the door is securely latched and then 
turn the machine on.

 

If the front door is not completely closed, the machine will not 
operate.

Replacing the imaging unit
When the life span of the imaging unit has expired, the Smart Panel 
program window appears on the computer, indicating the imaging unit 
needs to be placed. Otherwise, your machine may stop printing.
1. If the machine is printing from the computer or warming up, wait until the 

job ends. Then, turn the machine off.
2. Using the handle, completely open the front door.

3. Grasp the handles on the front cartridge and pull to remove four 
cartridges from the machine.

4. Pull the waste toner container out of the machine using its handle.

5. Pull the imaging unit out of the machine using the groove on the front of 
the imaging unit.

6. Take a new imaging unit out of its package. Remove the protective 
devices on both sides of the imaging unit and the paper protecting the 
surface of the imaging unit.

 

•Don’t use sharp objects such as a knife or scissors to open the 
imaging unit package.

•Do not touch the drum located in the imaging unit. Use the handle 
on the cartridge to avoid touching this area.

•Be careful not to scratch the surface of imaging unit.
•To prevent damage, do not expose the imaging unit to light for 

more than a few minutes. Cover it with a piece of paper to 
protect it if necessary.
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7. Holding the groove on the front of the imaging unit, push imaging unit in 
to the machine.

8. Insert the waste toner container into position and then push it to make 
sure that it is firmly seated in place.

9. Slide four toner cartridges back into the machine.

10. Close the front door firmly.

 

If the front door is not completely closed, the machine will not 
operate. Please, make sure all toner cartridges are installed 
properly. If any toner cartridge is installed improperly, the front 
door do not close.

11. Turn the machine on.

 

•It may takes few minutes for your machine to get ready.
•If the machine cannot recognize the status of toner cartridges, 

open and close the front door. If the problem persists, turn the 
power button off and on.

Replacing the waste toner container
When the life span of the waste toner container has expired, the Smart 
Panel program window appears on the computer, indicating the waste toner 
container needs to be replaced. Otherwise your machine stops printing.
1. Turn the machine off, then wait a few minutes for the machine to cool.
2. Using the handle, completely open the front door.

3. Pull the waste toner container out of the machine using its handle.

 

Make sure that you lay the waste toner container on a flat surface 
so that the toner does not spill.

4. Remove the container’s cap from the container as shown below and 
then use it to close the waste toner container opening.

 

Do not tilt or turn over the container.

5. Take a new waste toner container out of its package.

2

1
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6. Insert the new container into position and then push it to make sure that 
it is firmly seated in place.

7. Close the front door firmly.

 

If the front door is not completely closed, the machine will not 
operate. Please, make sure all toner cartridges are installed 
properly. If any toner cartridge is installed improperly, the front 
door do not close.

8. Turn the machine on.
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1.specifications
This chapter covers the machine’s primary specifications.
This chapter includes:
• Hardware specifications
• Environmental specifications
• Electrical specifications
• Print media specifications
  

 

The specification values are listed below: specifications are subject to change without notice. See www.samsung.com/printer for possible changes in 
information.

Hardware specifications

Environmental specifications

Item Description

Dimensions Height • CLX-3185/CLX-3185N/CLX-3185WK: 310 mm (12.2 inches)
• CLX-3185FN/CLX-3185FW: 344 mm (13.5 inches)

Depth • CLX-3185/CLX-3185N/CLX-3185WK: 378 mm (14.9 inches)
• CLX-3185FN/CLX-3185FW: 378 mm (14.9 inches)

Width • CLX-3185/CLX-3185N/CLX-3185WK: 416 mm (16.4 inches)
• CLX-3185FN/CLX-3185FW: 416 mm (16.4 inches)

Weight Machine with consumables • CLX-3185/CLX-3185N/CLX-3185WK: 14.24 Kg (31.39 lbs)
• CLX-3185FN/CLX-3185FW: 15.25 Kg (33.62 lbs)

Item Description

Noise Levela

a.Sound Pressure Level, ISO 7779. Configuration tested: machine basic installation, A4 paper, simplex printing.

Printing mode Less than 46 dBA (Color printing)
Less than 48 dBA (Mono printing)

Copying mode • Mono copying
-ADF: 52 dBA
-Scan glass: 50 dBA

• Color copying
-ADF: 50 dBA
-Scan glass: 48 dBA

Standby mode Background noise Level

Sleep mode Background noise Level

Temperature Operation 10 to 32 °C (50 to 89.6 °F)

Storage (packed) 0 to 40 °C (32 to 104 °F)

Humidity Operation 20 to 80% RH

Storage (packed) 10 to 90% RH
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Electrical specifications

 

Power requirements are based on the country/region where the device is sold. Do not convert operating voltages. Doing so might damage the device and 
void the product warranty.

Item Description

Power ratinga

a.See the rating label on the machine for the correct voltage (V), frequency (hertz) and type of current (A) for your machine.

110 volt models AC 110 - 127 V

220 volt models AC 220 - 240 V

Power consumption Average operating mode Less than 350 W

Ready mode Less than 60 W

Power save mode • CLX-3185/CLX-3185N: Less than 8 W
• CLX-3185WK/CLX-3185FN/CLX-3185FW: Less than 11 W

Power off mode Less than 0.45 W
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Print media specifications

Type Size Dimensions Weighta

a.If media weight is over 120 g/m2 (32 lbs), load a paper into the tray one by one.

Capacityb

b.Maximum capacity may differ depending on media weight, thickness, and environmental conditions.

Plain paper Letter 216 x 279 mm (8.50 x 11.00 inches) 70 to 90 g/m2 (19 to 24 lbs bond) 130 sheets of 80 g/m2 (21 lbs 
bond) paper for the trayLegal 216 x 356 mm (8.50 x 14.00 inches)

US Folio 216 x 330 mm (8.50 x 13.00 inches)

A4 210 x 297 mm (8.27 x 11.69 inches)

Oficio 216 x 343 mm (8.50 x 13.50 inches)

JIS B5 182 x 257 mm (7.17 x 10.12 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 10.50 inches)

A5 148 x 210 mm (5.83 x 8.26 inches)

A6 105 x 148 mm (4.13 x 5.82 inches)

Envelope Envelope Monarch 98 x 191 mm (3.87 x 7.50 inches) 75 to 90 g/m2 (20 to 24 lbs bond) 5 sheets for manual feeding in 
the tray

Envelope 6 3/4 92 x 165 mm (3.62 x 6.50 inches)

Envelope No. 10 105 x 241 mm (4.12 x 9.50 inches)

Envelope No. 9 98 x 225 mm (3.87 x 8.87 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.38 x 9.02 inches)

Envelope C6 114 x 162 mm (4.49 x 6.38 inches)

Thick paper Refer to the Plain 
paper section 

Refer to the Plain paper section. 90 to 105 g/m2 (24 to 28 lbs bond) 5 sheets for manual feeding in 
the tray

Thin paper Refer to the Plain 
paper section 

Refer to the Plain paper section. 60 to 70 g/m2 (16 to 19 lbs bond)

Labelsc

c. The smoothness of the labels used in this machine is 100 to 250 (sheffield). This means the numeric level of smoothness.

Letter, A4 Refer to the Plain paper section. 120 to 150 g/m2 (37 to 40 lbs bond)

Card stock Post card 101.60 x 152.4 mm (4 x 6 inches) 105 to 163 g/m2 (28 to 43 lbs bond)

Transparencyde

d.Recommended media: Transparency for a color laser printers by Xerox 3R91331 (A4) or Xerox 3R2780 (Letter).
e.Recommended media: 0.104 to 0.124 mm (0.004094 to 0.004882 inches) thickness of transparency paper.

Letter, A4 Refer to the Plain paper section. - 1 sheet for manual feeding in the 
tray

Glossy photof

f. Recommended media: Glossy paper (Letter) for this machine by HP Brochure Paper (Product: Q6611A). Glossy paper (A4) for this machine by HP Laser 
Professional paper 130 glossy (Product: Q2552A), HP Professional paper 150 glossy (Product: CG965A) and HP Professional Laser paper 120 soft 
glossy (Product: Q6542A). Matte paper (A4) for this machine by HP Photo Laser Paper 220 matt (Product: Q6550A).

Letter, A4, Postcard 4 
x 6

Refer to the Plain paper section. 111 to 220 g/m2 (30 to 58 lbs bond)

Matte photof Letter, A4, Postcard 4 
x 6

Refer to the Pain paper section. 111 to 220 g/m2 (30 to 58 lbs bond)

Minimum size (custom) 76 x 152.4 mm (3 x 6 inches) 60 to 163 g/m2 (16 to 43 lbs bond) 
Maximum size (custom) 216 x 356 mm (8.50 x 14.02 inches)
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contact samsung worldwide
If you have any comments or questions regarding Samsung products, contact the Samsung customer care center.

Country/Regio
n Customer Care Center Web Site

ARGENTINE 0800-333-3733 www.samsung.com

ARMENIA 0-800-05-555

AUSTRALIA 1300 362 603 www.samsung.com

AUSTRIA 0810-SAMSUNG (7267864, 
€ 0.07/min)

www.samsung.com

AZERBAIJAN 088-55-55-555

BAHRAIN 8000-4726

BELARUS 810-800-500-55-500 www.samsung.ua
www.samsung.com/ua_ru

BELGIUM 02-201-24-18 www.samsung.com/be 
(Dutch)
www.samsung.com/be_fr 
(French)

BRAZIL 0800-124-421
4004-0000

www.samsung.com

CANADA 1-800-SAMSUNG 
(726-7864)

www.samsung.com

CHILE 800-SAMSUNG (726-7864) www.samsung.com

CHINA 400-810-5858
010-6475 1880

www.samsung.com

COLOMBIA 01-8000112112 www.samsung.com

COSTA RICA 0-800-507-7267 www.samsung.com

CZECH 
REPUBLIC

800-SAMSUNG 
(800-726786)

www.samsung.com

Samsung Zrt., česká organizační složka, Oasis Florenc, 
Sokolovská394/17, 180 00, Praha 8

DENMARK 70 70 19 70 www.samsung.com

ECUADOR 1-800-10-7267 www.samsung.com

EGYPT 0800-726786

EIRE 0818 717100 www.samsung.com

EL SALVADOR 800-6225 www.samsung.com

ESTONIA 800-7267 www.samsung.com

KAZAKHSTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

KYRGYZSTAN 00-800-500-55-500

FINLAND 030-6227 515 www.samsung.com

FRANCE 01 48 63 00 00 www.samsung.com

GERMANY 01805 - SAMSUNG 
(726-7864 € 0,14/min)

www.samsung.com

GEORGIA 8-800-555-555

GUATEMALA 1-800-299-0013 www.samsung.com

HONDURAS 800-7919267 www.samsung.com

HONG KONG (852) 3698-4698 www.samsung.com/hk
www.samsung.com/hk_en

HUNGARY 06-80-SAMSUNG 
(726-7864)

www.samsung.com

INDIA 3030 8282
1800 110011
1800 3000 8282 
1800 266 8282

www.samsung.com

INDONESIA 0800-112-8888
021-5699-7777

www.samsung.com

ITALIA 800-SAMSUNG (726-7864) www.samsung.com

JAMAICA 1-800-234-7267 www.samsung.com

JAPAN 0120-327-527 www.samsung.com

JORDAN 800-22273

KSA 9200-21230 www.samsung.com

LATVIA 8000-7267 www.samsung.com

LITHUANIA 8-800-77777 www.samsung.com

LUXEMBURG 261 03 710 www.samsung.com

MALAYSIA 1800-88-9999 www.samsung.com

MEXICO 01-800-SAMSUNG 
(726-7864)

www.samsung.com

MOLDOVA 00-800-500-55-500 www.samsung.ua
www.samsung.com/ua_ru

NETHERLANDS 0900-SAMSUNG 
(0900-7267864) (€ 
0,10/min)

www.samsung.com

NEW ZEALAND  0800 SAMSUNG (0800 726 
786)

www.samsung.com

NICARAGUA 00-1800-5077267 www.samsung.com

NORWAY 815-56 480 www.samsung.com

PANAMA 800-7267 www.samsung.com

Country/Regio
n Customer Care Center Web Site
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PHILIPPINES 1800-10-SAMSUNG 
(726-7864)
1-800-3-SAMSUNG 
(726-7864)
1-800-8-SAMSUNG 
(726-7864)
02-5805777

www.samsung.com

POLAND 0 801 1SAMSUNG 
(172678)
022-607-93-33

www.samsung.com

PORTUGAL 80820-SAMSUNG 
(726-7864)

www.samsung.com

PUERTO RICO 1-800-682-3180 www.samsung.com

QATAR 800-2255

REP. DOMINICA 1-800-751-2676 www.samsung.com

RUSSIA 8-800-555-55-55 www.samsung.ru

SINGAPORE 1800-SAMSUNG 
(726-7864)

www.samsung.com

SLOVAKIA 0800-SAMSUNG 
(726-7864)

www.samsung.com

SOUTH AFRICA 0860 SAMSUNG 
(726-7864)

www.samsung.com

SPAIN 902-1-SAMSUNG(902 172 
678)

www.samsung.com

SWEDEN 0771 726 7864 
(SAMSUNG)

www.samsung.com

SWITZERLAND 0848-SAMSUNG (7267864, 
CHF 0.08/min)

www.samsung.com

SYRIA 1825-22-73

TADJIKISTAN 8-10-800-500-55-500

TAIWAN 0800-329-999 www.samsung.com

THAILAND 1800-29-3232
02-689-3232

www.samsung.com

TRINIDAD & 
TOBAGO

1-800-SAMSUNG 
(726-7864)

www.samsung.com

TURKEY 444 77 11 www.samsung.com

U.A.E 800-SAMSUNG (726-7864) www.samsung.com

U.K 0845 SAMSUNG 
(726-7864)

www.samsung.com

U.S.A 1-800-SAMSUNG 
(726-7864)

www.samsung.com

UKRAINE 8-800-502-000 www.samsung.ua
www.samsung.com/ua_ru

Country/Regio
n Customer Care Center Web Site

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

VENEZUELA 0-800-100-5303 www.samsung.com

VIETNAM 1 800 588 889 www.samsung.com

Country/Regio
n Customer Care Center Web Site
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glossary
 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well 
as mentioned in this user’s guide.

802.11
802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards 
Committee (IEEE 802). 

802.11b/g/n
802.11b/g/n can share same hardware and use the 2.4 GHz band. 
802.11b supports bandwidth up to 11 Mbps, 802.11n supports 
bandwidth up to 150 Mbps. 802.11b/g/n devices may occasionally suffer 
interference from microwave ovens, cordless telephones, and Bluetooth 
devices.

Access point
Access Point or Wireless Access Point (AP or WAP) is a device that 
connects wireless communication devices together on wireless local 
area networks (WLAN), and acts as a central transmitter and receiver of 
WLAN radio signals. 

ADF
An Automatic Document Feeder (ADF) is a scanning unit that will 
automatically feed an original sheet of paper so that the machine can 
scan some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Macintosh (1984) 
and is now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher color 
depth gives a broader range of distinct colors. As the number of bits 
increases, the number of possible colors becomes impractically large for 
a color map. 1-bit color is commonly called as monochrome or black and 
white.

BMP
A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file 
format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the bootstrap 
process of computers or operating systems running on them. The 
BOOTP servers assign the IP address from a pool of addresses to each 

client. BOOTP enables 'diskless workstation' computers to obtain an IP 
address prior to loading any advanced operating system.

CCD
Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the machine.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in front of 
the machine. 

Coverage
It is the printing term used for a toner usage measurement on printing. 
For example, 5% coverage means that an A4 sided paper has about 5% 
image or text on it. So, if the paper or original has complicated images or 
lots of text on it, the coverage will be higher and at the same time, a 
toner usage will be as much as the coverage.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it is 
used in Microsoft Excel, has become a de facto standard throughout the 
industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a scanning unit that 
will automatically feed and turn over an original sheet of paper so that 
the machine can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its box 
state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network. DHCP also 
provides a mechanism for allocation of IP addresses to client hosts.
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DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing data, 
received fax data.

DLNA
The Digital Living Network Alliance (DLNA) is a standard that allows 
devices on a home network to share information with each other across 
the network.

DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks, 
such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head 
that runs back and forth on the page and prints by impact, striking an 
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD 
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line to 
answer several different telephone numbers.

Duplex
A mechanism that will automatically turn over a sheet of paper so that 
the machine can print (or scan) on both sides of the paper. A printer 
equipped with a Duplex Unit can print on both sides of paper during one 
print cycle.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan limitation 
such as pages per year. The lifespan means the average capacity of 
print-outs, usually within the warranty period. For example, if the duty 
cycle is 48,000 pages per month assuming 20 working days, a printer 
limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built into 
Class 1 fax machines or fax modems. It automatically detects and 
corrects errors in the fax transmission process that are sometimes 
caused by telephone line noise.

Emulation
Emulation is a technique of one machine obtaining the same results as 
another.
An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 

Emulation focuses on exact reproduction of external behavior, which is 
in contrast to simulation, which concerns an abstract model of the 
system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized 
as IEEE 802.3. It has become the most widespread LAN technology in 
use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Macintosh (1984) and is now 
deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the machine to 
allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that fuses the toner onto the print media. It 
consists of a heat roller and a pressure roller. After toner is transferred 
onto the paper, the fuser unit applies heat and pressure to ensure that 
the toner stays on the paper permanently, which is why paper is warm 
when it comes out of a laser printer.

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or a 
network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are represented 
by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of dots. 
Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.

HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded data 
on rapidly rotating platters with magnetic surfaces.
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IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the advancement 
of technology related to electricity.

IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to 
a specific connector type on the end of the parallel cable that attaches to 
the peripheral (for example, a printer). 

Intranet
A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of 
an organization's information or operations with its employees. 
Sometimes the term refers only to the most visible service, the internal 
website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in 
order to identify and communicate with each other on a network utilizing 
the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a printer 
can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and so 
forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing solution 
than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international radio 
and telecommunications. Its main tasks include standardization, 
allocation of the radio spectrum, and organizing interconnection 

arrangements between different countries to allow international phone 
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 
compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is the 
format used for storing and transmitting photographs on the World Wide 
Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over 
TCP/IP.

LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates 
the status of a machine.

MAC address
Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier usually 
written as 12 hexadecimal characters grouped in pairs (e. g., 
00-00-0c-34-11-4e). This address is usually hard-coded into a Network 
Interface Card (NIC) by its manufacturer, and used as an aid for routers 
trying to locate machines on large networks.

MFP
Multi Function Peripheral (MFP) is an office machine that includes the 
following functionality in one physical body, so as to have a printer, a 
copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax machines 
to transfer the image recommended by ITU-T T.4. MH is a 
codebook-based run-length encoding scheme optimized to efficiently 
compress white space. As most faxes consist mostly of white space, this 
minimizes the transmission time of most faxes. 

MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.
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Modem
A device that modulates a carrier signal to encode digital information, 
and also demodulates such a carrier signal to decode transmitted 
information.

MR
Modified Read (MR) is a compression method recommended by ITU-T 
T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.

NetWare
A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and it is 
usually green or rust colored and has a cylinder shape. 
An imaging unit containing a drum slowly wears the drum surface by its 
usage in the printer, and it should be replaced appropriately since it gets 
worn from contact with the cartridge development brush, cleaning 
mechanism, and paper.

Originals
The first example of something, such as a document, photograph or text, 
etc, which is copied, reproduced or translated to produce others, but 
which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for communications. 
OSI offers a standard, modular approach to network design that divides 
the required set of complex functions into manageable, self-contained, 
functional layers. The layers are, from top to bottom, Application, 
Presentation, Session, Transport, Network, Data Link and Physical.

PABX 
A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL has 
been released in varying levels for thermal, dot matrix printer, and laser 
printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two dimensional documents in a 
device independent and resolution independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas. - 
that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the computer 
to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can 
be used in a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for determining 
how fast a printer works, meaning the number of pages a printer can 
produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
See PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the 
world's public circuit-switched telephone networks which, on industrial 
premises, is usually routed through the switchboard.

RADIUS
Remote Authentication Dial In User Service (RADIUS) is a protocol for 
remote user authentication and accounting. RADIUS enables 
centralized management of authentication data such as usernames and 
passwords using an AAA (authentication, authorization, and accounting) 
concept to manage network access.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
between nodes on a network. It also provides an authenticated 
Inter-process communication mechanism.
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SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, 
text-based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-server 
protocol, where the client transmits an email message to the server.

SSID
Service Set Identifier (SSID) is a name of a wireless local area network 
(WLAN). All wireless devices in a WLAN use the same SSID in order to 
communicate with each other. The SSIDs are case-sensitive and have a 
maximum length of 32 characters.

Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and which 
part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP); 
the set of communications protocols that implement the protocol stack 
on which the Internet and most commercial networks run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible and 
platform-independent format can be used for pictures that have been 
made by various image processing applications.

Toner Cartridge
A kind of bottle or container used in a machine like a printer which 
contains toner. Toner is a powder used in laser printers and 
photocopiers, which forms the text and images on the printed paper. 
Toner can be fused by by a combination of heat/pressure from the fuser, 
causing it to bind to the fibers in the paper.

TWAIN
An industry standard for scanners and software. By using a 
TWAIN-compliant scanner with a TWAIN-compliant program, a scan can 
be initiated from within the program. It is an image capture API for 
Microsoft Windows and Apple Macintosh operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access network 
shares in Window NT and other Microsoft products. The format of a 
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and peripherals. 
Unlike the parallel port, USB is designed to concurrently connect a 
single computer USB port to multiple peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that appears 
lighter when viewed by transmitted light. Watermarks were first 
introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WEP
Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 
802.11 to provide the same level of security as that of a wired LAN. WEP 
provides security by encrypting data over radio so that it is protected as 
it is transmitted from one end point to another.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is 
originally introduced in Windows Me and Windows XP. A scan can be 
initiated from within these operating systems by using a WIA-compliant 
scanner.

WPA
Wi-Fi Protected Access (WPA) is a class of systems to secure wireless 
(Wi-Fi) computer networks, which was created to improve upon the 
security features of WEP.

WPA-PSK
WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small 
business or home users. A shared key, or password, is configured in the 
wireless access point (WAP) and any wireless laptop or desktop 
devices. WPA-PSK generates a unique key for each session between a 
wireless client and the associated WAP for more advanced security.

WPS
The Wi-Fi Protected Setup (WPS) is a standard for establishing a 
wireless home network. If your wireless access point supports WPS, you 
can configure the wireless network connection easily without a 
computer.

XPS
XML Paper Specification (XPS) is a specification for a Page Description 
Language (PDL) and a new document format, which has benefits for 
portable document and electronic document, developed by Microsoft. It 
is an XML-based specification, based on a new print path and a 
vector-based device-independent document format.
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